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The Human System Risk Board (HSRB) is responsible for the management of a portfolio of 
30 human system risks that NASA tracks and configuration manages to mitigate for future 
crewed exploration missions.  Starting in January 2020, the board has developed and 
managed the concept of causal diagrams (in the form of DAGs) as an approach to creating 
knowledge graphs for each risk to enable shared mental models of causal flow from 
spaceflight hazards to mission outcomes among HSRB Stakeholders.  These diagrams are 
intended to improve insight and communication of risk across the myriad subject matter 
experts and management interested in human system risk reduction.  This includes program 
managers, systems engineers, and operators in addition to the Human Health and 
Performance Directorate.   

With the completion of the Configuration Management of all 30 human system risk DAGs, 
we requested preparation of a NASA Technical Publication suitable for public dissemination 
that contains: 

1. Guidance on how to construct and interpret the DAGs

2. Shared definitions of all the terms within the DAGs

3. DAGs for each of the Human System Risks

a. Including their narrative description

4. Code appropriate for easy replication of the Human System DAGs by interested
parties

One function of this technical publication is to release the DAGs to the public domain, the 
official NASA versions of DAGs, their narratives, and the definitions of the terms within the 
DAGs will be version last configuration managed by the HSRB.  It is understood and desired 
that the public and research community will add detail and complexity to the DAGs for each 
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user's purpose, but the version of the DAGs on the HSRB NASA website will always be the 
official one for NASA risk management purposes and will supersede any non-HSRB 
configuration managed versions. 

We look forward to the receipt of this material and hope the external community can expand 
and respond to this publication in ways that characterize and mitigate the risks to human 
health and performance of exploration spaceflight. 
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Abstract 
For over a decade, the National Aeronautics and Space Administration (NASA) has tracked 

and configuration-managed approximately 30 risks to astronaut health and performance that 
occur before, during and after spaceflight. The Human System Risk Board (HSRB), a Health 
and Medical Technical Authority (HMTA) Board at NASA Johnson Space Center, is the entity 
responsible for identifying, assessing, analyzing, and monitoring the official understanding of the 
risk or risk posture for each of the Human System Risks and determining – based on evaluation 
of the available evidence – when that risk posture changes. The ultimate purpose of tracking 
and researching these risks is to find ways to reduce the risk that astronaut crews face during 
spaceflight. Historically, research, development and operations relevant to one risk have been 
conducted in isolation from other risks; these individual risk ‘silos’ enabled initial characterization 
of each specific risk. In spaceflight however, the impact of exposure to risk for astronaut crews 
is cumulative, and not independent of exposures or other risks, as all the adverse effects of the 
spaceflight environment begin at launch, continue throughout the duration of the mission and in 
some cases across the lifetime of the crews. In January of 2020, the HSRB at NASA embarked 
on a pilot project designed to assess the potential value of causal diagramming as a tool to 
facilitate understanding of these cumulative and interdependent effects as applied within Human 
System Risk management. This process uses directed acyclic graphs as a means of formalizing 
a shared mental model of the causal flow of risk among Risk Board stakeholders. Initially this 
model was to improve communication among those stakeholders, but the potential value 
exceeds communication alone. The causal diagrams are formulated as directed acyclic graphs 
(DAGs) to function as a type of knowledge graph for reference for the board and its 
stakeholders.  

This document is a sister document to NASA/TM 20220006812 Directed Acyclic Graph 
Guidance Documentation (1).  In that document, the basic guidance for creating and 
standardizing directed acyclic graphs as tools for cross-risk analysis is provided.  This document 
contains the initial configuration managed DAGs that were created as a result of applying those 
principles.  These initial versions were accepted by the HSRB in January of 2022.  Each of the 
Human System Risks are represented by a DAG that has been reviewed by the larger Human 
Health and Performance community at NASA including life scientists, physical scientists, 
physicians, nurses, pharmacists, exercise specialists and more.  These results show the starting 
point for Human System Risk DAGs as shared mental models and communication aids across 
the boundaries of the various expertise needed to understand and mitigate the human risks in 
spaceflight.  Because they are a starting point, each of these DAGs can be expected to change 
over time as new or refined evidence becomes available.  The process for updating these DAGs 
can be found in the JSC-66705 Human System Risk Management Plan (2) that is publicly 
available on the NASA Technical Reports Server. 

 
 
 

  

https://ntrs.nasa.gov/


 
 

5 

Table of Contents 
Abstract ......................................................................................................................................... 4 

Table of Contents .......................................................................................................................... 5 

Overview ....................................................................................................................................... 7 

Description of Sections and Appendices .................................................................................... 13 

Directed Acyclic Graphs and Descriptive Writeups ..................................................................... 14 

Adverse Cognitive or Behavioral Conditions and Psychiatric Disorders (Behavioral Med. Risk) 15 

Risk of Bone Fracture due to Spaceflight-induced Changes to Bone (Bone Fracture Risk) ....... 18 

Risk of Cardiovascular Adaptations Contributing to Adverse Mission Performance and Health 
Outcomes (Cardiovascular Risk) ................................................................................................ 21 

Risk of Nominal Acute and Chronic Ambient Carbon Dioxide Exposure in Crewed Vehicles 
(CO2 Risk) .................................................................................................................................. 23 

Risk to Vehicle Crew Egress Capability and Task Performance as Applied to Earth and 
Extraterrestrial Landings (Crew Egress Risk) ............................................................................. 25 

Risk of Decompression Sickness (DCS Risk) ............................................................................. 28 

Risk of Adverse Health & Performance Effects of Celestial Dust Exposure (Dust Risk) ............ 30 

Risk of Injury from Dynamic Loads (Dynamic Loads Risk) ......................................................... 32 

Risk to Crew Health Due Electrical Shock (Electrical Shock Risk) ............................................. 34 

Risk of Injury and Compromised Performance Due to EVA Operations (EVA Risk) .................. 37 

Risk of Performance Decrement and Crew Illness Due to Inadequate Food and Nutrition (Food 
and Nutrition Risk) ...................................................................................................................... 39 

Risk of Adverse Outcomes Due to Inadequate Human Systems Integration Architecture (HSIA 
Risk) ............................................................................................................................................ 44 

Risk of Reduced Crew Health and Performance Due to Hypoxia (Hypoxia Risk) ...................... 47 

Risk of Adverse Health Event Due To Altered Immune Response (Immune Risk) ..................... 50 

Risk of Adverse Health Outcomes and Decrements in Performance Due to Medical Conditions 
that occur in Mission, as well as Long Term Health Outcomes Due to Mission Exposures 
(Medical Risk) ............................................................................................................................. 53 

Risk of Adverse Health Effects Due to Host-Microorganism Interactions (Microhost Risk) ........ 55 

Risk of Impaired Performance Due to Reduced Muscle Size, Strength, and Endurance (Muscle 
Risk) and Risk of Reduced Physical Performance Capabilities Due to Reduced Aerobic 
Capacity (Aerobic Risk) .............................................................................................................. 58 

Risk of Adverse Health Outcomes and Performance Decrements resulting from Non-Ionizing 
Radiation during Spaceflight (Non-Ionizing Radiation Risk) ....................................................... 60 

Risk of Ineffective or Toxic Medications During Long-Duration Exploration Spaceflight (Pharm 
Risk) ............................................................................................................................................ 62 

Risk of Radiation Carcinogenesis (Radiation Carcinogenesis Risk) ........................................... 65 

Risk of Renal Stone Formation (Renal Stone Risk) .................................................................... 68 



 
 

6 

Risk of Spaceflight Associated Neuro-ocular Syndrome (SANS Risk) ....................................... 71 

Risk of Altered Sensorimotor/Vestibular Function Impacting Critical Mission Tasks 
(Sensorimotor Risk) .................................................................................................................... 74 

Risk of Performance Decrements and Adverse Health Outcomes Resulting from Sleep Loss, 
Circadian Desynchronization, and Work Overload (Sleep Risk) ................................................. 77 

Risk of Performance and Behavioral Health Decrements Due to Inadequate Cooperation, 
Coordination, Communication, and Psychosocial Adaptation within a Team (Team Risk) ......... 80 

Risk of Toxic Exposure (Toxic Exposure Risk) ........................................................................... 83 

Risk of Urinary Retention (Urinary Retention Risk) ..................................................................... 86 

Concern of Venous Thromboembolism (VTE Concern) ............................................................. 88 

References .................................................................................................................................. 90 

Appendix A - DAGtionary ............................................................................................................ 91 

Appendix B – DAG Nodes to Risks Mapping ............................................................................ 138 

Appendix C – Risk Formatting Instructions DAG Formatting from DAGitty 3.0 ........................ 154 

 

  



 
 

7 

Overview 
For the Human System Risk Board (HSRB), a Directed Acyclic Graph (DAG) is a visual tool 

that is used to capture knowledge and enhance communication across all the stakeholders of 
human system risks. The knowledge captured is the Human Health and Performance 
community’s knowledge about the causal flow of a human system risk. They are intended as a 
high-level resource for understanding the complex relationships between factors that contribute 
to increased risk within and across the Human Spaceflight System Risks. They are not intended 
to provide detailed insight into subject matter expert (SME) domains of deep knowledge, but 
rather to provide the high-level scaffolding to which SMEs can attach more detailed visuals to 
clearly relay their importance to Mission Level Outcomes. The DAGs documented here are 
current as of May 13, 2022.  

• The DAGs are dynamic and will change. 

• Any major changes will be captured, and configuration managed at the HSRB. 

• Any DAGs not configuration managed at the Board are considered notional. 
For context, the interested reader can download JSC-66705 Human System Risk 

Management Plan (2) and NASA/TM 20220006812 Directed Acyclic Graph Guidance 
Documentation (1). 

The formal definition of each node in the DAG network can be found in Appendix A. 
The Human System Risk DAGs were created using DAGitty 3.0 (3) a publicly available 

browser-based environment for creating, editing, and analyzing causal diagrams. DAGitty 
formatting files for each Risk are included in Appendix B. Note that there are dotted lines in 
some DAGs connecting nodes. These indicate weak or speculative evidence support for the 
causal connection drawn and are explained more in the supporting documentation listed above.  
These are not a feature of the DAGitty program. Each of those found DAGs shown here were 
added in post-processing and as such are not captured in the DAGitty formatted files. These are 
intended to be captured in future software capabilities.  

Guidance for DAGs 

• All causal flow is acyclic, no loops are allowed. 

• All flow starts with a Hazard(s) and ends with a Mission Level Outcome(s). 

• Arrows to outbound Risks have been removed for visual clarity. They are 
shown as inbound arrows in the applicable Risks. 

• Some nodes are “nested” to collapse like categories. 

• Configuration Management of the DAGs is performed by the HSRB at NASA. The HSRB 
configuration managed DAGs represent the official position of the NASA Human Health 
and Performance community and the Health and Medical Technical Authority (HMTA).   

• The DAGs shown here are ‘Narrative’ DAGs. These are intended to capture the high-level 
community agreement on causal flow. They are accompanied by narrative slides that 
explain in words the visualized representation. They include nodes that can represent 
grouped concepts for clarity and visual simplification. 

• ‘Detailed’ DAGs can be made by individual users that show some of these concepts 
unpacked into multiple additional nodes or can add additional detail that is relevant to a 
specific problem. These are not configuration managed by the HSRB. Variations used 
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within NASA are expected to show fidelity to the Narrative DAG and are subject to HSRB 
administrative review.  

• Users of DAGs may encounter more detailed DAGs that have been created by modifying 
or adding detail to the Narrative DAGs. Please note that these may not have been 
approved by the HSRB and as such may not reflect an official position of the NASA 
community. The user is responsible for determining whether the DAG is an HSRB 
configuration managed version or has been derived from an HSRB configuration managed 
version.   

• HSRB Management would appreciate any comments on what level of detail or 
logistics need to be considered in this delineation of products. Please email your 
comments to jsc-dl-hsrb@mail.nasa.gov. 

• Substantive changes to the Narrative DAGs may be proposed with any board update for 
the associated risk. This is to ensure discussion of the evidence considered in proposing 
updates to the DAGs. Anyone wishing to propose a DAG update must send a From-To 
visualization with rationale for recommending the causal changes. NASA is under no 
obligation to respond or accept suggested changes but will consider them within available 
resources.   

• Processes for validating the structure of the DAGs using existing evidence are in 
development and the reader can learn more here Validating Causal Diagrams of Human 
Health Risks for Spaceflight: An example using bone data from rodents can be found here, 
Validating Causal Diagrams of Human Health Risks for Spaceflight: An Example Using 
Bone Data from Rodents (4) 

Standardization Process 
The DAG Guidance Document (1) provides a detailed explanation of the standardization 

guidelines for making HSRB approved DAGs. This is to ensure that visual representation of 
concepts and node terminology used is applicable across the many different fields of expertise 
that contributed to making the DAGs for the HSRB. The goal is to create a repeatable and 
systematic process for creating and updating DAGs to demonstrate consistency across all 
DAGs and ensure usability for the future. 

 

 
Figure 1: Each DAG starts with one or more of the known Hazards in human spaceflight and proceeds through nodes and edges 
to one or more of the Mission Level Outcomes that define risk for the astronauts and NASA.  
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Figure 2: Example of standardization of visual representation. In this case, monitoring, detection, and the resulting intervention 
or treatment are shown in a consistent way across all DAGs. A. shows the general approach and B. shows a specific use case.  

• Common Start and End Points. 

• Common representations of concepts – See monitoring example in Figure 2. 

• Harmonized Terminology - Ensuring that terms referring to the same concept are named 
the same in order to facilitate risk-risk interaction mapping. This is accomplished by 
reviewing all the DAGs together and creating a terminology list. When official DAGs are 
updated the Risk Custodian Teams responsible are asked to choose terms from the 
official list for any new nodes. If there is not an applicable term in the database, then the 
team needs to submit a definition for the proposed node along with an update to the 
narrative of how that node contributes to the causal story of risk shown in the affected 
DAG(s). 

• Below is the legend for the DAGs visualized with the current DAGitty 
(http://www.dagitty.net) capabilities. Future software will enable different representations. 

 
Figure 3: For DAGs created with the DAGitty software, this legend identifies the types of nodes and edges found in the DAGs in 
this document. Dotted lines are not part of the DAGitty capabilities and were added manually.  

 

http://www.dagitty.net/
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Common Terms 
This is a list of some of the common terms found in multiple DAGs with description: 

• Hazards – Set hazards defined in the Risk Management Plan (Altered Gravity, Radiation, 
Isolation and Confinement, Hostile Closed Environment, Distance from Earth). 

• Mission Level Outcomes – Set outcomes defined in the Risk Management Plan (Task 
Performance, Evacuation, Loss of mission objectives, Loss of Crew Life, Loss of Crew, 
Loss of Mission, Flight Recertification, Long Term Health Conditions, and Long-Term 
Health Quality.) 

• Crew Capability - represents the ability/readiness of the entire crew to perform a task. 
This includes functional capacity and knowledge, skills, and abilities. 

• Individual Readiness - the level to which a crewmember is prepared mentally and 
physically to perform necessary tasks. 

• Task Performance – likelihood of successful performance of a task based on factors such 
as response time, efficiency, or accuracy. 

• Astronaut Selection - the narrowing down of the pool of individual applicants to the most 
suitable for spaceflight. 

• Individual Factors 
─ The influence that each crewmember will have on biologic variability (e.g., physical, 

physiological, or behavioral) affecting risk. This node as a category is broken out into 
two types: 
o Modifiable (lifestyle choices, smoking status, exercise habits, etc.). 
o Non-modifiable (age, sex, genetic predispositions, etc.). 
o Astronaut Selection processes affect what Individual Factors are present in any 

given crew.  
 Reduces pre-existing Medical Conditions and affects multiple risks. 
 May be different for commercial/private astronauts in the future. 

Important Note:  This node as shown in Figure 4 illustrates the concept of Nesting that is 
discussed in more detail in the DAG Guidance Document (1).  Briefly this means that in telling 
the high-level story of causal flow it is sometimes helpful to group together some detailed 
causes/effects into a single node. That node must faithfully represent the contributions of all the 
sub-nodes to the DAG. This applies here to Individual Factors as well as Total Medical Events 
and Crew Health and Performance System below.  
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Figure 4: Individual Factors node is a category node that includes potential sub-nodes within it. It can be split into Modifiable 

Individual Factors and Non-Modifiable Individual Factors. Within those sub-nodes there are further potential divisions as shown 
by the bulleted lists of factors.   

• Total Medical Events 
─ Traumatic Injury - any injury that occurs as a result of acute or chronic loading of a 

part of the body including penetrating and blunt. 
─ Environmental Injury - any non-traumatic injury that is the direct result of a known 

environmental exposure including burns. 

─ Medical Illness - any illness that is not specifically caused by the above. 

• Physiologic Changes  
─ Category node that includes physiologic changes, measurable variances in cellular, 

tissue, organ, or body function, that are specific to a given risk. Used in Narrative 
DAGs for visual clarity. 

• Crew Health and Performance (CHP) System  
─ Vehicle system including the following capabilities that provides health and 

performance support to crew. 
o Prevention Capability- to address health conditions using onboard therapeutics, 

crewmembers, and ground-based resources and provide and preventive 
countermeasures. 

o Medical Treatment Capability - to address health conditions using onboard 
therapeutics, crewmembers, and ground-based resources and provide 
treatment countermeasures. 

o Monitoring Capability - to periodically or continuously observe, record, and 
systematically review the status of vehicle, habitat, spacesuit or human systems. 

o Detection Capability – to identify, measure and report changes that occur during 
a space flight mission to assist in determining the need for intervention or 
treatment. 
 



 
 

12 

• Surveillance 
─ Monitoring and diagnostic services available to active and retired astronauts to 

facilitate early detection of health conditions that may be associated with exposures 
incurred during space flight or space flight training. 
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Description of Sections and Appendices 
 
The section immediately following this shows the HSRB approved DAGs and their narrative 

descriptions as of May 2022. Following that there is more information in this document.   
Appendix A is called the ‘Dagtionary’. This is a listing of all the node names and closely related 
terms used in this domain by the NASA HHP community. This list of definitions was reviewed by 
the HSRB and the definitions formally approved in August 2022. The main reason for this step is 
that working with risk and countermeasures in the human health and performance domain of 
spaceflight requires collaboration across many different specialty fields such as medical, 
engineering, life sciences, and more. Each of these domain experts can have slightly different 
definitions that they use for the terms provided. In order to provide a standardized, community 
wide common language, the HSRB reviewed, and configuration managed these definitions.  
This section seeks to provide an adjudication point for terminology that may be used differently 
by experts who need to work together.  

Appendix B is the mapping of all the nodes used in the Narrative DAGs to the various risks.  
This is provided as a short cut to give the reader insight into where common items are expected 
to affect the causal path for multiple risks. One overly simplistic measure of importance of nodes 
to the larger risk network could be how many risks it touches. However, analytics of risk 
networks are complicated and deriving useful information from a network like this requires more 
thorough consideration. This is the goal of future work using these DAGs.   
Appendix C is the Risk Formatting Instructions from DAGitty 3.0. The structure of the DAGs 
shown here is captured in DAGitty and made available so that reconstructing it does not need to 
be done manually. However, these instructions do not capture all of the information shown in 
the official DAGs. Dotted lines that show weakly hypothetical causal links (as opposed to 
strongly hypothetical causal links represented by solid lines) are not captured in these files and 
the user must take care to cross reference the file output with the DAG images shown in this 
paper if the basic Level of Evidence supporting the assertion of a link is important to them. 
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Directed Acyclic Graphs and Descriptive Writeups 
 

Pages 12-87 contain the visual depiction of the causal flow in the DAG followed by a narrative 
description for each of the 29 HSRB risk and the one concern.  Each of these are the HSRB 
approved versions that are current as of May 2022.   
Note:  The Muscle and Aerobic risks have been combined into one DAG.  
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Adverse Cognitive or Behavioral Conditions and Psychiatric Disorders (Behavioral Med. Risk) 
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Behavioral Med. Risk DAG Narrative 

• The primary spaceflight hazard for the Behavioral Risk is exposure to the Isolation and Confinement of 
spaceflight which can result in decrements in cognitive and behavioral functioning centered around two 
nodes, Psychological Status and Cognitive Function; secondary Hazards include Distance 
from Earth and Radiation. 

• Psychological Status refers to the mood and psychological state of the crew at any given time during a 
mission. These factors can directly affect Individual Readiness, Crew Capability by decreasing 
an individual’s readiness for Task Performance if crew are distracted, preoccupied, dysregulated, 
unmotivated, or uncooperative. This also affects the Team (Risk). 

─ The equilibrium that is present in Psychological Status for an individual astronaut is affected by: 
o Family/World Events that can occur while an astronaut is on a long mission. These can include 

deaths and loss that provoke grief and affect mood and motivation for example.  
o Social Dynamics with the rest of the crew are dependent on Crew Composition. NASA 

typically does not select crews for their compatibility, but this may be required in longer duration 
exploration missions. 

o Central Nervous System Changes that can occur as a result of Isolation and Confinement or 
can occur because of Other Risks including Medical (Risk), Pharm (Risk), Food and Nutrition 
(Risk), Sensorimotor (Risk), SANS (Risk), Sleep (Risk), CO2 (Risk), Hypoxia (Risk), 
Immune (Risk), and Acoustics (Risk) changes. This can also be affected by Oxidative 
Stress and Inflammation as a result of Radiation and other causes.  

o Individual Factors including Age, Sex, Genetic Predispositions and more affect the resilience 
of individual astronauts and the magnitude of impact to Psychological Status that may occur. 

• Cognitive Function refers to the astronaut’s attributes like planning, reasoning/decision-making, 
attention, memory, cognitive speed, and other thought processes that can be affected by a variety of 
factors in the spaceflight environment. Disruption in Cognitive Function can also directly affect 
Crew Capability and decrease readiness for Task Performance required for a variety of mission 
objectives. This can affect the Team (Risk) by requiring other team members to compensate for the 
individual’s deficits.  

─ The equilibrium that is present in Cognitive Function for an individual astronaut is affected by: 
o Central Nervous System Changes as described above can affect Cognitive Function. 
o Workload can affect ability to focus and general cognitive function. 
o Individual Factors including Age, Sex, Genetic Predispositions and more affect the resilience 

of individual astronauts and the magnitude of impact to Cognitive Function that may occur. 

• Countermeasures to issues with Psychological Status and Cognitive Function can occur pre-flight or 
in-mission and in some cases must be included in Vehicle Design allocations and the Crew Health and 
Performance System in order to realize risk reduction. These include: 

─ Selection of crew who are resilient to decrements in Psychological Status and Cognitive 
Function. 

─ Training historically has occurred pre-flight and enables crews to develop individual resilience as 
well as team cohesion. This may need to be included in-flight as well in future missions. 

─ Exercise has a strong connection with mood and motivation of the crew affecting 
both Psychological Status and Cognitive Function in positive ways. 
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─ BHP Prevention Capability could include Exercise as above, but there are other preventive 
measures that are performed including care packages, family conferences, private psychological 
conferences, and more.  

─ BHP Monitoring Capability enables the crew to identify when there are changes to Psychological 
Status or Cognitive Function and determine appropriate times to implement BHP Intervention 
Capability. This includes regular assessments of Cognitive Function and evaluations 
during Private Medical Conferences as well as Private Psychological Conferences.  

─ BHP Intervention Capability includes as clinically indicated Private Psychological Conferences, 
Private Family conferences, and ground-based family support services. Intervention by other 
crewmembers, and other BHP interventions that may include medications if warranted.  

• Most of the current countermeasures are dependent on real-time communication and resupply. 
As Communication Factors change with Distance from Earth, access to Ground Support that 
enables successful BHP Monitoring Capability and BHP Intervention Capability becomes strained or 
non-existent. 

• Central Nervous System Changes and Psychological Status of an individual astronaut throughout a 
mission both have the possibility of causing Long Term Health Outcomes. Surveillance post-flight and 
post-career enables us to Detect Long Term Health Outcomes of interest and better characterize 
the long-term risk to astronauts. 
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Risk of Bone Fracture due to Spaceflight-induced Changes to Bone (Bone Fracture Risk) 
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Bone Fracture Risk DAG Narrative 
The Bone Fracture DAG centers around the Bone Fracture node that has two types of inputs. Those 

that affect the loads that the bone experiences, and those that make the bone more fragile i.e., Skeletal 
Fragility.  

• Nodes that affect the loads the bone experiences include: 

─ Musculoskeletal Loads is dependent in part by Altered Gravity, the Resistive Exercise 
designed into the Crew Health and Performance System, and the effects 
of Muscle (Risk) on the bone. 

─ Vehicle Design and Suit Design. 
─ Dynamic Loads (Risk) governs the loads experienced in landing scenarios for planetary 

surfaces. This is heavily influenced by Vehicle Design and Suit Design as well.  

─ Sensorimotor and Aerobic (Risks) can influence the likelihood of experiencing high loads 
from falling or operational errors. 

─ Muscle (Risk) includes the muscular loads on the bone and muscular support that change 
with muscular atrophy. This is dependent on the Resistive Exercise designed into the Crew 
Health and Performance System. 

• Nodes that affect Skeletal Fragility include: 

─ Bone Density refers to mass and mineral density within the bone. 
─ Bone Structure refers to changes in the trabecular structure internal to the bone and areal 

structure of the bone. 

─ Changes to both of these occur as a result of unbalanced Bone Remodeling here shown as 
two sub-nodes: 
o Bone Resorption performed by Osteoclast cells and dependent on Musculoskeletal 

Loads, Endocrine Factors such as estrogen, Individual Factors, medications used 
here represented by Pharm (Risk), and Nutrients here represented by Food and 
Nutrition (Risk). 

o Bone Formation performed by Osteoblast cells and dependent on all of the same nodes 
as above except for Food and Nutrition (Risk). 

• It is hypothesized that Chondrocyte Metabolism may be affected by Altered Gravity and 
Radiation. These connections are shown as dotted lines because of the paucity of evidence 
supporting this assertion. If so, this can lead to Cartilage Defects and Osteoarthritis that can 
contribute to Individual Readiness and Crew Capability for example, when dealing with joint 
pain. Osteoarthritis can also occur in some cases of Bone Fracture.  

• Skeletal Fragility if permanent can cause osteoporosis and contribute to Long Term Health 
Outcomes. Similarly chronic joint pain such as arthritis can contribute to Long Term 
Health Outcomes.  

• Monitoring countermeasures that can be performed before and after flights such as DXA, QCT, and 
MRI enable us to Detect Bone Density Changes and Detect Bone Structure Changes. 
Detecting these can lead to Long Term Health Clinical Decisions such as orthopedic 
interventions or medication use that can decrease the likelihood or severity of Long Term Health 
Outcomes. Currently there is no arrow connecting Detect Bone Structure Changes to Flight 
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Recertification because we do not have a clinical trigger that is identified. However, research into 
both technology and clinical validation is in progress.  

• Ultrasound may provide an option to Detect Bone Structure Changes occurring in flight if the 
capability is designed into the Crew Health and Performance System.



21 

 

Risk of Cardiovascular Adaptations Contributing to Adverse Mission Performance and Health 
Outcomes (Cardiovascular Risk) 
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Cardiovascular Risk DAG Narrative 

• The Cardiovascular (Risk) incorporates three former risks into a single risk to the cardiovascular 
system itself. The new risk is organized around the ability of the heart and blood vessels to 
successfully perfuse the organs (supply needed oxygen and nutrients).  

• In-mission risk is dependent on aerobic fitness (captured here as the Aerobic (Risk)) and Organ 
Perfusion. Aerobic Fitness and Pre-syncope/Syncope (underperfusion of the brain) represent 
the performance pathway to affecting mission level outcomes. The health pathway is shown by 
Medical Illness which is a category node that includes a number of medical conditions including 
dysrhythmias (electrical system of the heart, formerly represented by the Arrythmia Risk), 
myocardial infarction (damage to the pumping capability of the heart), and vascular conditions (the 
integrity of the pipes that deliver oxygen and nutrients from the heart).  

• These are preceded by the Cardiac and Vascular Structure/Function which are both affected by 
Exercise, Individual Factors, Fluid Shifts, Endocrine Factors, Intravascular Volume, 
Oxidative Stress, and Inflammation. Oxidative Stress and Inflammation are in particular 
affected by Radiation (formerly part of the Radiation Risk as Tissue Degeneration).    

• Finally, Orthostatic Intolerance can cause changes in Organ Perfusion (especially the brain) and 
is shown affected by multiple factors as well as Orthostatic Intolerance countermeasures which 
includes compression garments, fluid loading, salt tablets, and more.  

• The Crew Health and Performance System design specifically includes Exercise, Medical 
Prevention Capabilities like medications, Medical Monitoring Capabilities like EKG and 
Ultrasound, and Medical Treatment Capabilities like medications and defibrillators depending on 
DRM needs and priorities.  

• Note that if these are not designed into the vehicle, they will not be available for risk mitigation in 
mission.  
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Risk of Nominal Acute and Chronic Ambient Carbon Dioxide Exposure in Crewed Vehicles (CO2 
Risk)  
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CO2 Risk DAG Narrative 

• The CO2 concentration in the closed spacecraft environment is a balance between production 
(primarily crew) and Environmental Control and Life Support (ECLS) scrubbing. 

• When the balance is impacted by vehicle capability (limited ECLS mass/power, for example) or 
production influences (exercise, for example), the CO2 concentration will increase and may result in 
several different physiological changes. 

• Monitoring is essential to understand the levels and possible outcomes. 

─ Ambient cabin level averaging is currently relied upon almost exclusively. 

─ Ambient local/area monitoring also possible via the carbon dioxide monitor (CDM) and personal 
CO2 monitors (pCO2m). 

─ Periodic individual monitoring (inspired CO2 or other, for example) is not currently available. 

• Levels that are elevated significantly and/or chronically may lead to adverse mission outcomes, 
including loss of mission objectives or loss of mission (evacuation). Unexpectedly high acute levels 
may lead to loss of crew life, but the likelihood of this event is very low. 
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Risk to Vehicle Crew Egress Capability and Task Performance as Applied to Earth and 
Extraterrestrial Landings (Crew Egress Risk)  
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Crew Egress Risk DAG Narrative 

• Altered Gravity across all DRM categories includes microgravity, lunar gravity, Mars gravity and 
Earth gravity. This affects Effective Gravity Level which is mission dependent.  

• The Hostile Closed Environment here refers to the Landing Site Environment (including waves 
for water landings) and accelerations that are experienced in the Landing Profile that affect 
the Dynamic Loads (Risk). 

• Distance from Earth determines the mass and volume allocations for Vehicle Design and Suit 
Design and affects the Effective Mission Duration. 

• Individual Readiness and the Crew Capability to perform Post-Landing Tasks Performance is 
strongly dependent on several other Human System risks as well as the Effective Exposure 
Duration to whatever Effective Gravity Level is encountered as these factors determine 
the extent of deconditioning crew will face. This can range from microgravity (0g) to lunar 
gravity (1/6g) to Mars gravity (3/8g) to Earth Gravity (1g). Post Landing Tasks include egress from 
the vehicle, safing the vehicle, and more. As mission duration increases, the confluence of other 
risks can lead to a variety of issues.  

• Those risks include Muscle (Risk), Aerobic (Risk), Cardiovascular (Risk), Sensorimotor (Risk), 
Bone Fracture (Risk), Dynamic Loads (Risk), DCS and Hypoxia (Risks) serve to decondition 
crew depending on Effective Exposure Duration. 

• HSIA (Risk) varies depending on Distance from Earth and effective implementation of standards, 
requirements and HSI Processes in vehicle and mission design. 

• The Muscle (Risk), Aerobic (Risk), Sensorimotor (Risk), and Cardiovascular (Risk) can all 
directly affect Crew Capability and through that Task Performance. Effective exercise can help 
reduce these risks. 

• Medical issues that can lead to reduced Individual Readiness and Crew Capability include: 

─ Organ Perfusion can be decreased because of orthostatic intolerance which is 
represented by the Cardiovascular (Risk). One outcome of this is higher likelihood 
of Vomiting as well as crew passing out and these can be exacerbated by the Thermal 
Environment of the landing vehicle. 

─ Motion Sickness can lead to Vomiting and Aspiration which may lead to Loss of Crew 
Life in cases where crew cannot turn their head, remove a helmet quickly, or otherwise 
cannot protect their airway. This can be exacerbated by the Landing Site Environment, 
particularly if there is a water landing with waves.  

• Traumatic Injury likelihood can be increased through several means: 

─ Sensorimotor (Risk) changes affecting balance and proprioception can lead to an increased 
likelihood of falls in a deconditioned state. 

─ Dynamic Loads (Risk) - Landing Profiles, which are the accelerations/deceleration profiles 
that the crew experience in re-entry determine the loads that crew experience and affect the 
likelihood of traumatic injuries that will occur. The design of occupant protection measures 
such as restraints and seat designs are included in the vehicle and spacesuits. 

─ Bone Fracture (Risk) changes due to spaceflight may result in an increased chance of 
fracture when traumatic injuries are sustained. Bone changes that predispose to fracture are 
minimized by effective exercise in mission. 
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─ Fall Height is a factor that can affect the likelihood of Traumatic Injury including in lander 
designs, ladder heights, and tasks that crew may be asked to perform as part of Post-Landing 
Tasks. 

─ Traumatic Injuries that are incurred can result in issues with Flight Recertification or Long 
Term Health Outcomes. Occupational Surveillance ensures that we Detect Long Term 
Health Outcomes of our astronauts. 

• DCS and Hypoxia (Risks) contribute to possible Environmental Injuries that may occur 
depending on the use of staged denitrogenation prior to landings and EVAs on the surface of the 
Moon or Mars.  

• Medical Issues can be in part mitigated through capabilities designed into the Crew Health and 
Performance System or, in the case of Earth landings, brought along by Ground Support. 

─ Medical Prevention Capability such as medications to prevent motion sickness and 
vomiting, and fluid loading to prevent orthostatic intolerance. 

─ Medical Treatment Capability such as pain medications to treat pain, nausea and other 
medical treatments as needed. 

• In the special case of Earth landings, the medical capability that is brought by Ground 
Support also serves to mitigate risk but is unavailable for lunar or Mars landings. 

• HSIA (Risk) influences the level of Crew Capability and likelihood of successful Post-Landing 
Task Performance in several ways: 

─ Vehicle Design, Suit Design, and Crew Vehicle Integration all affect the ability of 
astronauts to perform the tasks they have been given. These affect adequate exit paths, 
hatch openings, restraint during landing, ability to remove restraints in an emergency, 
potential Fall Height, and more.  

─ Operations Designs including appropriate flight rules or overly complicated Procedure 
Designs can also enhance or adversely affect successful Post Landing Task Performance. 
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Risk of Decompression Sickness (DCS Risk)  
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DCS Risk DAG Narrative 
The Risk of Decompression Sickness (DCS) is broken into two nodes – DCS Type I which is 

mild Environmental Injury, and DCS Type II which is severe Environmental Injury. It is possible 
for DCS Type I to progress to DCS Type II.  
• Either of these types can impact Individual Readiness and Crew Capability by introducing 

functional impairments and can lead to Loss of EVAs. DCS Type II, Arterial Embolism, 
and Ebullism, if they occur, can lead to Loss of Crew Life or permanent Long Term 
Health Conditions.  

• The likelihood of experiencing DCS is dependent on physical exertion captured here as Workload. 
This is dependent on EVA Operations which as a category node includes EVA Frequency, EVA 
Duration, Planned EVA Content, EVA Task Timeline, EVA Decision Support (These are 
explicitly shown in the EVA Risk DAG). 

• EVA Operations are directly affected by the Denitrogenation (including Pre-Breathe time) that is 
dependent on Atmospheric Conditions. For example, Exploration Atmospheres are altered 
Atmospheric Conditions designed to decrease Denitrogenation time while keep the risk of DCS 
low.  

• Vehicle Design determines:  

─ Atmospheric Conditions. 
─ Airlock Design. 

─ Crew Health and Performance System which determines the level of Medical Diagnostic 
Capability and Medical Treatment Capability. The Medical Diagnostic Capability is 
important to distinguish between mild DCS symptoms and other injuries. Medical Treatment 
Capability depends in part on Suit Design. For example, on International Space Station 
(ISS) treatment is provided by the Space Suit which is capable of some over-pressurization. 

• The likelihood of Vehicle/Suit Failure which can lead to Depressurization is affected by Vehicle 
Design and Suit Design.  

• The likelihood of Loss of Crew Life is dependent on the likelihood of DCS Type II, Arterial 
Embolism, Ebullism, and the effectiveness of the Medical Treatment Capability that is provided 
in mission. 



30 

 

Risk of Adverse Health & Performance Effects of Celestial Dust Exposure (Dust Risk)  
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Dust Risk DAG Narrative 

• This DAG centers around Atmospheric Dust Levels that can occur within vehicles after 
Extravehicular Activity (EVA) Operations on celestial bodies. During EVA Operations, Dust 
Sources from the lunar or Martian surface can result in dust being carried back into a vehicle or 
habitat, potentially on space suits. The extent to which this will occur depends on Vehicle Design, 
Suit Design, and the Seals/Gasket designs that are included to prevent dust entry into a vehicle.  

• If dust gets into a vehicle or habitat, then the extent of exposure that crews face depends on 
several factors: 

─ The level of Dust Suspension that occurs in the vehicle atmosphere. 
─ The Surface Dust Level that builds up when dust settles from the atmosphere onto vehicle 

surfaces. 

• The capability for Dust Monitoring that enables crews to Detect Atmospheric Dust levels must 
be included in the Environmental Control and Life Support (ECLS) System in order to determine 
the appropriate contamination levels that should prompt Dust Removal (filtration) and Cleaning of 
surfaces.  

• Inappropriate levels of Dust Suspension in the atmosphere can lead to issues with Cabin 
Visibility affecting performance when piloting vehicles, especially on return to microgravity. This 
can also lead to several health challenges that affect Crew Capability. 

• Dust exposure can lead to Eye Injury, Lung Injury and Skin Irritation which can all progress to 
affect the Medical (Risk). Most evidence suggests that the medical issues are likely to be minor in 
mission. 

• Dust that gets into food or pharmaceuticals may lead to Ingestion Toxicity, especially in the case 
of Martian dust with perchlorates. 

• There is some evidence that the Cardiovascular (Risk) and Immune (Risk) may be affected by 
celestial dust exposures, but this remains at the speculative level currently. 

• Countermeasures can include: 

─ Medical Prevention Capabilities such as artificial tears, skin coverings, etc.  
─ Medical Treatment Capabilities including creams and ointments to treat skin irritation as 

well as medical eye drops to address eye irritation or injury. Antibiotics may be required if 
secondary infection develops.  

• Long Term health Outcome may include pneumonoconiosis, hypersensitivity conditions, 
autoimmune disorders, and cancers, but the level of evidence is currently low that these will occur. 
Surveillance post flight and post-career for these types of conditions can enable us to Detect Long 
Term Health Outcomes and better characterize the magnitude of risk in the Long-Term Health 
domain. 
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Risk of Injury from Dynamic Loads (Dynamic Loads Risk)  
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Dynamic Loads Risk DAG Narrative 

• The central issue in the Dynamic Loads Risk is the Traumatic Injuries that are caused by 
acceleration/deceleration forces.  

• Two categories of traumatic injuries are shown here – Musculoskeletal Injury and Neuro/Ocular 
Injury.  

• Evidence shown in the risk package supports the occurrence of Musculoskeletal Injuries after 
landings in the Soyuz and other vehicles.  

• The dotted lines to Neuro/Ocular Injury show a speculative concern given these have not been 
experienced to date. Predisposing factors for Neuro/Ocular Injuries may include Central Nervous 
System Changes and Vascular Structure/Function as well as Vehicle Dynamics and Body 
Posture.  

• Predisposing factors for Musculoskeletal Injuries include Muscle Performance, Connective 
Tissue Changes, Anthropometry and Bone Remodeling as well as Vehicle 
Dynamics and Vehicle and Suit Designs.  

• Restraints and occupant protection measures are included in Vehicle Design.  

• The Sensorimotor (Risk) influences Body Posture through Postural Control and Locomotion.  

• Given Design Reference Mission (DRM) categories that include Lunar and Martian Landings, the 
pathway through Crew Health and Performance System -> Medical Treatment Capability is 
shown to illustrate that the consequences of inadequate medical system planning will be felt 
in Crew Capability, likelihood of Evacuation, and potentially Loss of Crew Life. Any 
Neuro/Ocular or Musculoskeletal Injuries incurred have the potential to affect Flight 
Recertification of crew as well as Long Term Health Conditions. 
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Risk to Crew Health Due Electrical Shock (Electrical Shock Risk)  
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Electrical Shock Risk DAG Narrative 

• The Hostile Closed Environment feeds directly into Electrical System Design which is impacted 
by Vehicle Design and Electrical Hardware.  

• Electrical Shock centers around three nodes: 

─ Arc Flash/Sparking occurs when there is a voltage difference between hardware inside the 
spacecraft and either a crewmember or other hardware. When a spark jumps to 
a crewmember this can lead to a Dysrhythmia or a Startle Reaction.  

─ Electrical Shock describes when Human-Electrical Contact occurs inside the spacecraft 
and may occur without sparking. Small current can result in Startle Reaction or 
Electrical Muscle Effects such as tetany. Higher current passing through crewmembers can 
result in Burns, Dysrhythmia, or damage to muscles leading to Rhabdomyolysis. In rare 
circumstances, Dysrhythmia could lead to Loss of Crew Life.  

─ Plasma Induced Shock can occur during EVA Operations. Radiation impacts on the 
spacecraft can result in Charged Surfaces and if there is Suit-Vehicle/Habitat Contact then 
a shock may occur. The expected current levels suggest mainly Startle Reaction as the likely 
result which can affect crew operations during the EVA.  

• Crew Capability is affected by the severity of the shock that occurs in all three of the above 
categories. Consequences can range from minor annoyance to severe disease that results 
in functional impairments of the crew.   

─ The severity of Electrical Shock and Plasma Induced Shock both depend on Impedance 
Factors that can include insulation of clothing and shoes as well as amount of sweat on 
the body.  

• Human Electrical Contact may occur for several reasons: 

─ Electrical System Design can be done well or poorly. Poor design can result 
in Hardware/System Failure. Poor Crew-Vehicle Integration can result in increased 
likelihood of Human Errors that result in inadvertent contact with charged hardware and is 
influenced by the HSIA (Risk).  

─ Electrical System Design is dependent on the needed Electrical Hardware and Vehicle 
Design and is influenced by the HSIA (Risk). 

─ Likewise, Suit Design influences the EVA Operations including timeline and likelihood 
of Suit-Vehicle/Habitat Contact and is influenced by the HSIA (Risk). 

• The Crew Health and Performance System provides monitoring and treatment capabilities 
needed to respond to an injury that occurs.  

─ Physiologic Monitoring Capability includes Dysrhythmia Monitors required to Detect 
Dysrhythmias and provide Dysrhythmia Treatment when appropriate.  

─ Medical Diagnostic Capability includes appropriate laboratory testing to Diagnose 
Rhabdomyolysis and initiate Rhabdomyolysis Treatment such as IV Fluids when 
appropriate.  
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o The Medical Treatment Capability that is fielded must consider whether to include 
treatments such as Dysrhythmia Treatment, Rhabdomyolysis Treatment, or Burn 
Treatment Capability to respond to these Environmental Injuries.  

• Lack of appropriate Monitoring, Diagnostic, and Treatment Capabilities can lead to impacts 
to Crew Capability, Evacuation for injured crewmembers, or Loss of Crew Life. In the cases of 
Burns and Rhabdomyolysis, failure to treat in mission can result in Long Term Health 
Outcomes including skin constrictions and kidney failure. Surveillance performed post-mission 
and post career can Detect Long Term Health Outcomes and better characterize the magnitude 
of risk.  
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Risk of Injury and Compromised Performance Due to EVA Operations (EVA Risk) 
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EVA Risk DAG Narrative 

• The Risk of EVA Injury focuses on Environmental Injuries and Traumatic Injuries on the right 
side of the DAG. The numbers, types, and severities of injuries that occur during EVA 
affects Individual Readiness and Crew Capability by introducing functional impairments that can 
affect Task Performance. These categories of injuries are explicit in the Medical Risk DAG 
and Medical Treatment Capability provided in mission determines the extent to which the 
consequences of these injuries can be mitigated in-mission. 

• Contributing factors to Environmental Injuries are Suit Failure and Decompression Sickness 
– DCS (Risk).  

• Contributing factors to Traumatic Injuries includes Suit Failure, Fall Height (either from poor 
vehicle design or mission task attributes), Tool Design (such as in Apollo missions where many 
astronauts complained of hand injuries), and Procedure Design. All of these are affected by 
the HISA (Risk). 

• When severe, these injuries can lead to Loss of EVA Content which increases the likelihood 
of Loss of Mission Objectives, especially in short duration missions. Additionally, they can lead 
to Incapacitation/Crew Rescue during an EVA which increases the likelihood of Loss of 
Crew Life.  

• Individual Readiness and Crew Capability are also affected by both design and operational 
decisions and their consequences. Cognitive Function and Fatigue are dependent on: 

─ Planned EVA Content and EVA Task Timeline (are they feasible and appropriate?). 
─ EVA Duration (how long do they last?), EVA Frequency (how many and how often?), 

and EVA Decision Support (is decision support effective at cognitive unloading?). 

─ All of the above contribute to the Workload that crews experience during their EVAs. 

• Note that EVA Task Timeline and EVA Duration may both be affected by Radiation issues such 
as solar particle events. 

• Workload is also affected by the Altered Gravity environment (microgravity, lunar or Martian), 
their Physical Status, and any Previous Injuries – either old or incurred during prior EVAs. 

• Effective Training can affect the likelihood of having Previous Injuries as well as Crew 
Capability through a practiced understanding of movement and exertion limitations during an EVA. 
Dynamic Loads (Risk) also influences the likelihood of incurring a Previous Injury during a 
landing phase prior to EVA activity. 

• Distance from Earth affects the mass, power, volume and data bandwidth available to the Crew 
Health and Performance System that enables Medical Treatment Capability, EVA Decision 
Support and Physiologic Monitoring – such as the ear exams done to ensure crew can 
effectively clear prior to starting an EVA – that enable Detect EVA Readiness giving crew the 
green light to begin an EVA. 

─ The HSIA (Risk) interfaces at many places including Vehicle Design, Suit 
Design, Training, Fall Height, Tool Design, and Procedure Design. Inadequate attention 
to Human System Integration at the Mission, Vehicle and Suit level is expected to have a 
strong effect on the risk of EVA Injury. 
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Risk of Performance Decrement and Crew Illness Due to Inadequate Food and Nutrition (Food 
and Nutrition Risk)  
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Food and Nutrition Risk DAG Narrative 
The central issue in the Food and Nutrition Risk encompasses six nodes in the center of the diagram 

that highlight the contribution of food to human health and performance.  

• Energy (Calories) - this is the amount of energy that food supplies to crew to enable them to live 
and perform. Insufficient energy in the diet leads to body mass loss, muscle loss, bone loss, 
oxidative stress, and cardiovascular deconditioning, and ultimately starvation and death. 

• Nutrients  - this includes macro and micronutrients that are a critical part of our diet and without 
which we develop nutrient deficiency diseases and other pathophysiologies. The term nutrition also 
encompasses thousands of phytochemicals that when adequate can provide anti-inflammatory, 
anticarcinogenic, and other benefits. There is some evidence that food may be degraded by 
Radiation but the few studies to date have used higher levels of radiation than expected in human 
spaceflight. The dotted line indicates the low amount of evidence in this area.  

• Hydration – hydration status is determined by total water intake and exit from the body. 
Dehydration can affect multiple other risks, including cardiovascular, renal stone, cognition, 
performance, and more. 

• Food Acceptability – if food is not acceptable it does not matter if it has the required nutrition – 
they will not consume enough to get adequate nutrition. This is affected by Individual Factors 
such as food preferences and allergies which are part of the Immune (Risk). Astronaut Selection 
affects the extent of those factors present in a given crew.  

• Food Variety – variety is part of acceptability – a nutritional variety of foods needs to prevent menu 
fatigue and provide choice to prevent risk of underconsumption and undernutrition. 

• Food Safety – if food is not safe it does not matter if it has the required nutrition – it will be a major 
risk to crew health and loss of mission. 

In conflict with this is another critical concept - resources. To date, nutrition, energy, acceptability, 
and variety have been cut by programs, regardless of unknown risk, when resources are not available. 
Mass/volume and power are limited by the Vehicle Design, Crew Health and Performance System, 
and highly dependent on Distance from Earth as well as the HSIA (Risk). This is also dependent on 
Resupply. Resources also impact: 

• Food Preparation includes items such as a water heater, food warmer, and other equipment that 
can determine the amount of time that preparation activities add to the schedule as well as the 
acceptability and safety of the food for the astronauts. This is key to acceptability. 

• Food Storage Conditions includes refrigeration and packaging of food. This is key to nutrition and 
acceptability and is affected by Pre-Mission Food Storage Time which historically has ranged 
from weeks to years. Recycling primarily includes water.  

• Food Production which, if designed into the system may include necessary equipment for growing 
food and ensuring safety, and capability such as salad crops may be critical for acceptability on 
long duration missions with no resupply of fresh provisions. There is some evidence that Radiation 
may affect seed viability. Dotted line indicates the low amount of evidence in this area.  

In order to mitigate risk, crew must intake an appropriate amount of Energy (Calories), Nutrients, 
and Hydration. The system must provide the necessary Food Acceptability, Food Variety, and Food 
Safety that supports adequate intake. Too little of these and Nutrient Deficiencies, Starvation, or 
medical conditions such as dehydration can occur. Too much causes Nutrient Toxicities or other 
medical conditions such as polydipsia, hyponatremia, etc. Optimal nutrition can provide additional 
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benefits, including anti-inflammatory (Immune Risk) and anticarcinogenic effects (Radiation 
Carcinogenesis Risk), which can be a key countermeasure to prevent disease on long duration 
missions. This balance affects other risks listed below that all contribute to non-optimal Individual 
Readiness, Crew Capability and through that affect Task Performance. Through the Medical (Risk) or 
through Starvation, Nutrient Toxicities or Nutrient Deficiencies these can also affect the likelihood of 
other Mission Level Outcomes including Evacuation, Loss of Crew Life, and Long Term Health 
Outcomes.  

Food system (including nutrient deficiencies and/or toxicities) directly affects the likelihood of other 
risks listed below: 

• Behavioral (Risk) affects factors such as mood and cognitive function. 

• Muscle and Aerobic (Risks) fitness levels including stamina and strength can be affected. 

• Sleep (Risk) affects factors such as mood and cognitive function. 

• Microhost, VTE, Renal Stone, and Bone Fracture (Risks) –  all have nutritional underpinnings 
and can lead to specific medical conditions occurring in mission. 

• Immune (Risk) system dysregulation can occur as a result of inadequate energy. This also 
includes hypersensitivity reactions like food allergies which are affected by Individual Factors. 

• Cardiovascular (Risk) function and SANS (Risk) through vitamin issues or other single nutrient 
deficiencies.  

• Nutrient Toxicities occur when too much of a required nutrient is ingested. These can include 
vitamin and mineral toxicities if astronauts consume too much in-mission and affect Long Term 
Health Outcomes (e.g., liver damage from Vitamin A overconsumption). 

• Nutrient Deficiencies occur when too little of a required nutrient is ingested. Scurvy from a lack of 
vitamin C or rickets from a lack of vitamin D are historic examples that can lead to Long Term 
Health Outcomes.  

• Antioxidants and other nutrients may play a role in affecting Radiation Carcinogenesis 
likelihood  and Long Term Health Outcomes for long missions.  

Surveillance enables us to detect Long Term Health Outcomes and better characterize the risk as 
we gather more evidence. 
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Risk of Hearing Loss and Performance Decrements Due to Acoustics Issues in Space 
(Hearing Loss Risk)
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Hearing Loss Risk DAG Narrative 

• From a health perspective this DAG centers around Cochlear Changes which are changes inside 
the inner ear that can lead to issues with hearing. These culminate in effects on Individual 
Readiness and Crew Capability. This can be influenced by changes in: 

─ Noise Exposure which includes Noise Intensity Level, Noise Exposure Duration, 
and Noise Spectrum.  

─ Ototoxins in the environment or in medications. 

─ Sudden Sensorineural Hearing Loss which is dependent on Individual Factors and has 
been recorded in some astronauts.  

─ Intracochlear Pressure caused by Fluid Shifts in Altered Gravity environments. In this 
case the Effective Exposure Duration accounts for the cumulative effect that the exposure 
will have for different Design Reference Missions. 

─ Barotrauma that can result from changes in pressure represented here by Environmental 
Conditions. This can result in Inner Ear Barotrauma that affects Cochlear Changes or 
Middle Ear Barotrauma that affects Measurable Hearing Shifts without affecting the cochlea. 
This is affected by Suit Design. 

• From a performance perspective, Noise Exposure leads directly to Task Performance showing 
that the noise environment can affect performance by impacting effective communications without 
degrading astronaut health.  

• Vehicle Design and the Crew Health and Performance System enable Noise Monitoring and In-
Flight Hearing Exams if these are designed into the system. When designed into the system, they 
enable Detect Noise Levels and Detect Hearing Changes. Inflight Hearing Exams must be coupled 
with Pre-Flight Hearing Status to enable detection of changes. Detection of either 
inappropriate Noise Levels or actual hearing changes can prompt crews to use Hearing 
Countermeasures such as hearing protection, which must also be designed into the Crew Health 
and Performance System to enable risk mitigation. 

• From the Barotrauma perspective, Environmental Monitoring Capability enables us to Detect 
Pressure Changes. Standards require that crew have Environmental Control over the rate of 
depressurization that can minimize the likelihood of experiencing Barotrauma. 

• Measurable Hearing Shifts and Hearing Countermeasures both affect Individual 
Readiness and Crew Capability. In some cases, Measurable Hearing Shifts can lead to medical 
problems like Hearing Loss both In-Mission as well as Long Term Health Conditions.  
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Risk of Adverse Outcomes Due to Inadequate Human Systems Integration Architecture (HSIA 
Risk) 
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HSIA Risk DAG Narrative 
The central issue in the Human Systems Integration Architecture Risk is that Anomalous Events 

occur in human spaceflight, and the chain of steps that takes place after an Anomalous Event occurs is 
affected by known factors. The chain includes: 

• Anomalous Event with one or more vehicle systems occurs. 

• The crew (or Ground Support) must be able to Detect Events that have occurred or there will be 
no further steps. 

• The crew (or Ground Support) must be able to accurately Diagnose Events that have occurred or 
they will not be able to intervene appropriately to resolve the event.  

• Once diagnosed, the crew (or Ground Support) must make an Intervention Decision based on 
the Mitigation Options available.  

• The Intervention Decision could lead to tasks required to fix a problem. Successful completion of 
these is Task Performance. If the Diagnosis and Intervention Decision were correct, then the 
anomaly will be resolved. If it was incorrect, then the anomaly will not be addressed. Failure to 
resolve vehicle system Anomalous Events or inadequate Mitigation Options can force 
Intervention Decisions that can lead to Loss of Mission Objectives, Evacuation, or Loss of 
Vehicle. 

Crew Capability denotes the functional capacity of the crew as well as their knowledge, skills and 
abilities. This is affected by:  

• The level and type of Ground Support available. This is dependent on Communication 
Factors including latency related to Distance from Earth. 

• Training performed before and during a mission. 

• On-Board Expertise that exists within the crew. This is also a function of Crew Size. 

• Crew deterioration experienced by the cumulative impact of all of the Other Risks (Human System 
Risks). These contribute through Individual Readiness and Team Functionality. 

• Effectiveness of the Crew Health and Performance System in offsetting the deterioration 
from Other Risks. 

Task Performance is the degree of success the entire crew has in performing mission tasks. 
Inadequate Task Performance in the case of repairs can lead to Loss of Vehicle or Loss of Mission 
Objectives These are affected by: 

• Crew Capability as represented above. Note that a 100% functional crew may not be able to 
perform some tasks because of the following factors. 

• Procedure Design which denotes the design of procedures that respects human limitations in 
terms of strength, reach, complexity, etc. 

• Maintainability which includes accessibility for maintenance and repairs and tool dependence and 
availability is dependent on Vehicle Design and the design of Vehicle Systems. 

• Resource Availability such as availability of necessary spare parts is dependent 
on Resupply related to Distance from Earth. 

The rest of this narrative focuses on what can affect the success of each of these factors in the 
central chain.  
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• The number any type of Anomalous Events are affected by Vehicle Design, the level of Crew-
Vehicle Integration achieved, contributions from Autonomous Systems, System 
Complexity, Mission Architecture Complexity (single vehicle, multiple vehicles, docking, 
planetary landings, etc.), and Effective Mission Duration. In cases of EVA, Suit Design also 
influences Anomalous Events. It is also affected by Time Critical Procedure Execution when 
performed by crew with reduced Crew Capability In other words, crew with functional impairments 
or insufficient knowledge, skills and abilities can make mistakes that lead to Anomalous Events in 
vehicle systems.  

• The ability to Detect Events is dependent on Crew Capability, Ground Support, and Monitoring 
Capability present in the vehicle.  

• The ability to Diagnose Events is dependent on System Complexity.  

• Monitoring Capability and Diagnostic Capability are heavily data dependent and are both 
affected by Data Accessibility. This is provided by the Data Architecture within the vehicle that 
makes available to crew System Telemetry and System Knowledge Resources needed 
for diagnosis and monitoring of the Vehicle Systems as determined by Vehicle Design. In the 
case of EVA, System Telemetry from the space suite is affected by the Suit Design. 

As Distance from Earth increases, the available mass, power, volume and data bandwidth become 
more restricted. The Standards/Requirements and HSI Processes that are used to influence Vehicle 
Design, Suit Design, and Crew-Vehicle Integration will functionally determine what vehicle and 
systems are fielded, how complex and maintainable they are, and how information on system state 
is provided back to crew and ground support. The ability to detect, diagnose, and effectively intervene 
on Anomalous Events that occur ultimately determines how much HSIA Risk the mission will carry. 
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Risk of Reduced Crew Health and Performance Due to Hypoxia (Hypoxia Risk) 
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Hypoxia Risk DAG Narrative 

• There are two levels of Hypoxia stemming from different sources that are concern in spaceflight. 
The Hypoxia node represents more severe hypoxia that can occur as a result of a Suit 
Failure, Toxic Exposure, or Depressurization from Vehicle Failure. This severity of hypoxia can 
lead to Loss of Crew Life or can impact Individual Readiness and Crew Capability.  

• Mild Hypoxia is a different concern that can lead to issues with Cognitive Function, Medical 
(Risk) conditions such as acute mountain sickness, and issues addressed by other Human System 
Risks including Sleep (Risk) and Immune (Risk).  

• Mild Hypoxia is of concern when considering Exploration Atmospheres for example, where 
changes to Atmospheric Constituents during Staged Denitrogenation can expose astronauts to 
physiologic hypoxia that is at a low level and chronic over time. Suit Failures that are not 
catastrophic can also induce Mild Hypoxia and these can be caused by either Suit Design issues 
or EVA Operations. The level of hypoxia experienced is also dependent on 
the Effective Exposure Duration. 

• Distance from Earth affects the available Mass, Power, Volume and Bandwidth available to a 
Crew Health and Performance System. The Crew Health and Performance System enables 
Environmental Monitoring Capability that can Detect Atmospheric Changes. In cases where 
those changes warrant, countermeasures such as Breathing Masks, Pressure Suits, 
and Compartment Isolation can be implemented to protect Individual Readiness, Crew 
Capability, and health.  

• Historically pilots and astronauts are exposed to hypoxic conditions prior to flight so that they can 
understand how their unique symptoms are expressed. This is because the insidious onset of 
hypoxia can affect Individual Readiness and Crew Capability severely enough that Task 
Performance for critical tasks like piloting a vehicle may be affected and Loss of Vehicle can 
occur.   
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Risk of Adverse Health Event Due To Altered Immune Response (Immune Risk) 
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Immune Risk DAG Narrative 
The central issue in the Immune Risk is the progression from Persistent Subclinical Immune 

Dysregulation -> Clinically Significant Immune Dysregulation -> Medical Illness. Oxidative Stress, 
Persistent Subclinical Immune Dysregulation and Clinically Significant Immune Dysregulation can 
affect Inflammation levels in the body that contribute to Medical Illness. 

• Subclinical Immune Dysregulation refers to changes in cellular proliferation and function that 
does not have a known clinical issue directly following it.  

• Clinically Significant Immune Dysregulation refers to the threshold at which those cellular 
issues have a known prognostic indication for impending disease. 

• The Medical Illnesses that can result are a function of both hypoactive and hyperactive 
immune dysregulation. 

• Hypoactive dysregulation predisposes astronauts to increased probability of infections. 

• Hyperactive dysregulation predisposes astronauts to increased probably of hypersensitivity 
reactions like rashes and autoimmune disease. 

Increasing probability of Medical Illnesses contributes to deterioration of Individual Readiness 
and Crew Capability which affects Task Performance, likelihood of Evacuation for medical reasons, 
and in severe cases can contribute to Loss of Crew Life. Persistent medical issues post flight and post 
career may affect Flight Recertification and Long Term Health Outcomes.  

• Contributors to the start of this chain of events include: 

• Radiation exposure leads to Oxidative Stress that can contribute to immune dysregulation. 

• Nutrients which are dependent on safe and acceptable Food and Nutrition (Risk). 
• The Microbiome which is dependent on the status of the Microhost (Risk). 
• Atmospheric Conditions including airborne content affected by the Hypoxia, CO2, Dust (Risks). 
• Circadian Misalignment associated with the Sleep (Risk) is known to affect immune function. 

• Stress associated with the Behavioral (Risk) is known to affect immune function. 
Countermeasures that affect immune system function must be included in the Crew Health and 

Performance System and accommodated in Vehicle Design. These are affected by the HSIA 
(Risk) and include: 

• Countermeasures that may prevent Persistent Subclinical Immune Dysregulation. 

• Probiotics and Supplements which are dependent on the Pharm (Risk) and may require different 
storage modalities.  

• Other stress relieving techniques such as Stress Relieving Virtual Reality (VR). 
• Exercise has been shown to improve Subclinical changes in the immune system. 

• Lab Blood Monitoring enables the ability to Detect Immune Changes that are either subclinical 
or clinically significant. When detected, these can enable further interventions including: 

─ Medical Prevention Capability such as evaluations by the crew medical officer that can help 
reduce the causes of immune dysfunction. 
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─ Medical Treatment Capability that responds to the infections or hypersensitivity reactions 
that occur and seek to minimize the consequences of those medical conditions. 

─ Both of these are dependent on the Pharm (Risk) as medications used are subject to stability 
and pharmacokinetic (PK)/pharmacodynamic (PD) issues. 

• The likelihood of infectious diseases (Medical Illness) in a mission is also affected by Microbial 
Virulence Factors which have been shown to change in spaceflight. 

• Long Term Health Outcomes that may occur as a result of immune dysregulation must be 
included in Surveillance post flight and post-career in order to effectively Detect Long Term 
Health Outcomes and characterize the magnitude of this risk in the Long Term Health domain. 
These can include hypersensitivity conditions, autoimmune disorders, and cancers. 
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Risk of Adverse Health Outcomes and Decrements in Performance Due to Medical Conditions 
that occur in Mission, as well as Long Term Health Outcomes Due to Mission Exposures (Medical 

Risk) 
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Medical Risk DAG Narrative 
The Medical Risk boils down to two parts – First, what medical conditions/events are going to 

happen in a given mission. Second, what can be done to decrease the likelihood (prevention) or the 
consequence (treatment) of those events.  

• For the first part: Total Medical Events are made up of three categories – Environmental Injuries, 
Traumatic Injuries, and Medical Illnesses.  

─ Environmental Injury likelihood is affected by Environmental Conditions (and other 
Environmental Risks), EVAs, and Vehicle and Suit Designs. Individual Factors inform the 
bio-variability in response to environmental insults. 

─ Traumatic Injury likelihood is affected by EVAs, Vehicle and Suit Designs, and other risks 
(Bone fracture, Dynamic Loads, Crew Egress, Muscle and Aerobic (Risks)). 

─ Medical Illness likelihood is affected by other risks and Individual Factors.  
Each of these categories can affect mission level outcomes, especially if not planned for. This is 

why there is a second part – What can we do about it? 

• For the second part: The Crew Health and Performance System provides for a variety of 
capabilities intended to mitigate medical risk. These include Medical Prevention Capabilities 
(designed to decrease likelihood of conditions) and Medical Treatment Capabilities (designed to 
decrease the consequence of conditions that have occurred). Deciding on what treatment to 
provide is an information dependent process that requires Physiologic and Environmental 
Monitoring Capabilities and Diagnostic Capabilities. These are closely linked to a Data 
Architecture and depend on Data Accessibility to inform the correct Treatment Decision. If an 
incorrect Treatment Decision is reached, risk is not mitigated, and it may be increased. 
Diagnostic and Treatment Capabilities are dependent on the On-Board Expertise, Ground 
Support, Training, Resource Availability, and Data Architecture provided by the Crew Health 
and Performance System.  

• Resource Availability is dependent on Resupply. Ground Support is dependent on 
Communication Factors including communications delay. Both of these are dependent on 
Distance from Earth.  
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Risk of Adverse Health Effects Due to Host-Microorganism Interactions (Microhost Risk) 
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Microhost Risk DAG Narrative 

• The Microhost Risk centers around the possibility for microbial contamination leading to 
Infections that if left inadequately treated could become Sepsis. Both Infections and Sepsis can 
lead to deterioration of Individual Readiness and Crew Capability which affects Task 
Performance, likelihood of Evacuation for medical reasons, and in severe cases can contribute 
to Loss of Crew Life. They can also lead to Long Term Health Outcomes if inadequately treated 
and post-mission/career Surveillance enables Detection of Long Term Health Outcomes to 
understand the magnitude of the problem. 

• The cause of infections can come from various sources:  

─ Microbial Virulence Factors – evidence that the virulence of certain microbes change in 
response to spaceflight environment.  

─ This may lead to an increased risk of infections. 

─ Can indirectly lead to infections through changes in Microbiome. 

─ Immune (Risk) - the strength of the immune system determines how well individuals fight 
off infections. 

─ Surface Contamination - microbes on surfaces are found regularly on ISS, cleaning 
procedures can decrease impact on crew. 

─ Air Contamination – good air quality and filtration can limit likelihood of airborne and droplet-
based infections among crew. 

─ Water Contamination - water quality monitoring and cleaning helps limit infections in crew. 

─ Pharmaceutical Contamination - repackaged pharmaceuticals are susceptible to 
contamination increasing risk for infection among crew. 

─ Food Contamination – inadequate packaging and storage conditions for crew food could 
lead to infections including gastroenteritis. 

• Countermeasures that affect microbial levels must be included in the Crew Health and 
Performance System and accommodated in Vehicle Design. These are affected by the HSIA 
(Risk) and include: Countermeasures include the storage conditions which if compromised could 
increase contamination of food and pharmaceuticals; the storage conditions are also impacted by 
the food system available which is represented in the DAG by the Food and Nutrition (Risk). 

─ Preventive Source Control includes monitoring, regular cleaning, filtration and other modes 
of limiting spread of microbes. 

─ Hygiene includes personal hygiene such as regular showers, dental hygiene, and other 
personal cleaning that limits the development of Infection.  

─ Environmental Monitoring Capability is necessary to Detect Contamination levels in the 
air, water, and surfaces. This enables Intervention Source Control measures like cleaning 
or maintenance of filtration systems.   

─ Medical Treatment Capability includes antibiotics, antifungal, and antiviral medications, as 
well as other supportive care, intended to minimize consequence of infection and prevent 
the development of sepsis. 
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─ Infections and Sepsis affect cognitive function, mood and performance and therefore 
affect Behavioral (Risk) and Team (Risk) which negatively impacts Individual Readiness 
and Crew Capability. 



58 

 

Risk of Impaired Performance Due to Reduced Muscle Size, Strength, and Endurance (Muscle 
Risk) and Risk of Reduced Physical Performance Capabilities Due to Reduced Aerobic Capacity 

(Aerobic Risk) 
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Muscle and Aerobic Risks DAG Narrative 

• Altered Gravity across all DRMs includes microgravity, lunar gravity, Mars gravity and Earth 
Gravity. This affects Effective Gravity Level experienced by crew and through 
that Musculoskeletal Loads. 

• Isolation and Confinement, especially over long Effective Mission Durations can induce 
monotony and anhedonia affecting the Motivation to perform needed exercise. 

• Distance from Earth determines the mass and volume allocations for Vehicle Design and Suit 
Design and affects the Effective Mission Duration. 

• The central focus of the Muscle and Aerobic Risk DAG is on Aerobic Fitness and Muscle 
Performance levels being adequate for crew to do the tasks that are expected of them (Task 
Performance). These directly influence Individual Readiness and crew readiness or fitness for 
duty (Crew Capability). 

• When these nodes are negatively affected, the performance of EVAs - EVA (Risk) - and the 
performance of post-landing tasks – Crew Egress (Risk) may be threatened. 

• Aerobic Fitness and Muscle Performance are directly affected by the Muscle Physiologic 
Changes that occur at the level of cardiac, smooth, and skeletal muscle throughout the body as a 
result of the duration of exposure to the spaceflight environment. Aerobic Fitness is also directly 
dependent on the functionality of the Cardiovascular system (Cardiovascular Risk). 

• These Physiologic Changes are the result of several contributing factors: 

─ Musculoskeletal Unloading that occurs as a result of the Altered Gravity Environment. 

─ Endocrine Factors that are related to the Isolation and Confinement experienced. 

• Countermeasures to these include: 

─ Resistive Exercise. 

─ Aerobic Exercise. 

─ Medications - Pharm (Risk). 

─ Nutrients - Food and Nutrition (Risk). 

• Other contributing factors can include the Motivation to exercise which is impacted 
by Fatigue through the Sleep (Risk) and Food and Nutrition (Risk), Effective Mission 
Duration that can induce monotony, design and maintenance challenges from the HSIA (Risk). 

• The exercise capability that protects Aerobic Fitness and Muscle Performance is the result of 
the Vehicle Design process, the HSIA (Risk), and the fielded Crew Health and Performance 
System. These define and limit the presence and reliability of the Exercise Hardware that is 
available in a mission. The Exercise Prescription that can be accomplished by crew is limited by 
the Schedule, Vibration Isolation System, Previous Injury, and environmental factors such 
as Temperature, Humidity, and CO2 (Risk) that are a function of the ECLS System.  
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Risk of Adverse Health Outcomes and Performance Decrements resulting from Non-Ionizing 
Radiation during Spaceflight (Non-Ionizing Radiation Risk) 
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Non-Ionizing Radiation Risk DAG Narrative 

• The central risk for Non-ionizing Radiation is in Eye Injuries and Skin Injuries that can result 
from Sunlight or Laser Exposure.  

• If these occur, they can create functional impairments that affect Individual Readiness and Crew 
Capability in mission, especially in loss of vision.  

• Protection from these exposures occurs through Protective Windows and Filters that are 
designed into the vehicle, Helmet/Protective Visors that are designed into the suits, and the 
provision of Protective Glasses for crew as needed.  

• Crew Health and Performance System -> Medical Treatment Capability captures any 
treatments that need to be planned into the system, possibly including pain medications, ocular 
drops, skin creams for burns, etc.  

• If Eye Injuries do occur from these exposures, then there is a chance that they will affect Flight 
Recertification of crew and possibly include Long Term Health Conditions like debilitating visual 
defects.  
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Risk of Ineffective or Toxic Medications During Long-Duration Exploration Spaceflight (Pharm 
Risk) 
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Pharm Risk DAG Narrative 
DAG: Nodes Directly Affecting Pharmacokinetics. 

• Absorption:  How a drug enters the body. 

─ Intestinal Absorption – For oral medications, most absorption occurs in the small intestine. 

─ Gastric Emptying Time – The rate-limiting step of oral absorption. 

• Distribution:  The journey of the drug through the bloodstream to various tissues of the body. 

─ Changes in total body water or Intravascular Volume. 

─ Plasma protein binding. 

• Metabolism: How the drug is biotransformed (broken down) in the body. 

─ Hepatic Function, Hepatic Enzymes. 

─ Other organs (e.g. Lungs, kidney, gastrointestinal (GI), skin). 

• Elimination:  How a drug is removed from the body. 

─ Renal Function. 

─ Hepatic Function. 

─ Minor Pathways. 

 

The Pharm Risk centers around Pharmaceutical Effectiveness. There are three basic things that 
contribute to this. 1. In-Mission Shelf Life, 2. Physiologic Changes, and Antimicrobial Resistance. 
Hazards affecting this risk include Distance from Earth, Hostile Close Environment, Radiation and 
Altered Gravity. 
• In-Mission Shelf Life is defined from the time that medication is packed to whenever the 

medication is used or jettisoned. This is dependent on Environmental Conditions in the vehicle 
and Pharmaceutical Storage Conditions - i.e., refrigeration, packaging, etc. The Manufacturer 
Shelf Life refers to the labeled shelf life the medication would have without spaceflight exposure. 
Effective Mission Duration refers to how long the medications are exposed to the spaceflight 
environment. 

• Physiologic Changes are the changes that the human body experiences that affect how a 
pharmaceutical functions within the body. Fundamentally this is broken into absorption, 
distribution, elimination, and metabolism of medications. Metabolism is affected by many 
factors including enzyme expression and pharmacogenomics. All lead to variations in 
Pharmacokinetics (the concentration of the active ingredient in the body over time) and 
Pharmacodynamics (how the target tissues use the medication). Individual Factors (age, sex, 
etc.), Hydration, and Fluid Shifts affect these physiologic changes.   

• Antimicrobial resistance, including antibiotics, antivirals and antifungals, can affect the 
effectiveness of some pharmaceuticals.  

• Pharmaceutical Effectiveness is upstream of Medical Prevention Capability, Medical 
Diagnostic Capability, and Medical Treatment Capability.  

• Medical Prevention Capability in this case includes any medications used to prevent the effects 
of other risks. Examples include Potassium Citrate for Renal Stone Prevention, Bisphosphonates 
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for Bone protection, etc. There are 11 risks shown that have known potential pharmaceutical 
preventive cases. 

• Medical Diagnostic Capability includes any medications used to assist in diagnosis. For example, 
proparacaine used to enable intraocular pressure measurements for the Risk of Spaceflight 
Associated Neuro-ocular Syndrome (SANS) risk. Note that in this example proparacaine In-
Mission Shelf Life is strongly affected by refrigeration (Storage Conditions). 

• Medical Treatment Capability includes any medications used to treat medical conditions. This 
includes medications for symptoms including pain, nausea, fever, etc. as well as definitive 
treatments such as antibiotics for infections. Multiple risks include treatment needs including 
Cardiovascular (Risk), EVA (Risk), Decompression Sickness (Risk), and Electric Shock 
(Risk)*. Most of the risks shown in the Preventive Medication Capability pathway include a need 
for treatment as well i.e., pain control for renal stones, etc.  

• Medical Prevention Capability and Medical Treatment Capability can affect the severity of Side 
Effects which then can affect Individual Readiness, Crew Capability and Task Performance, all 
which could lead to Loss of Mission Objectives or Loss of Mission.  

• Additional paths included: 

─ Pharmaceutical Toxicity can occur from two sources: 1) degradation products may be toxic; 
2) dosing errors and other factors can lead to under-or over-dosing of a given medication. In-
mission Shelf Life can reduce the amount of active pharmaceutical ingredients present or 
lead to degradation products that may cause Pharmaceutical Toxicity. Over-dosing of 
medication can lead to life-threatening toxicities including suppression of breathing in the 
case of opioid use or damage to organs such as liver failure in acetaminophen overdose.  

─ Medication compatibility – This includes both the compatibility of medications of the vehicle 
environment (Vehicle Design) and the suit (Suit Design). It also includes the capability of the 
provision of a medication while wearing the suit. This affects what medications can be 
administered to the crew in suited operations. 

─ Vehicle systems and suits that can be damaged by a medication therapy - I.e., topical 
medications that cause Suit Damage. We do not know what components of medications 
create problems for the suit and the atmosphere in the suit but continue to be asked by 
engineering for that information. 

─ Suit Design that doesn’t allow for proper Medical Treatment Capability - E.g., Orion 144-
hour suit contingency allows for a small port in the helmet to administer a small number of 
oral medications. Not all medications fit. 

─ Resupply and Resource Availability – Distance from Earth can affect the ability to 
Resupply in some DRMs can lead to a risk of inadequate medications. If Pharmaceutical 
Effectiveness is lessened through either degradation or PK/PD issues, crew may use more 
medications than originally planned and potentially run out sooner. 

─ Surveillance enables us to Detect Long Term Health Outcomes and better characterize 
the risk as we gather more evidence. 
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Risk of Radiation Carcinogenesis (Radiation Carcinogenesis Risk) 
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Radiation Carcinogenesis Risk DAG Narrative 

• Exposure to space Radiation increases the likelihood that an individual will develop cancer due to 
interaction of Charged Particles and Neutrons with the human body. The ionizations that occur 
within the body lead to a Biologic Response that occurs on the cellular and molecular level which 
modifies the likelihood that an astronaut will develop Cancer post-mission and post-career.  

─ The flux of Charged Particles that astronauts may receive is affected by the Trapped 
Radiation, Galactic Cosmic Radiation (GCR), and Solar Particle Events that may happen 
during a mission.  These in turn are affected by the Solar Cycle. 

─ The flux of Neutrons is affected by Charged Particle interactions with vehicle Shielding or 
Extraterrestrial Surfaces such as the Moon or Mars.  

─ Nuclear Technology, if used in a mission for propulsion or power generation, can lead to 
additional Charged Particle exposure, Gamma Ray exposure, and additional Neutron 
exposure for the astronauts. 

─ Other Biomedical Exposures such as CT scans for research or medical purposes can also 
affect Biologic Response and likelihood of developing Cancer.  

• Besides spaceflight radiation exposures, there are other factors that modify an individual’s 
susceptibility to developing cancer that must be considered. Astronaut Selection processes 
modify the Individual Factors present in the crew. 

─ Non-Modifiable Individual Factors such as age, sex, genetic predispositions, and pre-
existing medical conditions. 

─ Modifiable Individual Factors such as smoking habits, exercise and dietary habits, alcohol 
habits, etc. 

─ Any of these factors can modify the likelihood that Cancer will occur for a given astronaut 
post-career. 

• Surveillance enables us to detect Cancer (Detect Long Term Health Outcomes) which can 
inform Cancer Treatment. Both the occurrence of Cancer and Cancer Treatments can affect 
Long Term Health Outcomes such as subsequent illnesses, premature death, and quality of life 
issues.  

• Distance from Earth impacts the Vehicle Design through and volume allocations for Shielding 
and the Crew Health and Performance System. Inclusion of these are affected by the HSIA 
(Risk). 

• The Crew Health and Performance System provides allocations for:  

─ Medical Prevention Capability which may provide medications or supplements designed to 
reduce overall space radiation carcinogenesis risk by modifying the biologic response to 
radiation. These would be affected by the Pharm (Risk) issues like all other medications. 

─ Radiation Monitors on the spacecraft enable the detection of changes in Charged Particle 
or Neutron flux (Detect Radiation) that may be associated with Solar Particle Events, 
changes in Galactic Cosmic Rays, and Trapped Radiation due to the Solar Cycle. 
o Monitoring can drive Intervention Measures in mission such as reconfiguring mass for a 

storm shelter, donning additional radiation protection, or early termination of EVAs.  
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o Monitoring also enables Estimated Dose Rate and Estimated Mission Dose as well as 
informing the Cancer Model regarding crew exposures. The Estimated Mission Dose 
can be affected by Effective Mission Duration which in turn can be modified by Nuclear 
Technologies. 

Estimated Mission Radiation Dose is combined with Prior Mission Exposures to assess an 
Estimated Career Dose for each astronaut. This information is used in conjunction with agency 
standards to inform Flight Recertification for each astronaut. 
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Risk of Renal Stone Formation (Renal Stone Risk) 
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Renal Stone Risk DAG Narrative 
The Risk of Renal Stone Formation (urolithiasis) in spaceflight is predicated on the Hazards 

influencing Urine Chemistry. Altered Gravity may cause increased calcium in the blood and urine due 
to Bone Remodeling, while the Hostile Closed Environment may alter the Hydration Status.  

• The central story of the Renal Stone Risk focuses on the pathway from Urine 
Chemistry to Medical Illness. The steps included are: 

─ Urine Chemistry is affected by a variety of factors including the Microbiome. The calcium, 
potassium, citrate, oxalate and other chemical concentrations in the urine determine the 
probability that Mineralized Renal Material will precipitate out of the urine and adhere to the 
wall of the nephron or calyx.  

─ The growth of this Mineralized Renal Material in part determines the likelihood that it will 
break off and become a kidney stone also called Nephrolithiasis. When this occurs, the 
stone exists in the kidney but does not cause pain or infection.  

─ There is some probability that the stone in the kidney will progress and enter the ureter. This 
is called Ureterolithiasis and at this point the stone can cause pain and other symptoms. 
This includes affecting Urine Flow which can predispose to several types of Medical 
Illness including Hydronephrosis, UTI, Pyelonephritis, and possibly Sepsis if untreated. 

─ All of these things can affect Crew Capability because the pain, nausea, and infections can 
cause functional incapacitation for some time, typically less than 14 days unless  the stone 
fails to pass. With failure to pass and progression to other Medical Illnesses, there is a 
chance that Evacuation or Loss of Crew Life could occur. Effects on Individual 
Readiness, Crew Capability or Evacuation can lead to problems with Task 
Performance that can lead to Loss of Mission Objectives or Loss of Mission if severe. 

• There are several contributing factors that can modify the likelihood of each of the above steps 
occurring. Those include: 

─ Urine Chemistry is affected by: 
o Excess calcium in the blood that can occur as a result of Bone Remodeling which is 

affected by the Bone Fracture (Risk). 
o Changes in Urine Concentration that are affected by Hydration Status 
o And the CO2 (Risk) that affects the acid-base balance in the body. 

─ Nephrolithiasis is affected by Individual Factors such as genetic predispositions as well as 
by Astronaut Selection as those individuals with a high risk of renal stones would not be 
selected into the Astronaut Corps. 

─ Urine Flow is also affected by the Urinary Retention (Risk). 

• To counteract the progress of this process, multiple Crew Health and Performance 
System Capabilities must be considered in Vehicle Design. These are affected by the HSIA 
(Risk).  

• Medical Prevention Capabilities can affect several steps in this process: 

─ Water Intake requirements for crew affect the Hydration Status and has been shown to be 
effective at preventing stone formation. 
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─ Potassium Citrate and Thiazide medications directly affect the Urine Chemistry and can 
help prevent stone formation. 

─ Exercise and Bisphosphonate medications directly affect Bone Remodeling including the 
calcium released into the bloodstream. 

─ Nutrients affect Urine Chemistry through the intake of various substances such as oxalate, 
calcium, magnesium, etc. and must be considered in the Food and Nutrition (Risk).  

─ Medical Monitoring Capabilities: 
o Ultrasound Diagnosis is a key monitoring capability for several reasons. It allows 

diagnosis and monitoring of Mineralized Renal Material and Nephrolithiasis before they 
become significant clinical issues. Ultrasound may also detect stones within the ureter. 

• It also enables several treatment options discussed below: 

─ Medical Treatment Capabilities: 
o Recent progress has been made in focused ultrasound applications that enable non-

invasive Ultrasound Manipulation of stones in the kidney before they enter the Ureter. It 
also may enable Ultrasound Manipulation of stones in the Ureter including the capability 
to remove some stones from the proximal or distal Ureter and decreasing the time that 
crew are symptomatic. 

o In the case of Hydronephrosis or Pyelonephritis, Ultrasound can be used to guide 
insertion of a Percutaneous Nephrostomy Tube that can alleviate symptoms and help 
stabilize an otherwise sick astronaut.  

o Tamsulosin is a medication that relaxes the smooth muscle in the Ureter and can help 
allow Ureterolithiasis to pass faster.  

o Medications can include pain medications like NSAIDs and Opioids as well as anti-
emetic medications such as Ondansetron that can control the symptoms of the Medical 
Illnesses caused by renal stones. This can also include antibiotics in the cases 
of UTI and Pyelonephritis. Effectiveness of all medications is in part affected by 
the Pharm (Risk). 

• Failure to diagnose and treat renal stones can lead to Long Term Health Outcomes including 
chronic kidney disease and other issues. Surveillance post-mission and post career enables us 
to Detect Long Term Health Outcomes and better characterize the long term risk. 
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Risk of Spaceflight Associated Neuro-ocular Syndrome (SANS Risk) 
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SANS Risk DAG Narrative 

• Altered Gravity removes (0 g) or reduces (partial g) the hydrostatic pressure gradient, causing a 
cephalad Fluid Shifts within the arterial and venous systems and within the cerebrospinal fluid 
column. Individual Factors such as age, sex, genetic predispositions, pre-existing medical 
conditions and more influence variability in biologic response to the spaceflight environment. This 
can affect multiple nodes discussed below. 

• These cause physiologic changes including Venous Congestion and possibly Intracranial 
Pressure Changes in the brain. CO2 (Risk) and Sleep (Risk) may have a causal connection to 
Intracranial Pressure Changes as CO2 is known to cause vasodilation of cerebral arterioles, and 
impaired sleep may reduce lymphatic/glymphatic clearance from the brain and eye. Invasive 
measures of Intracranial Pressure Changes have not been obtained in-flight. 

• These physiologic changes are hypothesized to underlie the structural changes in the eye including 
Optic Disc Edema, Globe Flattening, and Chorioretinal Folding. Terrestrially, Optic Disc 
Edema can lead to Retinal Nerve Fiber Layer Atrophy but this has not been observed in the 
astronaut population. 

• In-mission, these structural changes lead to functional changes in the eye including Refractive 
Error Shifts, and reversible Visual Field Defects have been detected postflight. These in turn 
affect Individual Readiness for mission tasks that can progressively affect Crew Capability and 
Task Performance overall.  

• Brain Structural Changes are hypothesized to result from the cephalad fluid shift, but potential 
acute effects and/or Long Term Health Outcomes are unknown.  

• To characterize the risk, Surveillance is required to Detect Long Term Health Outcomes that 
may present as cognitive or visual decrements post-flight or post-career. 

• To assess and counteract the SANS issues in flight, the Vehicle Design must include a Crew 
Health and Performance System that provides mass and volume allocations for several 
countermeasure pathways. Inclusion of these pathways are affected by the HSIA (Risk). 

• Medical Prevention Capabilities include: 

─ Astronaut Selection affects and limits the Individual Factors present in the crewmembers.  

─ Lower Body Negative Pressure is under consideration as a preventive countermeasure for 
many effects of Fluid Shifts.  

─ Veno-occlusive Thigh Cuffs may reduce Fluid Shifts and may improve Venous Congestion 
and Intracranial Pressure Changes.  

─ Supplements such as B vitamins are hypothesized to affect homocysteine pathways and 
improve microvascular function and reduce edema. These are related to the Food and 
Nutrition (Risk). 

─ Medications have been considered to prevent Intracranial Pressure Changes and these 
are affected by the Pharm (Risk). 

• Monitoring Capabilities include: 

─ Optical Coherence Tomography is used pre-, post-, and in-flight to assess the retina, 
choroid, and optic nerve head. 

─ In-flight Fundoscopy to assess gross structural changes in the optic nerve head and retina. 
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─ Pre- and post-flight MRI to track structural changes in the eye and brain. 
─ Pre-, post-, and in-flight Ultrasound to assess structural changes within and posterior to the 

eye. 

─ Testing for Visual Acuity and Visual Fields assess the functional state of the eye. These 
allow us to Detect Visual Changes and guide Medical Treatment Capability in-mission. 

─ In-Flight direct Intracranial Pressure Monitoring is of interest but has not been performed to 
date. It is speculated that this information could enable us to Detect Intracranial Pressure 
Changes and that information could be used to guide Medical Treatment Capabilities in the 
future.  

• Medical Treatment Capabilities: 

─ Corrective Lenses are the current treatment modality in-mission for visual changes that may 
affect Individual Readiness. This requires the ability to provide corrective lenses with the 
appropriate corrective power. 

─ There is currently no proven inflight pharmaceutical treatment available for SANS.  

• Flight Recertification has been affected when ocular structure changes (e.g., severe SANS 
findings) and Intracranial Pressure Changes have been detected post flight.   
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Risk of Altered Sensorimotor/Vestibular Function Impacting Critical Mission Tasks 
(Sensorimotor Risk) 
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Sensorimotor Risk DAG Narrative 

• The Sensorimotor Risk is primarily derived from Altered Gravity environmental changes but also 
has effects from Radiation and Hostile Closed Environment. 

• Time spent in an Altered Gravity environment causes physical changes to the body including: 

─ Fluid Shifts – fluid shifts from the lower body towards the upper body.  

─ Musculoskeletal Loads – end-organ changes (e.g., otoconia size, changes in neural 
synapses) to physical unloading. 

─ Morphological G-Receptor Changes – cellular responses to physical unloading. 

• These changes lead to physiologic changes that affect:  

─ Vision and Gaze Control - vision is the ability to see and gaze control is the ability to orient 
the eyes, and maintain fixation, on a desired visual target. Radiation can induce cataracts 
that affect vision. 

─ Vestibular Gain Changes - the relationship between accelerations, including gravitational 
and vestibular responses. 

─ Vestibular Motor Neuron Changes - vestibular neurons adapt to reduced or increased firing 
rates and become more or less sensitive. Radiation and the Hostile Closed Environment 
are suspected to affect motor neurons. 

─ Proprioception - a global term that encapsulates multiple internal sensors that monitor the 
relationship between one body segment and another.  

─ Muscle Physiologic Changes - reduced loading on muscle, tendons, and ligaments that 
cause both structural and functional changes in strength. 

• All of these physiologic changes send signals that must be interpreted by the brain and here is 
represented by Multi-Sensory Integration Alterations. Radiation and the Hostile Closed 
Environment effects on the central nervous system is suspected to affect this central processing.  

• The central nervous system must integrate information from all of these systems. Multi-Sensory 
Integration Alterations lead to functional impairments such as: 

─ Motion Sickness occurs when vestibular and ocular signals from the brain are conflicting.  

─ Fine Motor Control limits the ability to perform tasks that require delicate control.  
─ Postural Control and Locomotion refer to the balance and ability to walk that are required 

to perform physical tasks in a gravity environment. 

• The severity of these functional impairments directly impacts Individual Readiness and Crew 
Capability and specific tasks including: 

─ Manual Control of Vehicles which depends on Fine Motor Control and perception. 

─ EVA (Risk) through the increased likelihood of falls or injury. 

─ Crew Egress (Risk) through the increased likelihood of falls or injury. 

• These affect Individual Readiness, Crew Capability and through them Task Performance and 
other Mission Level. 
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• Distance from Earth affects the mass, power, volume, and bandwidth allocations for Vehicle 
Design the Crew Health and Performance System in particular. These include: 

─ Exercise including Exercise Hardware which affects Postural Control and Locomotion. 

─ Medical Prevention Capabilities such as the following are still experimental and include: 
o Strobe Goggles. 
o Self-Administered Rehab. 
o Sensory Augmentation. 
o Balance Training. 

• Medical Treatment Capabilities can include medications such as Phenergan, etc. that are 
susceptible to stability issues included in the Pharm (Risk). 

• Artificial Gravity as a countermeasure holds the potential to significantly reduce the Sensorimotor 
Risk but is high cost to implement.  
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Risk of Performance Decrements and Adverse Health Outcomes Resulting from Sleep Loss, 
Circadian Desynchronization, and Work Overload (Sleep Risk) 
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Sleep Risk DAG Narrative 
The Sleep Risk is driven mainly by the hazards of Isolation and Confinement, Hostile Closed 

Environment, and Altered Gravity each of which impacts the Stress of the crewmember.  
The Sleep Risk focuses around two key nodes: 

• Sleep Deficiencies occur for a variety of reasons in human spaceflight including: 

─ Schedule Shifting including slam shifting that has been a common occurrence given arrivals 
and departures of vehicles from different parts of the world, etc.  

─ The Workload that an astronaut undertakes, including the strenuous demands of any EVAs 
represented by the EVA (risk). 

─ Stress encountered in the mission environment for example as relates to alarms and 
emergencies. 

─ Environmental Conditions that are present in the sleep quarters including temperature, 
humidity, noise, privacy, etc.  

─ Food and Nutrition (Risk) represents the connection between the food that astronauts are 
given and can include effects of specific substances like caffeine and insulin and meal-timing 
relative to sleep timing.  

• Circadian Misalignment is dependent on: 

─ Environmental Conditions specifically including lighting as the intensity, wavelength, and 
timing of lighting exposure drives circadian entrainment. 

─ Schedule Shifting including slam shifting that creates an inappropriate series of lighting cues 
as well. 

─ There is also a dependence on Behavioral (Risk) and Team (Risk) not shown here due to 
the acyclic requirement. 

• When these occur, they can lead to other issues including: 

─ Fatigue which as a category can include mental fatigue, physical fatigue, 
sleepiness/drowsiness etc. These all can affect Crew Capability by impacting readiness 
for Task Performance. 

─ Sleep Inertia is amplified when astronauts are chronically sleep deprived, wakes at an 
adverse circadian phase or from deep sleep or when crew take hypnotic medications. This 
can affect Individual Readiness and Crew Capability including the timing to response to 
alarms for example.  

─ Insomnia is when sporadic sleep deficiencies become persistent and meet the definition of a 
clinical medical condition. This is an inability to get adequate sleep when provided adequate 
opportunity. This is part of the Medical (Risk) and leads to further medical issues requiring 
treatment. 

• Environmental Conditions are defined by the Vehicle Design and the ELCS System design and 
are dependent on Standards/Requirements and HSI Processes that are part of the HSIA (Risk). 
This is specifically true for private sleep quarters IF they are designed into the systems.  

─ Radiation, including Solar Particle Events, can cause Environmental Conditions to 
change. 
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─ Environmental Monitoring enables Detect Environmental Changes can cause Schedule 
Shifting when responding (i.e., reconfiguring mass to mitigate radiation exposures) and 
Stress among the crew in the case of Solar Particle Events. 

─ There is weak evidence that suggests that Radiation may cause Sleep Deficiencies. 

• The Crew Health and Performance System includes several potential countermeasures for sleep 
issues: 

─ Environmental Monitoring which provides the ability to Detect Environmental Conditions 
relevant to sleep. And, when designed into the ECLS System, the ability for the crew to 
exercise Environmental Control over the relevant parameters that disrupt sleep in the 
sleeping quarters.  

─ Medical Prevention Capability includes Hypnotic and other medications that may be used in 
anticipation of Sleep Deficiencies that could occur for example in the case of expected Slam 
Shifting.   

─ In cases where sleep issues are not expected or growing, Medical Treatment Capabilities 
may be brought to bear to minimize the consequences of the Sleep Disturbances or 
Insomnia.  

• Sleep issues can lead to other Medical (Risk) issues as well as Long Term Health Outcomes 
including diabetes, hypertension, etc. that should be monitoring in post-flight and post-career crew 
through Surveillance in order to Detect Long Term Health Outcomes and better inform the 
magnitude of the long term health risks associated with Sleep.  
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Risk of Performance and Behavioral Health Decrements Due to Inadequate Cooperation, 
Coordination, Communication, and Psychosocial Adaptation within a Team (Team Risk) 
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Team Risk DAG Narrative 

• Isolation and Confinement affects Interpersonal Relationships directly and through monotony, 
boredom, and other possible Behavioral affects that are represented in the Behavioral (Risk). 

• Distance from Earth affects the mass and volume allocations that limit Vehicle Design decisions. 
It also affects Communications Delays, influences Effective Mission Duration, and affects Crew 
Size. 

• The central issue in the Team Risk is that Team Cohesion, Team Skills, and Team Cognition 
come together to influence Team Functionality, and ultimately, Crew Capability. Ground 
Support, which will be heavily impacted by communication delays, is an important part of the 
spaceflight multi-team system. The Team Risk operates downstream of many other Risks, and at a 
higher level than the individual, but is heavily influenced by the individuals and individual-level 
Risks in the system.  

─ Duration is related to distance, but not always, and it has implications for the (likely 
decremented) team functioning over time. 

─ Crew Size is another potential stressor that is more loosely tied to the 5 Hazards, but has 
implications for the knowledge, skills and abilities, relationships, and simply # of person-
hours, hands available onboard. 

• Team Functionality is the degree of coordination, cooperation, communication, and psychosocial 
adaptation that enables a team to successfully complete tasks and live and work as a team. It is 
affected by:  

─ Team Cognition is shared understanding among team members that is related to roles and 
responsibilities, team mission objectives and norms, and familiarity with team members’ 
knowledge, skills and abilities. Team Cognition is supported by many factors related to 
Team Composition and Interpersonal Relationships, the team Training together, 
engaging in Team Skills and Social Support, Countermeasures (e.g., debriefs), and 
Individual Readiness and Factors (i.e., individual cognition). Ground Support is an 
important part of Team Cognition across the multi-team system.  

─ Team Skills consist of information sharing, backup behaviors, leadership/followership, team 
care, and providing social support, among others. Team Skills are developed through training 
and supported by Countermeasures such debriefs and psychological support tools and 
experts. Team Skills support Individual Readiness to function on a team, offer social 
support, create and maintain shared Team Cognition. 

─ Team Cohesion is tendency for a group to operate in a unified fashion while working towards 
a goal or to satisfy the emotional needs of its members. It is affected by Interpersonal 
Relationships that develop through shared values and complementary personalities (Team 
Composition) and Social Support during shared experiences.  

• Crew Capability is the readiness of the entire crew to perform required tasks including the 
functional capacity as well as knowledge, skills and abilities, at both an individual and team level. 
Inadequate Task Performance during critical team tasks (e.g., EVAs for repairs or surface ops) 
can lead to Loss of Vehicle or Loss of Mission Objectives  or Loss of Crew Life. This is 
affected by:  

─ Team Functionality as represented above. 
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─ Crew Size effects the pool of available knowledge/skills/abilities and person-hours onboard, 
as well as Interpersonal Relationships via Team Composition. 

─ Individual Readiness is affected by several other risks, and it affects the crew capability in a 
similar fashion to crew size.  

─ Communication Delays also negatively influence the real-time Crew Capability, particularly 
in time pressure situations (e.g., emergency response), by restricting timely troubleshooting 
by and coordination with Ground Support. 

• Countermeasures and other factors influence the level of Team Cohesion, Team Skills, 
and Team Cognition. These include: 

─ Training performed before and during a mission. This includes both technical and team skills 
training /behavioral health training. Technical training is dependent on Vehicle Design and 
the design of Vehicle Systems and the Crew Health and Performance System and can 
affect the Individual Readiness and shared understanding (Team Cognition) of these 
vehicle systems. Team Training affects each Individual’s Readiness to work and live as a 
team, affect Interpersonal Relationships as they train together, and affect shared 
understanding (Team Cognition) of team norms.  

─ Astronaut Selection creates a pool of well-qualified, highly skilled, team-oriented 
individuals (Individual Factors). A physically and psychological fit individual (Acoustics, 
Medical, Sleep, CO2, Food and Nutrition (Risks), Behavioral (Risk)), combined with Team 
Skills enhanced through Team Training, results in Individual Readiness.  

─ Team Composition is influenced by a given DRM’s Distance from Earth and Crew Size, 
and by the mission objectives, and the Individual’s Readiness to meet those 
objectives. Team Composition is an ongoing consideration as different tasks occur 
throughout the mission, and it does not end when the crew is assigned.  
o The risk introduced by Private Astronaut Missions and space tourists is an unknown 

and may severely disruptive the entire system. Private Astronaut Missions (PAMs) will not 
have the same level of strategic Selection, Composition, Training, or Countermeasure 
support as the professional astronauts and will affect Team Composition. 

─ The HSIA (Risk) influences Vehicle Design and systems (Crew Health and Performance 
System, Environmental Control), affecting the Net Habitable Volume and the availability 
of Privacy/Team Space. Both Privacy and shared Team Space (e.g., a dining/worktable) 
influences Interpersonal Relationships.  

─ Interpersonal Relationships are affected by the mix of individuals on the mission (Team 
Composition, Behavioral Risk), the Team Training experienced together the Team Skills 
they use to support the relationships. Interpersonal Relationships particularly during longer 
Effective Mission Durations are a strong predictor of Team Cohesion, and how the team 
provides work and non-work supportive behaviors to coordinate and cooperate (Social 
Support, Team Cognition.  

─ Communication Delays restrict the degree of Social Support provided by Family 
Effects, Ground Support, and psychological support (BHP Countermeasures) from experts 
on Earth. Team Monitoring allows experts, team members, or autonomous systems to 
prompt the team to engage in team-supportive countermeasures (e.g., debriefs), but these 
may be restricted due to Communication Delays.   
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Risk of Toxic Exposure (Toxic Exposure Risk) 
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Toxic Exposure Risk DAG Narrative 

• Numerous sources of toxic materials onboard spacecraft are impacted by the Hazards: 

─ Altered Gravity results in increased exposure risk to floating particles and liquids, reduced 
dispersion of gases in areas that aren’t well ventilated, and greater difficulty in capturing and 
cleaning a release. 

─ A Hostile Closed Environment limits removal capabilities and increases exposure likelihood 
(small volume for gases and volatiles to fill). 

• Toxic Exposure is dependent on the release of toxic substances into the interior of the spacecraft 
or spacesuit that can affect the health and performance of the astronauts. This can be caused by: 

─ Crew Metabolism includes the CO2 (Risk) exhaled by the crew which in some cases can 
reach toxic levels. Biovariability is determined by Individual Factors.  

─ Waste Management System includes the above as well as chemicals used for 
neutralizing/cleaning and waste from bodily functions. 

─ Combustion/Smoldering Events have happened in prior spaceflight and can result in 
release of Carbon Monoxide, weak acids, and other toxic substances. This is in part 
dependent on the Electric Shock (Risk). 

─ Thermal Degradation is the result of heated materials such as plastics that are 
not combusting but are releasing toxic vapors into the local atmosphere. 

─ Payload Chemicals refers to chemicals that may be brough on-board by a visiting spacecraft 
or payload that is not always present in the vehicle systems.  

─ Materials Off-Gassing occurs for plastics, rubbers, and other substances that are 
not thermally dependent.  

─ External Contaminants such as lunar or Martian Dust (Risk) may be brought into the 
vehicle or habitat. 

• All of these except Crew Metabolism are dependent on Vehicle Design and the HSIA (Risk). 

• If a Toxic Exposure occurs, there are several pathways to affect Individual Readiness and Crew 
Capability including: 

─ Some toxins have cardiovascular toxicities – Cardiovascular (Risk) - that can lead to 
dysrhythmias and myocardial tissue damage.  

─ Some toxins are Ototoxins and can affect the Acoustics (Risk).  
─ Several toxins can cause Environmental Injuries such as CO poisoning or Ammonia 

inhalation that can occur from coolant release and other Medical (Risk) issues that can lead 
to consequences such as Evacuation, Loss of Crew Life or Long Term Health Outcomes.  

─ These can also lead to Behavioral (Risk) issues including altered mental status, effects 
on Cognitive Function, and Psychological Status that can affect the Team (Risk). 

• If a Toxic Exposure occurs, then the ability of the crew to mitigate the problem depends on what 
has been designed into the Vehicle Design and the Crew Health and Performance System, 
and ECLS System.  

• Toxic Substance Monitoring enables Detect Toxic Exposure which can drive countermeasure use 
such as using Atmospheric Scrubbers or donning Protective Equipment. Protective Equipment is 
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part of the Medical Prevention Capabilities designed into the Crew Health and Performance 
System. 

• Physiologic Monitoring Capability can include physical and laboratory biomarkers that can 
identify the physiologic response of an affected astronaut and help Detect Diagnosis to tailor 
medical care which is part of the Medical (Risk).  

• Effectiveness of medical interventions is in part dependent on the Pharm (Risk) for 
Pharmaceutical Effectiveness. 

• Historically the detection of system issues that can lead to Release of Toxic Substances has in 
large part depended on Ground Support from Mission Control. This is available in LEO, 
but Communication Factors must be considered in DRMs that have more Distance from Earth. 
Increased autonomy needs for crews may drive an increased monitoring capability to reduce the 
risk of toxic exposures.  

• Some toxic exposures can lead to Long Term Health Outcomes such as cardiovascular, 
pulmonary, renal, and other medical conditions. Surveillance such as occupational health 
surveillance post-flight and post career is critical to Detect Long Term Health Outcomes and 
better characterize the magnitude of the Long Term Health risks.  
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Risk of Urinary Retention (Urinary Retention Risk) 
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Urinary Retention Risk DAG Narrative 

• The central focus of the Urinary Retention DAG begins with the Urinary Retention node which is 
the point at which the retention of urine in an astronaut reaches a clinically significant level. 
Inflammation can result from the hazards of Radiation, Hostile Closed Environment, and 
Isolation and Confinement. Prior to that, astronauts may retain urine that they are not aware of 
and this is called Post-Void Residual. Retention may be intentional in some situations. When 
retained urine begins to affect Urine Flow, this can lead to several Medical Illnesses that can 
affect Individual Readiness and Crew Capability including: 

─ Infectious processes like Urinary Tract Infections, Pyelonephritis (kidney infection) and 
potentially Sepsis if untreated, can result from Urinary Retention.  

─ Renal Colic, Retention Pain, and Hydronephrosis can result from Urinary Retention or Urine 
Flow disruption.  

• All of these, if untreated, can potentially lead to Renal Failure which has implications 
for Evacuation, Loss of Crew Life and Long Term Health Outcomes.  

• Retention of urine can be cause by Mechanical Obstruction at the level of the urinary bladder 
or prostate (in men). Retention may also be intentional in some situations (e.g. not wanting to use 
MAG). Retention is affected by Individual Factors like age, sex, and genetic predispositions and 
can be caused by: 

─ Urinary Muscle Changes that occur in Altered Gravity environments or due to Side Effects 
of certain medication classes including Sympathomimetics and Anticholinergics used 
for EVA (Risk) mitigation, Sensorimotor (Risk) mitigation, Space Motion Sickness, 
and congestion. 

─ Inflammation in the bladder or prostate 

• Countermeasures must be designed into the mass and volume allocations for the Vehicle Design 
and Crew Health and Performance System to effect risk mitigation. These are affected by the 
HSIA (Risk) and include: 

─ Ultrasound Monitoring is used to Detect Post-Void Residual when increased, and 
if severe can inform the use of countermeasures such as a Void Trial.  

─ Medical Prevention Capability such as Tamsulosin can help to relax Urinary Muscle Changes. 
─ Medical Treatment Capability such as Catheterization may be needed to 

relieve Urinary Retention and prevent the development of other Medical Illnesses. Other 
medical treatments may be needed if Medical Illness progresses (i.e. UTI -> Pyelonephritis 
-> Sepsis). 

• Effectiveness of the Medical Prevention Capability and the Medical Treatment Capability is 
dependent on the Pharm (Risk). 

• Long Term Health Outcomes may occur and Surveillance is needed post-flight and post-mission 
to help Detect Long Term Health Outcomes and characterize the magnitude of the Long 
Term Health risk contribution.  
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Concern of Venous Thromboembolism (VTE Concern) 
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VTE Concern DAG Narrative 

• Venous Thromboembolism development centers around Virchow’s Triad which leads 
to thrombosis. 

• Blood Stagnation – the flow of blood is altered in spaceflight. 

• Blood Coagulability - changes in the coagulation factors of blood during spaceflight. 

• Endothelial Damage – damage to wall of blood vessels that exposes underlying tissue. 

• Astronaut Selection affects and limits the Individual Factors present in the 
crewmembers. Individual Factors such as genetics, age, sex, smoking habits, etc. Can 
all affect likelihood of changes in Virchow's Triad. 

• Specific possible causal paths include: 

─ Fluid Shifts that occur in spaceflight can lead to distension and alteration 
of Vascular Structure/Function which in turn can cause Blood Stagnation leading 
to Venous Thrombosis. 

─ Hematologic Index Alterations such as changing hematocrit in response to 
hypoxia and atmospheric conditions can lead to Blood Viscosity changes which 
affect Coagulability and the likelihood of Venous Thrombosis. 

─ Oxidative Stress and/or Psychological Stress can lead to Inflammation which can 
lead to Endothelial Damage by altering of Vascular Structure/Function. 

• Medical conditions of concern include DVT, Pulmonary Embolism or Sinus 
Thrombus, all of which can lead to changes in Individual Readiness and Crew 
Capability affecting Task Performance, likelihood of Evacuation for medical reasons 
and in severe cases can contribute to Loss of Crew Life.  

• Countermeasures against VTE must be included in the Crew Health and Performance 
System and accommodated in Vehicle Design.  

• Medical Prevention Capability including the use of Oral Contraceptives, which are 
used to mitigate abnormal uterine bleeding during flight but can also increase 
the risk thrombosis. 

─ Medical Treatment Capability includes Anticoagulants and other medications and 
supportive care. 

─ The effectiveness of medications are modified by the Pharm (Risk) as medications 
used are subject to stability and PK/PD issues. 

─ Medical Monitoring Capability, such as ultrasound, is needed to detect a thrombus
. 

Long Term Health Outcomes that may occur as a result of VTE must be included 
in Surveillance post flight and post-career in order to effectively Detect Long Term 
Health Outcomes and characterize the magnitude of this risk in the Long Term Health domain.   
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Appendix A - DAGtionary 
 

To avoid the paradigm, where different teams of experts use different terminology to 
refer to the same concept, a dictionary of common terms, the DAGtionary, was 
developed. The DAGtionary enforces common terminology for node names across the 
Human System Risk Board direct acyclic graphs (DAGs). These nodes provide points of 
connection between the DAGs. The DAGtionary was approved by the HSRB and will be 
configuration managed along with the DAGs themselves.   

When definitions already existed in NASA STD 3001 this document attempted to 
utilize those terms. However, discrepancies may exist and in those cases each 
document’s definitions are exclusive to each respective document. 
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Nodes Definitions  Additional Notes 
Absorption One of the four pharmacokinetic parameters that 

describe how a drug is dissociating from its dosage 
form, dissolving in body fluids, and diffusing across 
biological membranes. 

 

Acoustics (Risk) 
Risk of Hearing Loss and Performance Decrements Due 
to Acoustics Issues in Space; also referred to as the 
Hearing Loss Risk. 

Risk Statement: Given changes in environmental (e.g., noise) 
and physiological conditions in space flight, there is the 
possibility that the auditory system will experience temporary 
or permanent reductions in hearing sensitivity or that crew 
performance will be impacted 

Aerobic Fitness The ability to perform dynamic exercise that involves 
large muscle groups at a moderate to high intensity for 
prolonged periods.  

V�O2max is the gold standard measurement index of aerobic 
capacity. 

Aerobic (Risk) Risk of Reduced Physical Performance Capabilities Due 
to Reduced Aerobic Capacity. 

Risk Statement: Given that exposure to a microgravity 
environment causes cardiovascular fitness (maximal aerobic 
capacity) to decline, there is a possibility that mission task 
performance would be impaired, or tasks could not be 
performed. 

Air Contamination Harmful or poisonous substances affecting air quality 
within the vehicle or habitat in-mission.  

 

Airlock Design An airtight room with two entrances that provides an 
isolated volume for transfer between a pressurized 
vehicle and the vacuum of space.  

 

Altered Gravity Gravity environment that is less than Earth-normal (1g)  

Human System Risk Hazard - Exposure to a gravity environment 
that is less than Earth-normal begins a process of adaptation; 
some of these adaptations create issues for human bodies that 
developed to function in a 0g (gravity) environment. 

Ambient CO2 Level Concentration of carbon dioxide (CO2) in occupied 
spaces with air exchange; the distributed cabin CO2 
level. 

The regulatory definition of ambient air is - that portion of the 
atmosphere, external to buildings, to which the general public 
has access.   

Anomalous Events Occurrences that are inconsistent with or deviating 
from what is usual, normal, or expected. 

 

Anthropometry The science of measuring the human body and its parts 
and functional capabilities. Includes lengths, 
circumferences, body mass, etc. (NASA-STD-3001) 

Anthropometry is used to understand human physical variation 
and to recommend appropriate accommodations for 
vehicle/crew interfaces. An individual’s anthropometry may 
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Nodes Definitions  Additional Notes 
predispose them to certain injuries. 

Anticholinergics Competitive antagonists of the neurotransmitter 
acetylcholine at central and peripheral receptor sites 
within the cholinergic system.  

Anticholinergics can cause physiologic effects on circulation, 
respiration, alertness, urination, and vision; they are used to 
treat many conditions (e.g., cholinergic toxicity, urinary 
incontinence, respiratory disorders, cardiovascular disease, and 
alertness disorders). 

Anticoagulants A group of chemical substances, including drugs known 
as blood thinners that increase the time it takes for 
blood to clot. 

Anticoagulants are used to treat blood clots, or in conditions 
where the risk of blood clots is increased (e.g., stroke or heart 
attacks). 

Antimicrobial Resistance The ability of a microorganism (bacteria, virus, fungi, 
parasite) to resist the effects of antimicrobial drug 
treatment.  

Antimicrobial Resistance occurs when bacteria, viruses, fungi, 
and parasites change over time and no longer respond to 
medicines making infections harder to treat and increasing the 
risk of disease spread, severe illness and death. 

Arc Flash/Sparking Arc flash is a type of electrical explosion or discharge 
that results from a connection through air to ground or 
another voltage phase in an electrical system.  
·        Arc - a high temperature luminous electrical 
discharge across a gap 
·        Spark - a small incandescent particle created by 
some arcs 

Injuries from arc flash/sparking can include external burns (i.e., 
severe burns to the skin), internal burns and intoxication from 
inhaling hot gasses and vaporized metal, hearing damage, eye 
damage and blindness from the ultraviolet light of the flash as 
well as many other devastating injuries. 

Arterial Gas Embolism A blockage of blood supply caused by air bubbles in a 
blood vessel or the heart.  

Causes of an arterial gas embolism may include trauma, surgery, 
and decompression sickness. Symptoms can include breathing 
difficulty, chest pain, and confusion. Treatments include 
hospital care, oxygen, removing air from the heart, and a high-
pressure chamber. 

Artificial Gravity The creation of an inertial force that mimics the effects 
of a gravitational force, usually by rotation. 

 

Aspiration Inhalation of material not usually in the respiratory 
system. 

Aspiration of vomitus, blood, or mucus may occur when a 
person is unconscious. 

Astronaut An individual selected and trained to travel into space 
and to monitor, operate, and control parts of, or the 
whole space system to complete mission objectives. 

An astronaut may or may not be assigned to a mission. 

Astronaut Selection The narrowing down of the pool of individual applicants 
to the most suitable for spaceflight.  

Astronaut selection involves assessing qualifications and 
experiences, physical and medical condition/history, as well as 
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psychiatric health and job-relevant psychological competencies 
(e.g., decision-making skills, leadership skills, interpersonal 
skills) using multiple methods such as interviews, psychological 
tests, and individual and team-based behavioral evaluations, to 
finalize selection of applicants that will be employed by NASA as 
astronaut candidates. Not to be confused with Crew Assignment 
which is the narrowing down of the pool of trained Astronauts 
for specific missions. 

Atmospheric Conditions The composition of the invisible gaseous substances 
within the vehicle/habitat (e.g., nitrogen, oxygen, 
argon, carbon dioxide) as well as the pressure, 
temperature, humidity, etc. 

 

Atmospheric Dust Level The quantity of particulate matter in the air.  
Atmospheric Mixing The process of maintaining the correct balance of 

oxygen, nitrogen, water vapor, and carbon dioxide 
(CO2) in an enclosed environment.  

 

Atmospheric Scrubbers Life support equipment that removes metabolic, off-
gassing, and other contaminants from breathable air. 

 

Autonomous Systems The combination of elements that function together to 
produce the capability to meet a need that under 
specified conditions, functions without intervention by 
the crew.  

The elements of autonomous systems include all hardware, 
software, equipment, facilities, personnel, processes, and 
procedures needed for this purpose. 

Balance Training Training designed to improve upright balance by 
strengthening postural muscles and/or improving the 
use of visual/vestibular/somatosensory information for 
appropriate postural adjustments. 

 

Barotrauma Injuries caused by changes in pressure.  Barotrauma injuries can occur during airplane flights or scuba 
diving; barotrauma of the ear is common; barotrauma of the 
lung may be fatal. 

Behavioral (Risk) Risk of Adverse Cognitive or Behavioral Conditions and 
Psychiatric Disorders. 

Risk Statement: Given that crews of future exploration missions 
will be exposed to extended durations of isolation and 
confinement, greater distances from Earth, as well as increased 
exposures to radiation and altered gravity, there is a possibility 
that these singular or combined hazards could lead to (a) 
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adverse cognitive or behavioral conditions affecting crew health 
and performance during the mission; (b) development of 
psychiatric disorders if adverse behavioral health conditions are 
undetected or inadequately mitigated; and (c) long term health 
consequences, including late-emerging cognitive and behavioral 
changes. 

BHP Countermeasures Behavioral health and performance (BHP) actions, 
procedures, equipment, standards, or requirements. 

These countermeasures prevent or mitigate decrements to 
astronaut behavioral or cognitive health and performance. 

BHP Family Services Behavioral health and performance (BHP) support 
including counseling for astronauts and their families; 
launch and landing support; and in-mission 
psychological support.  

Examples include regular care packages and private family 
conferences between astronauts and their families to facilitate 
real-time one-on-one communication before, during, and after a 
long-duration missions. 

BHP Intervention Capability Behavioral health and performance (BHP) 
countermeasures used in mission.  

Examples include private psychological conferences and 
pharmaceutical treatment. 

BHP Monitoring Capability Behavioral health and performance (BHP) ability to 
watch, observe, and track astronaut behavioral health, 
cognitive and emotional performance to implement 
interventions as needed. 

 

BHP Prevention Capability Behavioral health and performance (BHP) support to 
prevent decline of astronaut behavioral health and 
cognitive performance; used in all mission phases. 

 

Biologic Response Reaction of an organism to a change in its environment.  
Biomedical Exposures Pre-flight research and medical tests utilizing ionizing 

radiation. 
Exposures can include medical imaging such as CT scans, X-Rays, 
etc. 
 

Bisphosphonates A group of medicines that slows down or prevent bone 
loss, preserving bone strength. 

 

Blood Stagnation A decrease in blood flow velocity or net movement of 
blood through a vessel.  

Blood stagnation usually results from changes in pressure or 
obstruction to flow. 

Blood Viscosity A measure of the resistance to blood flow. The viscosity is measured by the internal friction modified by 
the relative amounts of its constituents. 

Body Posture The position the body or body segments such as 
extremities relative to each other and to accelerations 
or forces experienced within a vehicle or suit. 
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Bone Density Mineral content within a projected image of bone 

(area) or a spatial volume of bone. 
 

Bone Formation Process by which osteoblasts produce new mineralized 
bone tissue. 

 

Bone Fracture Partial or complete break in a bone.  

Bone Fracture (Risk) Risk of Bone Fracture due to Space flight-induced 
Changes to Bone.  

Risk Statement: Given the skeletal changes that occur during 
space flight, there is a possibility that the bones of 
crewmembers during and after space flight are not as strong as 
they were before space flight and a fracture may occur 
postflight for activities otherwise unlikely to induce fracture 
prior to space flight. 

Bone Remodeling Highly regulated process by which old or damaged 
bone tissue is removed and replaced with new bone 
material.  

Alterations to the bone remodeling process during space flight 
may weaken bones or impair fracture healing. 

Bone Resorption Process by which osteoclasts break down the tissue in 
bones and release calcium from bone tissue to the 
blood. 

 

Bone Structure Spatial distribution of bone tissue (minerals and 
collagen matrix) in a 3D volume of whole bone. 

 

Brain Structural Changes Anatomical alterations to the brain. Changes due to spaceflight are usually considered to be upward 
shift of the brain within the calvarium, increased ventricle size, 
etc. 

Breathing Masks Emergency equipment providing protection from 
hypoxia through exclusion of harmful dusts, fumes, 
vapors or gases and provision of oxygen or clean air. 

 

Burn Treatment Capability Medical management and care of a burn. One example is the ability to provide relief of symptoms and 
prevent infection. 

Burns Tissue injury resulting from excessive exposure to 
thermal, chemical, electrical, or radioactive agents. 

 

Cabin Visibility Ability to see within the habitable volume.  
Cancer A large group of almost 100 diseases. Its two main 

characteristics are uncontrolled growth of the cells in 
the human body and the potential ability of these cells 
to migrate from the original site and spread to distant 
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sites. 

Cancer Model A health-effects model intended to provide estimates 
of cancer risk and uncertainties for defined space 
radiation exposure scenarios. 

 

Cancer Treatment Use of surgery, radiation therapy, medications, and/or 
other therapies to cure a cancer, shrink a tumor, or 
reduce tumor burden. 

 

Capability Having attributes (such as physical or cognitive) 
required for performance. (NASA-STD-3001) 

 

Cardiac Structure/Function The anatomy and physiology of the heart and coronary 
vessels. 

 

Cardiovascular (Risk) Risk of Cardiovascular Adaptations Contributing to 
Adverse Mission Performance and Health Outcomes. 

Risk Statement: Given that exposure to the space flight 
environment can contribute to cardiovascular deconditioning, 
dysfunction, and remodeling, there is a possibility that crews 
will experience impaired performance and negative 
cardiovascular health outcomes during and after space flight 
and planetary operations. 

Cartilage Defect A focal area of damaged cartilage at an articular surface 
(the surface where bones meet). 

 

Catheterization Introduction of a catheter, a tubular, flexible 
instrument, passed into the body for withdrawal of 
fluids from (or introduction of fluids into) a blood vessel 
a body cavity.   

Examples include insertion of a catheter into the urethra to 
drain the urinary bladder or percutaneous tubes that can drain 
areas in the abdomen. 

Central Nervous System 
Changes 

Alterations in Central Nervous System function that 
may be temporary or persistent. 

CNS changes may be a result of a singular or synergistic 
combination of space flight hazards, such as alterations to brain 
or cerebral spinal fluid volume or distribution, cerebral blood 
flow, cellular function, etc. 

Charged Particles An atomic particle that has an electric charge, either 
positive or negative.  

Examples of charged particles include protons, electrons, and 
ions. 

Charged Surface Surface with non-zero electric charge which exhibits 
electrostatic attraction or repulsion in the presence of 
other matter with charge. 

 

Chondrocyte Metabolism Chondrocyte metabolism is normally oxidative 
phosphorylation. If the microenvironment around the 

Chondrocyte metabolism is thought to be part of the process 
responsible for osteoarthritis (OA) and a potential target of 
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cartilage changes (usually inflammatory changes), then 
it results in a shift in the chondrocyte metabolism to 
glycolysis.  

pharmacologic countermeasures for OA. 

Chorioretinal Folds Undulations of the choroid, Bruch’s membrane (BM), 
retinal pigment epithelium (RPE), and the overlying 
retina. Can be subdivided into choroidal folds, retinal 
folds, and peripapillary wrinkles. 

 

Circadian Misalignment Desynchronization between the timing of the master 
circadian pacemaker in the suprachiasmatic nucleus 
(SCN) of the hypothalamus and sleep wake timing or 
desynchronization between the SCN and peripheral 
oscillators, such as those in the gut, liver, and 
reproductive organs.  

Circadian rhythm is synchronized to the environmental sleep-
wake schedule via light exposure and can adapt to different 
sleep-wake schedules (e.g., jet lag) with sufficient light exposure 
and as long as such schedules are within the range of 
entrainment (~23.5-25 h). Timing, intensity, wavelength, 
duration, and pattern of light exposure determine how quickly 
the circadian rhythm will shift to a new schedule.  
Misalignment can be caused by inappropriately timed or 
insufficiently comprised lighting and large schedule shifts. Can 
cause sleep deficiency and associated exacerbation of cognitive 
impairment. 

Cleaning Physical removal of dust, microbes, marks, or other 
impurities, from the habitat/suit by washing, wiping, or 
disinfecting. 

 

Clinically Significant Immune 
Dysregulation 

Refers to altered immune cellular function, 
inflammation, etc., reached a level which creates 
demonstrable / measurable / prognostic indication for 
impending disease.    

 

CO2 Physiologic Changes Measurable variances in cellular, tissue, organ, or body 
function that are caused by CO2 concentrations. 

CO2 Physiologic Changes refers to specific changes caused by 
CO2 and does not delineate specific biomarkers at this level. 
These changes may be cumulative with physiologic changes in 
other risks due to other causes. 

CO2 Production Generation and release of CO2.  CO2 production can be caused by humans or other spacecraft 
sources (SPHERES, etc.). 

CO2 Removal Elimination of CO2. CO2 removal is primarily via environmental control and life 
support systems in the context of spacecraft. 

CO2 (Risk) Risk of Nominal Acute and Chronic Ambient Carbon Risk Statement: Given that average cabin CO2 levels in 
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Dioxide Exposure in Crewed Vehicles.  spacecraft are maintained above ambient terrestrial levels with 

routine occurrence of short-term spikes and that the correlation 
between the cabin average and actual crew exposures remains 
unknown, there is a possibility that short-term and long-term 
CO2 exposures will adversely impact crew health and 
performance. 

Coagulability A measure of the capability to form a blood clot, 
modified by specific factors and biochemical pathways. 

 

Cochlear Changes Permanent or temporary alterations to the structure or 
function of the inner ear (cochlea), usually for the 
worse.   

Cochlear changes may be gradual or sudden and affected by 
internal (disease, genetics, etc.) or external (noise, ototoxins, 
pressure changes, etc.) factors. 

Cognitive Function Any mental process that involves symbolic operations. 
Cognitive function encompasses awareness and 
capacity for judgment.  

Cognitive function includes the mental processes of perception, 
learning, memory, comprehension, judgment, and reasoning. 
(NASA-STD-3001) 

Combustion/Smoldering Events Burning gasses or vapors that are undergoing 
combustion. 

The events lead to production of byproducts including carbon 
monoxide, carbon dioxide, nitrogen oxides, particulate matter 
(smoke), and volatiles specific to combusted materials. 

Communication Factors Circumstances that effect the communication systems 
which include information provided to and from the 
crew by way of voice, text, video, and/or telemetry 
(NASA-STD-3001); this includes constraints on 
communication between a crew and ground support 
personnel.  

Examples of communication factors are bandwidth, 
stability/consistency of link, and delay due to distance from 
Earth.  

Communications Delay Time delay between when a communication is sent to 
when the communication is received.  

 

Compartment Isolation Use of a small room/airlock to modify the environment 
in preparation for upcoming tasks.  

An example of compartment isolation is isolating the airlock and 
dropping the pressure to avoid impacts on resources for the 
whole stack plus the impact on science to depress the entire 
cabin. 

Connective Tissue Changes Changes to the tissue (bone, cartilage, fat, blood, or 
lymphatic) that supports, protects, and gives structure 
to other tissues and organs in the body. 

Changes during a mission may predispose a crewmember to 
MSK injury. 

Crew Two or more astronauts assigned to a mission that have 
been trained to monitor, operate, and control parts of, 
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or the whole space system. (NASA-STD-3001) 

Crew Assignment The selection of individual astronaut crewmembers to a 
specific mission. 

 

Crew Capability Represents the ability/readiness of the entire crew to 
perform a task.  Includes functional capacity and 
knowledge, skills, and abilities. 

 

Crew Composition See Team Composition.  

Crew Egress (Risk) Risk to Vehicle Crew Egress Capability as Applied to 
Earth and Extraterrestrial Landings.  

Risk Statement: Given that there are new spacecraft that will 
transport crews to the Moon and Mars surface and return them 
to Earth, that these spacecraft have diverse landing modalities 
and will function in different landing environments, and that the 
crew may be deconditioned on landing, there is a possibility 
that astronauts will not be able to independently egress the 
vehicles, may not be able to perform post-landing tasks in a 
timely manner, and may be unable to perform surface EVAs 
post-landing, including those required for emergencies. 

Crew Health and Performance 
System 

Vehicle system that provides health and performance 
support to crew. 

 

Crew Metabolism Total amount of the biochemical reactions involved in 
maintaining the living condition of the cells of the crew. 

 

Crew Size The total number of astronauts on a mission team that 
have been trained to monitor, operate, and control 
parts of, or the whole space system in the 
vehicle/habitat. 

 

Crew Vehicle Integration What vehicle and systems are fielded, how complex 
and maintainable they are, and how information on 
system state is provided back to crew and ground 
support. 

 

Data Accessibility The degree to which crew can access and meaningfully 
use data gathered by spacecraft systems and medical 
systems. 

 

Data Architecture The models, policies, rules, and standards that govern 
which data is collected and how it is stored, arranged, 
integrated, and used in data systems. 
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DCS (Risk) Risk of Decompression Sickness (DCS).  
Risk Statement: Given that tissue inert gas partial pressure is 
often greater than ambient pressure during phases of a mission 
(primarily EVA), there is a possibility of decompression sickness. 

DCS Type I Decompression Sickness Type I - A sickness induced by 
too rapid a decrease in atmospheric pressure sufficient 
to cause bubbles to form from gases (normally nitrogen 
[N2]) dissolved in blood and other body tissues. (NASA-
STD-3001) 

DCS Type I tends to be mild and affects primarily the joints, skin, 
and lymphatic vessels. 

DCS Type II Decompression Sickness Type II - A sickness induced by 
too rapid a decrease in atmospheric pressure sufficient 
to cause bubbles to form from gases (normally nitrogen 
[N2]) dissolved in blood and other body tissues. (NASA-
STD-3001) 

DCS Type II may be life-threatening, often affects vital organ 
systems, including the brain and spinal cord, the respiratory 
system, and the circulatory system. 

Denitrogenation Reduction of nitrogen from blood and body tissues by 
breathing gases devoid of nitrogen.  

In aerospace medicine, the removal of nitrogen from the body 
of a person preparing to fly in an environment in which the 
barometric pressure will be much lower than at sea level. 

Depressurization Reducing the pressure of air or gas within a suit, 
chamber, or vehicle. 

 

Detect Atmospheric Changes Ability to identify, measure and report the presence or 
existence of changes in features of the envelope of 
gases including pressure, temperature, and humidity in 
the vehicle/habitat/suit.  

Once detection of a change occurs, then treatment/intervention 
can be brought to bear. 

Detect Atmospheric Dust Ability to identify, measure and report airborne dust 
within the habitat to assess concentration. 

 

Detect BHP Changes Ability to identify, measure and report changes in the 
behavioral and cognitive state of astronauts in the 
vehicle/habitat/suit. 

 

Detect Bone Density Changes Ability to identify, measure and report changes in bone 
mineral distribution in a 2D image (g/cm2) or 3D 
volume (g/cm3) of bone tissue over time. 

 

Detect Bone Structure Changes Ability to identify, measure and report changes (beyond 
measurement error) in 3D distribution of bone tissue 
over time with serial measurements of whole, cortical, 
and trabecular bones. 
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Detect Brain Structural 
Changes 

Ability to identify, measure and report brain structural 
changes.  

Detection is usually accomplished with Magnetic Resonance 
Imaging. 

Detect CO2 Level Ability to identify, measure and report the presence 
and amount of carbon dioxide. 

 

Detect Contamination Ability to identify, measure and report harmful, 
unwholesome, or undesirable, substances in the air, 
water, food, pharmaceuticals, or surfaces. 

 

Detect CV Events Ability to identify, measure and report cardiovascular 
(CV) events in-mission.  

Cardiovascular events include ischemia, myocardial infarction, 
dysrhythmia, venous thromboembolism, etc. 

Detect DCS Ability to identify, measure and report if there is 
supersaturation of inert gas in the bloodstream and 
tissues. 

Decompression Sickness (DCS) is a sickness induced by too rapid 
a decrease in atmospheric pressure sufficient to cause bubbles 
to form from gases (normally nitrogen [N2]) dissolved in blood 
and other body tissues. (NASA-STD-3001) 

Detect Diagnosis Ability to correctly detect and identify the cause of any 
medical issues during a space flight mission. 

Correct diagnosis enables appropriate treatment of medical 
conditions that occur in-mission. Misdiagnosis can cause 
additional harm and waste of resources when attempting to 
treat. 

Detect Dysrhythmia Ability to identify, measure and report any abnormal 
heart rhythm. 

 

Detect Environmental 
Conditions 

Ability to identify, measure and report the state of the 
surroundings  

Environmental conditions can include air, water, contamination, 
acceleration, acoustics, vibration, radiation, temperature, 
atmosphere, pressure, humidity, ppO2, and ppCO2. 

Detect EVA Readiness Ability to identify, measure and report the 
preparedness of equipment and crew to conduct an 
extravehicular activity (EVA). 

 

Detect Events Ability to identify, measure and report a notable 
divergence from what is nominal and/or expected for 
vehicle, habitat, spacesuit or human systems. 

 

Detect Hearing Changes Ability to identify and measure changes in auditory 
performance, may use audiometric surveillance or 
crewmember report.  

Objective changes in auditory threshold are detected and 
quantified by comparing current audiometric results with a pre-
flight baseline.  Changes of a given magnitude in specific 
frequency regions are clinically significant and may require 
further action. 

Detect Immune Changes Ability to identify, measure and report the progression Subclinical Immune Dysregulation precedes Persistent 
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of Immune Dysregulation from Persistent Subclinical 
Immune Dysregulation to Clinically Significant Immune 
Dysregulation to Medical Illness.  

Subclinical Immune Dysregulation and refers to changes in 
cellular proliferation and function that does not have a known 
clinical issue. 

Detect Intracranial Pressure 
Changes 

Ability to identify, measure and report changes in 
intracranial pressure.  

Detection is usually performed via post-flight lumbar puncture. 

Detect Long Term Health 
Outcomes 

Ability to identify, measure and report if any health 
outcomes have occurred post-space flight or post-
career as a result of their occupational exposures (and 
resultant immune dysregulation) during space flight or 
training. 

 

Detect MRM/Stone Ability to identify, measure and report mineralized 
(MRM) renal material or stones in the urinary tract. 

 

Detect Noise Levels Ability to identify, measure and report ambient noise 
levels through personal dosimetry and/or static 
measurement using a sound level meter.   

Such measurements help determine if noise levels are 
hazardous or may impact crew performance or rest. Noise is 
defined as sound in the auditory range (15 Hz to 20,000 Hz) that 
is hazardous, undesired, and/or inappropriate to the intended 
use of the space. 

Detect Ocular Structural 
Changes 

Ability to identify, measure and report ocular structural 
changes.  

Detection can be accomplished using tools such as optical 
coherence tomography, ultrasound, fundoscopy, etc. 

Detect Physiologic Changes Ability to identify, measure and report the cellular, 
molecular, physiologic, pathologic, and functional 
changes that occur in individual astronauts during a 
space flight mission. 

 

Detect Post-Void Residual Ability to identify, measure and report on the amount 
of urine in the bladder following urination. 

 

Detect Pressure Changes Ability to identify, measure and report the presence of 
fluctuations in atmospheric pressure. 

 

Detect Radiation Ability to identify, measure and report the level of 
ionizing radiation. 

 

Detect Team Performance and 
Cohesion 

Ability to identify, measure and report the changes in 
crew performance and cohesion over time using 
monitoring tools. 

 

Detect Thrombosis Ability to identify, measure and report the presence of 
a clot within a blood vessel. 
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Detect Toxic Exposure Ability to identify, measure and report specific toxic 

compounds of potential concern. 
 

Detect Visual Changes Ability to identify, measure and report visual 
performance decrements.  

Detection can be accomplished using methods such as visual 
acuity (Snellen chart), visual field testing, etc. 

Diagnose Events Ability to identify the cause of an anomalous event 
thereby enabling appropriate maintenance and repair 
for vehicle, habitat, spacesuit or human systems.  

 

Diagnose Rhabdomyolysis Identification of the destruction or degeneration of 
muscle tissue and the accompanied release of 
breakdown products into the bloodstream. 

Rhabdomyolysis is usually from traumatic injury, excessive 
exertion, or stroke. 

Diagnostic Capability The sensors, data, tools, expertise, etc. that are 
available to identify any specific medical condition 
occurring in-mission  

Correct diagnosis enables appropriate treatment decisions. 
Diagnosis is dependent on all tools and expertise being 
available. 

Distance from Earth Numerical measurement of how far apart objects 
(vehicle or habitat) are from the Earth  

Human System Risk Hazard - Impacts real-time communications, 
consumables resupply, time to evacuation, and available mass 
and volume that can limit inclusion of countermeasures. 

Distribution One of four pharmacokinetic parameters that describes 
the transport process of a drug which deliver it to body 
areas away from the absorption site. 

 

Dust Monitor A device utilized to provide data on exposure levels of 
celestial dust within the habitat. 

 

Dust Removal Elimination of dust from the airborne region of the 
habitat. 

 

Dust (Risk) Risk of Adverse Health & Performance Effects of 
Celestial Dust Exposure.  

Risk Statement: Given the unique properties of lunar and other 
celestial bodies’ dust, there is a possibility that exposure could 
lead to serious health effects (e.g., respiratory, 
cardiopulmonary, ocular, or dermal harm) or to crew 
performance impacts during celestial body missions. 

Dust Source Event or trigger that introduces dust to the habitat.  
Dust Suspension The process of dust within a habitable volume rising 

into the breathing zone. 
Dust may be suspended when brought into the habitable 
volume on the suit, tools, or sampling equipment before it has 
time to settle or be removed by ECLS. It can also occur when 
settled dust in partial gravity becomes resuspended in micro 
gravity. 
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DXA Dual-energy X-ray absorptiometry (DXA), an x-ray-

based test that measures bone mineral in a 2D 
projected image of bone tissue.  

 

Dynamic Loads (Risk) Risk of Injury from Dynamic Loads.  
Risk Statement: Given the range of anticipated dynamic loads 
transferred to the crew via the vehicle, there is a possibility of 
loss of crew or crew injury during dynamic phases of flight. 

Dysrhythmia Abnormality in a physiological rhythm, especially in the 
activity of the heart. 

 

Dysrhythmia Monitor Ability to observe and keep a continuous record of an 
abnormality in a physiological rhythm, especially in the 
activity of the heart. 

 

Dysrhythmia Treatment Medical management and care of an abnormal cardiac 
rhythm with medication or procedure during a space 
flight mission. 

 

Ebullism Formation of bubbles in the bodily fluids because of an 
extreme or rapid reduction in the surrounding 
pressure. 

 

ECLS System Environmental Control and Life Support (ECLS) Systems 
designed to distribute air and remove contaminants. 
The elements include all hardware, software, 
equipment, facilities, personnel, processes, and 
procedures needed for this purpose. 

 

Effective Exposure Duration Length of time of exposure to a hazard or other node.  
Effective Gravity Level The period encompassing the exposure of crew to 

altered gravity during the design mission duration from 
launch to terrestrial landing. 

 

Effective Mission Duration The total time the crew is away from the surface of 
Earth, measured from launch of the Earth launch 
vehicle to landing or splashdown of the Earth return 
spacecraft. (NASA-STD-3001) 

 

Electric Shock (Risk) Risk to Crew Health Due to Electrical Shock.  
Risk Statement: Given that all human space flight mission 
vehicles and suits have electrical systems, there is a possibility 
of electrical shock from both direct contact and from plasma. 

Electrical Muscle Effects The response of muscle tissue to electrical current.   Muscle Effects include tetany and inadvertent contraction of the 
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muscle that can cause difficulty or errors during operations. 

Electrical Hardware Tools, machinery, and other durable equipment that 
functionally rely on electric energy to drive their core 
parts. 

 

Electrical Shock Describes when human-electrical contact occurs inside 
the spacecraft and may occur without sparking. 

 

Electrical System Design Plan or specification for electrical systems, groups of 
connected electrical components, to carry out some 
operation. 

 

Elimination Describes the process by which a pharmacologic 
substance is pulled or removed from the body.  

Elimination processes can include renal function, hepatic 
function and minor pathways. 

Endocrine Factors Locally produced or circulating levels of hormones in 
response to a stimulus or stimuli and the sensitivity or 
ability of the target tissues to respond.  

Hormones may be secreted by the endocrine system or 
introduced through exogenous sources such as medications.  
The interaction between the hormone and its receptor triggers 
a cascade of biochemical reactions in the target cell that 
eventually modify the cell’s function or activity. 

Endothelial Damage Damage or disruption to the inner lining (endothelium) 
of a blood vessel.  

Damage can contribute to dysfunction and disease. 

Energy (Calories) Quantitative property that must be transferred to a 
body or physical system to perform work on the body, 
or to heat it. The dietary Calorie (i.e. kilocalorie) is an 
energy unit used to describe the energy content of food 
and is defined as the amount of heat needed to raise 
the temperature of 1 kilogram of water by one degree 
Celsius. 

 

Environmental Conditions Nominal or off-nominal conditions within the vehicle.  Environmental conditions include air, water, contamination, 
acceleration, acoustics, vibration, radiation, temperature, 
atmosphere, pressure, humidity, ppO2, ppCO2, etc. 

Environmental Control Ability to regulate the surroundings or conditions in 
which the crew lives and operates.  

Environmental control includes accommodating increased O2 
consumption, additional output of heat, CO2, perspiration 
droplets, odor, and particulates like skin, hair, or lint from 
clothing or other materials, vibration, lighting, noise, and 
temperature. 

Environmental Injury Any non-traumatic bodily damage that is the direct  
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result of a known external exposure. 

Environmental Monitoring 
Capability 

Ability to test, log, and review the parameters that 
describe the environment in which the crew lives and 
operates to ensure they do not exceed specified limits. 

 

Environmental Risks Risks with potentially harmful factors originating from 
external conditions or surroundings.   

HSRB environmental Risks include Toxic Exposure, SANS, DCS, 
Hypoxia, CO2, Dust, Sensorimotor, Hearing Loss, Electrical Shock 
and Non-Ionizing Radiation. 

Estimated Career Dose The amount of radiation dose estimated to be received 
by an astronaut over the course of their career. 

 

Estimated Dose Rate Estimated dose of ionizing radiation absorbed or 
delivered per unit of time. 

 

Estimated Mission Radiation 
Dose 

Estimated amount of radiation dose for a particular 
design reference mission category (length of a mission, 
distance from Earth, etc.). 

 

Extravehicular Activity Operations performed by suited crew outside the 
pressurized 
environment of a flight vehicle or habitat (during space 
flight or on a destination surface). Includes contingency 
operations performed inside unpressurized vehicles or 
habitats. (NASA-STD-3001) 

 

EVA Decision Support Ability of the system (human or computer) to support 
determinations, judgments, and courses of action 
before and during an extravehicular activity to reduce 
cognitive workload. 

 

EVA Duration Length of time an extravehicular activity lasts, can be 
planned or actual. 

 

EVA Frequency Number of extravehicular activities conducted in a 
given period, and how often are they occurring 
(tempo). 

 

EVA Operations Activities performed by suited crew outside the 
pressurized environment of a flight vehicle or habitat 
(during space flight or on a destination surface). 

EVA Operations include contingency operations performed 
inside unpressurized vehicles or habitats. 

EVA (Risk) Risk of Injury and Compromised Performance Due to 
EVA Operations.  

Risk Statement: Given the high-performance physiological and 
functional demands of operating in a self-contained EVA or 
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training suit in various gravity fields and system environments, 
there is a possibility that crew injury and compromised 
physiological and functional performance may occur. 

EVA Task Timeline Planning duration and quantity of tasks to ensure 
activities to be performed during an extravehicular 
activity are feasible and appropriate  

The EVA task timeline may be affected by solar particle events. 

Evacuation Leaving the vehicle or habitat due to an injury or illness. 

Changing return times to Earth for different Design Reference 
Missions (DRMs) affects the resources required for successful 
evacuation.  In Mars DRMs, evacuation is not available due to 
orbital mechanics. 

Exercise Any bodily activity that enhances or maintains physical 
fitness and overall health and wellness.  

Exercise is used to maintain or minimize loss of crew 
cardiovascular fitness and of muscle mass and crew 
cardiovascular fitness, to maintain muscle mass and 
strength/endurance, for recovery from strenuous tasks and 
confined postures, to rehabilitate minor muscle injuries, and to 
maintain bone mass. Exercise also has behavioral health 
benefits. 

Exercise Hardware Equipment or systems designed to perform aerobic and 
resistive training stimuli needed to maintain health and 
performance that enables successful mission task 
performance. 

 

Exercise Prescription Planned, structured, repetitive, and purposeful 
activities that involve progressive modifications over 
time for frequency, intensity, time, and volume.  

 

External Contaminants Harmful or poisonous substances on the outside of a 
spacecraft that may enter the habitable volume via suit 
contamination during EVA or docking of visiting 
vehicles. 

 

Extraterrestrial Surface Celestial bodies existing or occurring outside the earth 
or its atmosphere. 

Examples of an extraterrestrial surface include moon, planetary, 
asteroid, 
etc. (NASA-STD-3001) 

Eye Injury Injury (environmental or traumatic) that occurs to the 
eyeball, eyelids, or orbital area. 

 

Fall Height Distance to the landing surface from the crewmember’s  
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workstation or operating region. 

Family Effects Perceived connectedness with family, stress associated 
with family relationships or with family situations that 
are influencing family members' well-being. 

 

Family/World Events Acute and chronic stressors of life outside of 
operational duties and events. 

Examples include family health conditions, family or marital 
discord, birth of a child, death of a loved one, and major world 
events such as natural disasters or terrorist attacks. 

Fatigue Weariness, exhaustion, or decreased attention. May 
result in decreased ability to perform mental or 
physical tasks. 

Fatigue is usually related to labor, exertion, or stress. May result 
from lack of sleep, circadian shifts, mood decrements, boredom, 
or disease.  May cause decreased ability to perform mental or 
physical tasks. (NASA-STD-3001) 

Fine Motor Control The coordination and dexterity of muscles, bones, and 
nerves required to produce precise movements. 

 

Flight Recertification 
Evaluation of a crewmember’s physical or mental 
health after a mission to assist in determination of 
ability to return to flight.  

Risk Impact Category which applies when throughout the career 
of an astronaut. 

Fluid Shifts A physiologic response to altered gravity or 
acceleration that creates a shift of bodily fluids (e.g., 
blood, cerebrospinal fluid) from one region to another. 

 

Food Acceptability A subjective measurement evaluating the hedonics 
associated with food.  

Food acceptability is influenced by factors related to the 
individual, the food, and the environment. These factors include 
sensory properties of the food (i.e., taste, smell, and texture), 
variety available, contextual implications, individual’s culture, 
food preferences, previous exposures and subsequent 
expectations, and physiological status (i.e., hunger, thirst, and 
health status). If food is not acceptable it will not be consumed 
in sufficient quantities to receive adequate energy and 
nutrients. 

Food and Nutrition (Risk) Risk of Performance Decrement and Crew Illness Due to 
Inadequate Food and Nutrition. 

Risk Statement: Given that there is a constrained space flight 
environment with a limited-source food supply and altered 
nutrient requirements, there is a possibility of inadequate 
nutritional delivery resulting in performance decrement, crew 
illness, and long-term health effects. 

Food Contamination Refers to foods that have been corrupted by a physical, Contaminated food could lead to infections. 
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biological, or chemical substance that renders the food 
unfit or unsafe for consumption.  

Food Preparation Making food ready for consumption including thawing, 
cooking, heating, cooling, cutting, assembling, and 
portioning.  

In space flight, food preparation is generally limited to the 
addition of water and heat to ready-to-eat shelf stable food to 
an acceptable temperature for consumption (not cooking). 

Food Production The process of converting raw materials into edible 
food fit for human consumption including cultivating, 
crop management, harvesting, cleaning, fermenting, 
slicing, processing, packaging, etc. 

 

Food Safety Food safety encompasses the conditions and practices 
observed to preserve the safety and quality of food to 
prevent food contamination and food-borne illness.  

Food safety includes proper and sanitary food handling, 
preparation, and storage. 

Food Storage  Food storage can be divided into three types, dry, 
refrigerated, and frozen.   

Factors which may impact food shelf life and type of food 
storage considered include humidity, pressure, atmosphere, and 
radiation. Foods stored in dry storage are those which do not 
require a climate-controlled environment (i.e., canned goods). 
Refrigerated foods are those that need to be kept cool at all 
times (i.e., meats, cheese, and eggs). The refrigerator 
temperature should be at or below 4 degrees Celsius. Freezing 
foods requires keeping them below -18 degrees Celsius. Freeze-
thaw cycles can damage food structures due to ice crystal 
growth. 

Food System The interconnected network of activities and resources 
involved in providing nutrients for human nourishment 
and sustaining life.  

A food system includes the production, aggregation, processing, 
packaging, distribution, consumption, and disposal of food. In 
space flight to date, the food system can be defined as all foods, 
beverages, vitamins, supplements, and associated packaging 
and utensils, as well as support for preparation such as water 
dispensers and food warmers. 

Food Variety Foods with diverse characteristics including foods from 
the entire range of food groups (vegetables, fruits, 
grains, meat, fish, and dairy products).  

Variety also refers to the number of different foods within each 
food group. 

Fundoscopy The act of examining the fundus of the eye.  Fundoscopy is nominally performed via a retinal camera and/or 
optical coherence tomography (OCT) device during space flight. 

Galactic Cosmic Radiation Ionizing radiation composed of highly energetic protons These particles represent the “background” radiation in space 
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and heavy charged particles that originate outside the 
solar system traveling at near relativistic speeds.  

and are the primary contributors to radiation exposure during 
spaceflight. 

Gamma Rays Also known as gamma radiation, is a penetrating form 
of electromagnetic radiation arising from the 
radioactive decay of atomic nuclei. It consists of the 
shortest wavelength electromagnetic waves, typically 
shorter than those of x-rays.  

 

Globe Flattening Structural deformation (flattening) of the posterior side 
of the eyeball, typically centered at the insertion point 
of the optic nerve into the globe.  

 

Ground Support Operations and tasks performed by ground personnel 
utilizing space flight systems, hardware, and equipment 
including during launches and after landings.  

Ground support includes mission control support as well as any 
physical, psychological, and behavioral health support. 

Hardware/System Failure An event or interaction that results in the vehicle 
system not functioning nominally or safely, with the 
potential for downstream consequences. 

 

Hearing Countermeasures A means to offset undesirable physical effects to 
hearing hazards.  

Hearing countermeasures include engineering controls or use of 
hearing protection. 

Helmet/Protective Visors Coverings, films, or filters designed into spacesuit visors 
that may provide protection from environmental 
factors.  

Visors may provide protection from sources such as sunlight, 
thermal, etc. 

Hematologic Index Alterations Changes in the absolute or relative proportions of the 
blood constituents. 

 

Hostile Closed Environment 
A sealed habitable volume and environmental system 
that does not rely on matter exchange with any part 
outside the system. 

Human System Risk Hazard - The habitable volume and 
environmental systems required to enable life and work in any 
space vehicle or habitat can expose astronauts to different 
atmospheric, water, or microbial challenges as well as 
acceleration environments that can lead to injury. 

HSI Processes Human System Integration (HSI) - An interdisciplinary 
and comprehensive management and engineering 
methodology that focuses on the integration of 
humans and cyber-physical systems during systems 
design and development or acquisition, to enable 
overall systems resilience. 
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HSIA (Risk) Risk of Adverse Outcomes Due to Inadequate Human 
Systems Integration Architecture. 

Risk Statement: Given need for increasing crew independence 
and greater operational complexity in future exploration 
missions, there is a possibility of adverse outcomes associated 
with deficiencies in Human Systems Integration, specifically that 
crew are unable to adequately respond to unanticipated critical 
malfunctions and/or perform safety critical procedures. 

Human Error Either an action that is not intended or desired by the 
person or a failure on the part of the person to perform 
a prescribed action within specified limits of accuracy, 
sequence, or time that does not produce the expected 
result and has led or has the potential to lead to an 
unwanted consequence. 

 

Human-Electrical Contact The contact between a human and anything electrical 
that can cause an electrical shock to the human. 

 

Human System Risk Hazard 

Set space flight Hazards (Altered Gravity, Distance from 
Earth, Hostile Closed Environment, Isolation and 
Confinement and Radiation) that are defined in the 
Human System Risk Management Plan. 

 

Humidity A measure of the amount of moisture in the air.  
Hydration The action of providing liquid to bodily tissues to 

compensate for fluid lost from the body. 
 

Hygiene Hygiene in space includes the everyday tasks of 
washing hair, brushing teeth, shaving, and going to the 
bathroom. It also includes washing and changing of 
clothes, as well as wiping down exercise equipment 
after use and covering up cuts and skin breaks while in 
space. 

Hygiene can be important in controlling bacteria and other 
microorganisms. 

Hypoxia Low oxygen at the tissue level; in context of the 
Hypoxia risk, denotes severe hypoxia.  

Hypoxia could potentially occur as a result of suit failure, toxic 
exposures, or depressurization from vehicle failure all of which 
could lead to loss of crew life. 

Hypoxia (Risk) Risk of Reduced Crew Health and Performance Due to 
Hypoxia. 

Risk Statement: Given that future human exploration missions 
require robust, flexible Extravehicular Activity (EVA) architecture 
protocols that include the use of a reduced pressure cabin 
atmosphere enabling staged denitrogenation, there is a 
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possibility that this atmosphere could result in compromised 
health and performance to the crewmember due to exposure to 
mild hypobaric hypoxia. 

Immune (Risk) Risk of Adverse Health Event Due To Altered Immune 
Response;  

Risk Statement: Given that exposure to orbital space flight 
results in persistent dysregulation of the immune system, which 
leads to reactivation of latent herpes-viruses and likely to an 
increased clinical incidence, including rashes and 
hypersensitivity reactions, there is a possibility 
that crewmembers will be susceptible to certain diseases during 
exploration class missions. 

Impedance Factors Factors that oppose an electrical circuits current 
impeding the flow of the charge.  

Impedance factors includes insulation of clothing and/or shoes 
as well as amount of sweat on the body. 

Incapacitation/Crew Rescue Injuries sustained by a crewmember during an 
extravehicular activity that prevent the affected 
crewmember from continuing independent operations, 
and which would require support from other suited 
crew to avert mission level outcomes. 

 

Individual Factors The influence that each crewmember will have on 
biologic variability (e.g., physical, physiological, or 
behavioral) affecting risk. This node as a category is 
broken out into two types: 
Modifiable (lifestyle choices, smoking status, exercise 
habits, etc.) 
Non-modifiable (age, sex, genetic predispositions, etc.).  

 

Individual Readiness The level to which a crewmember is prepared mentally 
and physically to perform necessary tasks. 

 

Infection Invasion and multiplication of microorganisms in body 
tissues. 

 

Inflammation The local response of living tissues to injury from any 
agent which could be microbial, immunological, 
physical, or chemical. There are two main types of 
inflammation: 
Acute - early reaction to injury or infection, short 
duration.  

Chronic inflammation can be triggered by oxidative stress, 
persistent subclinical immune dysregulation and clinically 
significant immune dysregulation which may contribute to 
medical illness, particularly chronic illness and may or may not 
be accompanied by pain and fatigue. 
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Chronic – occurs after a delay, longer duration. 

Inflight Hearing Exams Audiometric testing that evaluates the structure, 
function, and changes of the auditory system.   

Testing may include, but is not limited to, air and bone 
conduction audiometry and tympanometry. 

Ingestion Toxicity Systemic damage or injury to the body resulting from 
swallowing of a harmful substance in space flight. 

 

In-Mission Shelf Life The period from when a medication is packaged for a 
mission to the time of it's stated beyond use or 
expiration date. 

 

Insomnia Dissatisfaction with sleep quantity or quality, 
associated with one (or more) of the following 
symptoms: Difficulty initiating sleep or maintaining 
sleep, characterized by frequent awakenings or 
problems returning to sleep after awakenings. 

 

Interpersonal Relationships Emotional, psychosocial relationships between two 
individuals. 

 

Intervention Decision The selection of action(s) taken in response to an 
anomalous event to correct the causes and/or mitigate 
the consequences. 

 

Intervention Measures Decisions made or actions taken to mitigate specific 
health and performance risks. 

Interventions could include reconfiguring mass for a storm 
shelter, donning additional radiation protection, or early 
termination of EVAs in the case of a solar particle event.   

Intervention Source Control Control measures at the site of origin, such as 
debridement, drainage and/or excision, used to control 
ongoing infection. 

 

Intracochlear Pressure An increase in the static pressure of cochlear fluids.  Pressure may be increased due to whole-body fluid shifts from 
microgravity.  The increase in cochlear fluids can mimic disease 
processes and degrade hearing ability. 

Intracranial Pressure Changes Changes from an individual’s nominal baseline 
intracranial pressure.  

Intracranial pressure changes may occur as a result of altered 
gravity or accelerations. 

Intracranial Pressure 
Monitoring 

The act of measuring pressure exerted by fluids such as 
cerebrospinal fluid (CSF) inside the skull and on the 
brain tissue. 

 

Intravascular Volume Volume of blood in the vascular space (i.e., arteries, 
arterioles, capillaries, venules, and veins). 
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Isolation and Confinement Physical and mental separation from general 
population. 

Human System Risk Hazard - Increasing time in isolation 
increases the risk of psychological, physical, and mental health 
issues for crew. 

K+ Citrate Potassium citrate, a medication which modifies urine 
chemistry (making urine less acidic).  

Potassium citrate may be used to reduce the risk of renal stone 
formation. 

Lab Blood Monitoring Lab blood monitoring enables the capability to detect 
immune changes during space flight that are either 
subclinical or become clinically significant.  

When detected, these can enable further interventions or 
deployment of countermeasures including such actions as 
evaluations by the crew medical officer or 
prevention/treatment prescriptions to reduce or avoid further 
negative consequences (also, potential saliva monitoring). 

Landing Profile Duration, direction, and magnitude of acceleration that 
a crewmember experiences during landing on a 
terrestrial or extraterrestrial surface, arriving on solid 
ground or in water. 

 

Landing Site Environment The state of the surroundings where a vehicle will land. 
Includes climate and accessibility by ground support.  

For example, landing environments may include landing 
location, temperature, humidity, weather, sea state, gravity, 
etc. 

Laser Device that emits a coherent beam of light typically 
falling within the ultraviolet, visible, or infrared range 
of the electromagnetic spectrum. 

 

Lenses Optical devices that neutralize the refractive error of 
the eye, thereby focusing images onto the retina. 

The optical devices are usually glasses or contact lenses. 

Long Term Health 

Risk Impact Category indicating the lifetime impact of 
space flight on physical and mental health and 
performance of astronaut’s post flight including post-
career.  

The LTH category consists of the Health Outcomes impact 
subcategory which includes medical conditions resulting from 
career exposures to the space flight environment, and the 
Quality-of-Life impact subcategory which identifies decrements 
in the ability of a post-flight astronaut to perform daily living 
activities as a result of career exposure to the space flight 
environment. 

Long Term Health Clinical 
Decisions 

Any clinical decisions occurring post-flight or post 
career that are based on prior space flight exposure 
data and/or clinical testing data. 

 

Long Term Health Outcomes Medical conditions that impact the ability of a post-
flight astronaut to perform daily living activities as a 
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result of career exposure to the space flight 
environment. 

Long Term Health Quality 
Impacts to quality of life of a post-flight astronaut to 
perform daily living activities as a result of career 
exposure to the space flight environment. 

 

Loss of Crew Loss of (the whole) crew during the mission.  
Usually reserved for catastrophic events like Challenger, 
Columbia, Apollo 1 but can describe an entire crew being 
permanently incapacitated. 

Loss of Crew Life Loss of (a single) crewmember life during the mission.  For example - if Fred Haise had died of sepsis during Apollo 03 
and he was the only one who died. 

Loss of EVA Content Loss of one or more planned objective during 
extravehicular activities during a mission. 

 

Loss of EVA(s) Inability to conduct planned or contingency 
extravehicular activities during a mission. 

 

Loss of Mission Evacuation/abort prior to mission objectives being 
accomplished. 

Indicates anything that can lead to loss of a mission 

Loss of Mission Objectives Some mission objectives are lost, and other mission 
objectives can still be achieved.  

Single crewmember disability can lead to decreased 
functionality of that crewmember; this may impact if the rest of 
the team can accomplish other mission objectives. 

Loss of Vehicle The vehicle is rendered unusable during a mission, 
requiring evacuation of crew. 

 

Lower Body Negative Pressure A device/chamber covering the lower body that is 
sealed at the waist which through decompression 
intended to cause fluid shifts to the lower body. 

 

Lung Injury Any damage to the upper or lower airways  Potential sources of injuries include but are not limited to 
edema, inflammation, and fibrosis resulting from celestial dust 
exposure. 

Maintainability A measure of the ease and rapidity with which a system 
or equipment can be preserved against failure or 
restored to operational status.  

Maintenance includes servicing, repair, modification, 
modernization, overhaul, inspection, condition determination, 
corrosion control, and initial provisioning of support items. 
(NASA-STD-3001) 

Manufacturer Shelf Life A period that a drug manufacturer guarantees product 
quality, from date of manufacture until the labeled 
expiration date. 
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Materials Offgassing Volatile compounds that are produced and released 

into the air over time and as a function of temperature 
from soft goods like plastics. 

 

Measurable Hearing Shift A change in auditory thresholds that is greater than 
normal test re-test variability.   

A high frequency shift is present when the mean thresholds at 
2000, 3000, and 4000 Hz have changed by 10 dB or more when 
compared to the pre-flight baseline.  A low frequency shift is 
present when the mean thresholds at 250 and 500 Hz have 
changed by 10 dB or more when compared to the pre-flight 
baseline. 

Mechanical Obstruction A partial or total blockage of the bladder out flow tract 
caused by an object. 

One example of a mechanical obstruction is a tumor 
compressing the urethra. 

Mechanical Systems Sub-components including pumps, seals/gaskets, 
valves, and mechanical parts that contribute to the 
Environmental Control and Life Support Systems for 
vehicles and suits.  

These sub-components of the ECLS are designed to distribute air 
and remove contaminants (ventilation, carbon dioxide removal 
assembly (CDRA), thermal amine swing bed (TAS), etc.). 

Medical Diagnostic Capability The in-mission capability to correctly detect and 
identify the cause of medical issues in space flight.   

This capability can include training, experience, laboratory, 
imaging, and other medical diagnostic support tools. 

Medical Illness Any illness that is not specifically caused by traumatic 
injury or environmental injury.  

Examples of medical illness include dermatitis, infections, 
atypical allergies/hypersensitivities, cancer, and autoimmune 
diseases. 

Medical Monitoring Capability Capability to assess, log, and track aspects of crew 
health relevant to medical diagnosis and progression of 
disease, that is designed into the Crew Health and 
Performance System.  

Monitoring capability can include physiologic, laboratory, 
imaging, symptomatic, or other methods. 

Medical Prevention Capability Availability and efficacy of countermeasures to prevent 
undesired medical conditions in the crew during a 
mission. 

Prevention capability can include an array of countermeasures 
for preventing potential risks in space to crewmember and 
mission, including clinical/physician and family conferences, 
pharmaceutical products to 'reset' immunity, resistive exercise, 
and supplemental nutrition, as well as stress-relieving breathing 
or guided meditation exercises or behavioral training to reduce 
negative mental outcomes. 

Medical Treatment Capability The ability to address health conditions using onboard 
therapeutics, crewmembers, and ground-based 
resources.   

Treatment capability includes all of the medications, 
consumables, hardware, software, equipment, facilities, 
personnel, processes, and procedures needed to design into the 
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Crew Health and Performance System in a mission. 

Medical (Risk) 

Risk of Adverse Health Outcomes and Decrements in 
Performance Due to Medical Conditions that occur in 
Mission, as well as Long Term Health Outcomes Due to 
Mission Exposures.  

Risk Statement: Given that medical conditions will occur during 
human space flight missions, there is a possibility of adverse 
health outcomes & decrements in performance during these 
missions and for long term health. 

Medication Compatibility A medication's harmonious coexistence with its storage 
environment, administration (e.g., delivery and 
simultaneous administration with other medications) 
that promotes safe and effective use without the 
incidence of negative physiological consequences or 
chemical interactions; Specific to suit - The ability of a 
medication to be used safely in the suit without 
negatively impacting the suit environment or 
components. 

 

Medications A pharmaceutical or other substance used for medical 
diagnosis, prevention, or treatment. 

 

Metabolism How a drug is biotransformed (broken down) in the 
body [i.e., hepatic function, hepatic enzymes, other 
organs (e.g., Lungs, kidney, gastrointestinal, skin)];  

This is one of the four pharmacokinetic parameters that 
describes the conversion of the administered drug into another 
substance (either an active or inactive metabolite).   

Microbial Resistance Factors Description of the main drivers of antimicrobial 
resistance in space flight.  

Evidence that the virulence of certain microbes changes in 
response to space flight, increasing risk of infections or 
indirectly leading to infections through changes in microbiome 
status. 

Microbial Virulence Factors Evidence that the virulence of certain microbes changes 
in response to space flight environment.  

Changes may lead to an increased risk of infections especially 
during deep space missions. 

Microbiome All microbiota that live in or on our human body 
(including all tissue, fluids, and the various organs they 
can normally inhabit such as the GI tract, conjunctiva, 
moth/nose, vagina, and the skin).  

May also refer to interactions between the crew microbiome 
with other crewmembers, or the microbiome of the vehicle or 
environment. 

Microhost (Risk) Risk of Adverse Health Effects Due to Host-
Microorganism Interactions.  

Risk Statement: Given that evidence collected during space 
flight indicates alterations in microbial virulence and astronaut 
immune function, there is a possibility that infectious disease 
will have increased prevalence and/or will be more severe 
during space flight missions. 
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Mild Hypoxia Oxygen is not available in sufficient amounts at the 

tissue level.  
Mild hypoxia can lead to issues with cognitive function, acute 
mountain sickness fatigue and decreased endurance capacity. 

Mineralized Renal Material Nascent areas of renal calcification detected by 
ultrasound; five characteristics help define MRM: 
shadowing, Doppler twinkle, frequency dispersion, size, 
and anatomic location. 

 

Mission A major activity required to accomplish an Agency goal 
or to effectively pursue a scientific, technological, or 
engineering opportunity directly related to an Agency 
goal. (NASA-STD-3001) 

Mission needs are independent of any particular system or 
technological solution. 

Mission Architecture 
Complexity 

A measure of the number, diversity, and intricacy of 
mission systems and operations (e.g., surface versus 
orbital), and their interactions, both pre-mission and 
during mission operations. 

 

Mission Level Outcomes  Set outcomes defined in the HSRB Risk Management 
Plan.  

Task Performance, Evacuation, Loss of mission objectives, Loss 
of Crew Life, Loss of Crew, Loss of Mission, Flight Recertification, 
Long Term Health Outcomes, and Long-Term Health Quality. 

Mitigation Options All possible actions that could be taken in response to 
the anomalous event to reduce the risk of adverse 
outcomes. 

 

Modifiable Individual Factors Factors that influence the biologic variability among 
individual crewmembers that affect risk.   

Modifiable factors include lifestyle choices, smoking status, 
exercise habits, etc. These can be further decomposed 
depending on risk needs. 

Monitoring Capability The ability periodically or continuously observe, record, 
and systematically review the status of vehicle, habitat, 
spacesuit or human systems. 

Monitoring capability includes checking for quality or fidelity; 
testing to determine if a signal comes within limits; watching 
and observing for a specific signal or purpose; keeping track of, 
regulating, or controlling. (NASA-STD-3001) 

Morphological G-Receptor 
Changes 

Changes to the end organ, including neuronal 
sensitivity changes, otoconial mass changes, cilia 
changes, etc. 

 

Motion Sickness Vestibular disturbance leading to nausea and/or 
vomiting. 

 

Motivation Internal, subjective experience of drive, desire, or 
willingness to exert effort or resources toward a task or 
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goal. 

MRI Magnetic Resonance Imaging (MRI), a diagnostic test 
that measures the response of atomic nuclei in body 
tissue (hydrogen nuclei of water) to radio waves in a 
strong magnetic field.  

This does not expose the subject being scanned to radiation. 
The scanner is large enough for the whole body but is used to 
target specific areas of interest. 

Multi-Sensory Integration 
Alterations 

Changes to the internal weighting of the individual's 
information-gathering abilities to see, hear, touch, 
smell, and taste (sensory signals) that are integrated by 
the central nervous system to produce the perception 
of the physical environment and one’s relation to it.  

Perception includes temperature, pain, kinesthesia, and 
equilibrium. 

Muscle Performance The ability of the muscle to produce force. Muscular 
fitness is composed of the functional parameters of 
strength, endurance, and power.  

Loss of muscle performance on a mission may impair task 
completion or predispose a crewmember to musculoskeletal 
injury. 

Muscle Physiologic Changes Adaptations in muscle including muscle size, strength, 
metabolism, and hormonal and neural interactions, in 
response to the loading environment (e.g., altered 
gravity, exercise/work) that affect performance. 

 

Muscle (Risk) Risk of Impaired Performance Due to Reduced Muscle 
Size, Strength, and Endurance.  

Risk Statement: Given that exposure to a microgravity or partial 
gravity environment causes muscle size, strength, and 
endurance to decline, there is a possibility that mission task 
performance would be impaired or tasks could not be 
performed. 

Musculoskeletal Injury Any injury (environmental or traumatic) that occurs to 
the muscles, bones, tendons, ligaments, or other parts 
of the musculoskeletal system. 

 

Musculoskeletal Loads Forces that are applied to/experienced by the body 
including forces on the tissues, fluids, or materials of 
the body.  

Loads can originate from the external environment (gravity or 
acceleration) or may result from voluntary or involuntary 
actions of the individual (exercise/work). 

Nephrolithiasis Presence of stones in the urine collection area of the 
kidney.  

Nephrolithiasis occurs due to a decrease in urine volume or 
excess of stone-forming substances in the urine. 

Net Habitable Volume The functional volume left available on a spacecraft 
after accounting for the loss of volume caused by 
deployed equipment, stowage, trash, and any other 
items that decrease the functional volume. (NASA-STD-
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3001) 

Neuro/Ocular Injury Any injury (environmental or traumatic) that occurs to 
the eye or brain. 

 

Neutrons A subatomic particle which has a neutral charge; a type 
of ionizing radiation. 

High energy neutrons originating from GCR or created as 
secondary radiation are extremely efficient at ionization and 
more likely to cause cell damage than protons. 

Noise Exposure The level, spectrum, and duration of noise experienced 
by a human.  Noise is defined as sound in the auditory 
range (15 Hz to 20,000 Hz) that is hazardous, undesired, 
and/or inappropriate to the intended use of the space. 
(NASA-STD-3001) 

Noise exposure data can be used to determine expected 
impacts on human performance (e.g., alarm detection, face to-
face communication, etc.), hazards to hearing, and disruptions 
to sleep. 

Non-Ionizing Radiation (Risk) 
Risk of Adverse Health Outcomes and Performance 
Decrements resulting from Non-Ionizing Radiation 
during Space flight.  

Risk Statement: Given the potential for exposure to sunlight and 
ground-based lasers during space flight missions, there is a 
possibility that crewmembers could develop solar retinopathy, 
cataracts, conjunctivitis, photokeratitis, hemorrhagic retinal 
lesions and/or erythema which may result in permanent 
damage and/or may impact mission performance. 

Non-Modifiable Individual 
Factors 

Factors that influence the biologic variability among 
individual crewmembers that affect risk.  Non-
modifiable factors include age, sex, genetic 
predispositions, pre-existing medical conditions, etc. 
These can be further decomposed depending on risk 
needs. 

 

Nuclear Technology Technology that involves nuclear reactions of atomic 
nuclei.  

The use of these technologies for space flight may change the 
radiation carcinogenesis risk to an astronaut. 

Nutrient Deficiencies Nutrient deficiencies occur when the body is not 
getting enough nutrients to support normal 
physiological system function.   

Deficiencies include vitamins, minerals, fluid, and energy, and 
can be due to inadequate dietary intake or impaired digestion, 
absorption, transport, metabolism of nutrients, genetics, 
environmental factors, and can occur with some drug-nutrient 
interactions. 

Nutrient Toxicities Nutrient toxicities occur when nutrients are in excess of 
needs at such a high concentration that is harmful to 
the body.  

Nutrient toxicities generally occur due to excessive 
consumption. 

Nutrients Nutrients are substances that provide the body with Carbohydrates, protein, fat, and water are macronutrients, 
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the nourishment essential for growth and maintenance 
of life.  

required by the body in large quantities to sustain life. 
Micronutrients (including vitamins, minerals, and 
phytochemicals) are needed in smaller amounts for proper 
functioning of body systems. 

On-Board Expertise The collective knowledge, skills, and abilities of the 
integrated human-system team on the vehicle, 
especially pertaining to vehicle systems and complex 
operations. 

 

Operations Design Planning and execution of an activity, mission, or 
maneuver. (NASA-STD-3001) 

 

Optic Disc Edema Swelling of the retinal nerve fibers as they pass through 
the optic nerve head (aka optic disc) and exit the eye.  

 

Optical Coherence Tomography Non-invasive ophthalmic imaging technology that 
provides high-resolution, cross-sectional views of 
ocular anatomy (e.g., retina, cornea), as well as images 
that mimic color retinal photography. 

 

Oral Contraceptives A group of hormone containing substances (estrogen 
and progestin) that are used in menstrual management 
and pregnancy prevention. 

 

Organ Perfusion Under or over perfusion of organs, possibly 
contributing to ischemia or organ damage. 

 

Orthostatic Intolerance Unable or impaired ability to stand (gravity vector in z-
axis). 

Orthostatic intolerance usually occurs due to hypotension or 
motion sickness. 

Orthostatic Intolerance 
Countermeasures 

A means to offset undesirable effects of orthostatic 
intolerance.   

These can be performed during the missions (e.g., exercise) or 
applied prior to or during re-exposure to gravity (e.g., fluid 
loading, lower body compression garments) and may be used 
during recovery from space flight. 

Osteoarthritis A degenerative disease that occurs when the protective 
cartilage that cushions the ends of the bones wears 
down over time often resulting in chronic joint pain. 

 

Other Risks Nodes in a directed acyclic graph which only identify a 
connection at the risk level and do not carry 
information about what specific connections exist in 
detail.  
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Ototoxins A group of chemicals (medications) that can cause 

chemical damage to auditory or vestibular systems 
negatively impacting hearing or balance functions. 

 

Oxidative Stress Imbalance between the production of free radical 
activity and antioxidant activity.  

Long term exposure to these types of stressors may contribute 
towards many diseases, particularly chronic or immune-related 
ones. 

Payload Chemicals Chemicals that are used in experimental payloads.  
Percutaneous Nephrostomy The placement of a catheter through the skin into the 

kidney to drain urine. 
 

Persistent Subclinical Immune 
Dysregulation 

Changes in cellular proliferation and function that does 
not have a known clinical issue directly following it; 
chronic "off nominal" immune status due to stress, 
environment, or other mission factors.  

Changes may include altered Leukocyte Distribution and 
Function, Latent Viral Reactivation, Altered Cytokine, 
Inflammation Balance. 

Pharm (Risk) Risk of Ineffective or Toxic Medications During Long-
Duration Exploration Space flight.  

Risk Statement: Given that there is no current method to 
sufficiently characterize medication use, drug quality and 
performance, clinical outcomes, and the impact of a hostile 
space environment on pharmaceutical stability and potency 
during long-duration exploration missions, there is a possibility 
that provision of a safe and effective drug treatment will be 
significantly limited, impacting crew health and performance. 

Pharmaceutical Contamination Harmful or poisonous substances that can be 
introduced into pharmaceuticals when repackaged. 

Repackaged pharmaceuticals are susceptible to contamination 
and may increase risk for infection among crew. 

Pharmaceutical Effectiveness The extent to which a drug achieves its intended 
(labeled) effect under standard clinical conditions. 

 

Pharmaceutical Storage 
Conditions 

Acceptable environmental conditions (temperature, 
humidity) for storage of medications set forth by the 
United States Pharmacopeia (USP).   

Usually controlled room storage, cool storage and refrigerator 
storage and based on manufacturer stability of where a 
medication is maintained until use. 

Pharmaceutical Toxicity The expression of a poisonous or harmful effect a drug 
can produce. 

 

Pharmacodynamics How drugs act on the body to produce a desired effect.  The onset, intensity and duration of therapeutic response 
elicited by a medication (PD) depends on the rates of 
absorption, distribution, metabolism, and elimination (PK). 

Pharmacogenomics How genes affect drug response in an individual.  
Pharmacokinetics What happens to a medication from the time it enters,  
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and all traces exit the body, as described by four 
processes (pharmacokinetic parameters:  absorption, 
distribution, metabolism, and excretion).  

Physical Status Subset of Individual Factors - Refers to the condition of 
the crewmember at any given time during a mission. 
Can be affected by injuries, activity level, diet, nutrition, 
sleep cycle, and workload.  

Examples of physical status include immediate physical state of 
a crewmember identified prior to embarking on a specific 
mission task like EVA. 

Physiologic Monitoring 
Capability 

Capability to assess, log, and track aspects of crew 
health that provide insight into physiologic response to 
stimuli that is designed into the Crew Health and 
Performance Systems.   

Physiologic monitoring capability can include exercise 
monitoring, sleep monitoring, etc. 

Planned EVA Content Predetermined tasks expected to be completed during 
an extravehicular activity. 

 

Plasma Induced Shock Can occur during EVA Operations. Radiation impacts on 
the spacecraft can result in charged surfaces and if 
there is suit-vehicle/habitat contact then a shock may 
occur. 

 

Post-Landing Task Performance Ability to carry out post landing tasks in a manner that 
avoids crew injury.  

Tasks may include vehicle safing, as well as  tasks resulting from 
off-nominal landings. 

Postural Control and 
Locomotion 

Ability to maintain balance during static postures (lying, 
sitting, standing) and dynamic movements (walking, 
tandem walking, jumping). 

 

Post-Void Residual The amount of urine left in the bladder after urination.  
Preflight Hearing Status The audiometric thresholds obtained prior to flight that 

quantify auditory performance.   
These data are often used as a baseline for comparison to in-
flight and post-flight audiometric thresholds. 

Pre-Mission Food Storage Time The length of time food has been refrigerated or 
packaged before a mission. This can range from weeks 
to years. 

 

Pressure Suits Suits with pressure significantly lower than the ambient 
cabin pressure of a spacecraft.  

This makes crewmembers subject to decompression sickness. 

Pre-syncope/Syncope Under perfusion or decreased oxygenation of the brain 
leading to symptoms including faintness, dizziness, 
nausea, weakness, and tunnel vision. 

 

Preventive Source Control Measures taken to reduce, eliminate or prevent Examples of source control include monitoring for sources of 
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microbial spread.  microbial spread, changing of filters (air, water etc.), wiping 

down of surfaces with antimicrobial agents, eliminating sources 
of emissions by sealing off or assuring proper off-gassing (prior 
to launch). 

Previous Injury Damage or trauma to the body that occurred at any 
time in the past. 

This can include pre-mission injuries such as training injuries 
that limit range of motion or strength. 

Prior Mission Exposures Space flight exposures obtained during a previous 
mission for a particular astronaut. 

 

Privacy/Team Space Privacy: Having an acceptable level of control over the 
extent of sharing oneself (physically, behaviorally, or 
intellectually) with others. (NASA-STD-3001)/ Team 
Space: shared space that facilitates social interactions 
and teamwork.   

This includes limiting other people’s access to you and limiting 
your perceived presence of other people; may involve touch, 
sight, sound, and smell. Acceptable level is dependent upon an 
individual’s background and training.  

Private Astronaut Missions Space flight missions not managed by NASA or other 
government space agencies but instead by private 
organizations. 

 

Probiotics Live microorganisms (e.g., beneficial bacteria and/or 
yeast) which are consumed to promote health benefits, 
particularly in the digestive system by restoring the 
balance between the various types of microorganisms 
found. 

 

Procedure Design The plan of action including steps, conditions, and 
constraints used to complete a specific mission goal.  

 

Proprioception Change Alterations in the internal sense of body movement and 
location. 

 

Protective Equipment A set of components used to mitigate or control effects 
of hazards prior to occurrence.  

Physical equipment such as gloves, foot, and eye protection, 
hearing protection devices (earplugs, muffs), hard hats, 
respirators, and full body suits can provide a physical barrier 
from exposure to chemical releases and other harmful 
substances. 

Protective Glasses Specialized glasses providing eye protection from 
environmental exposures including foreign object 
debris, sunlight, laser, and some particle/chemical 
releases.  
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Protective Windows and Filters Scratch panes, shades, or filters designed into 

spacecraft windows systems that provide protection 
from sunlight and laser exposures. 

 

Psychological Status Refers to the mood and psychological state of the 
individual and/or crew at any given time during a 
mission. 

These factors can directly affect Individual Readiness, Crew 
Capability by decreasing an individual’s readiness for Task 
Performance if crew are distracted, preoccupied, dysregulated, 
unmotivated, or uncooperative. 

QCT Quantitative Computed Tomography (QCT), an x-ray 
based diagnostic test that measures bone mineral in a 
3D volume of bone tissue.  

This exposes the subject being scanned to radiation.  The 
scanner is large enough for the whole body, but it is used to 
target specific areas of interest. The hip and lumbar spine are 
the most common skeletal sites for clinical evaluation with QCT. 

Radiation Human System Risk Hazard - Any combination of 
electromagnetic radiation or particles that deposits 
enough kinetic energy to create ionization events when 
interacting with matter.  

Ionizing radiation energy absorption damages biological systems 
that may lead to clinical illness or contribute to human health 
and performance decrements. 

Radiation Carcinogenesis (Risk) Risk of Radiation Carcinogenesis. 
Risk Statement: Given crew is exposed to radiation from the 
space environment, there is the possibility for increased cancer 
morbidity or mortality. 

Radiation Monitors Device that allows for the determination of the amount 
of radiation within a spacecraft or for a particular 
person.  

 

Recycling The action or process of converting waste into reusable 
material. 

 

Refractive Error Shift Change in the overall optical power of the eye which 
may require the use of lenses to properly focus images 
onto the retina. 

 

Renal Stone (Risk) Risk of Renal Stone Formation.  

Risk Statement: Given changes in urinary biochemistry during 
space flight, there is a possibility that symptomatic renal stones 
will form, which could cause renal colic (pain), nausea, vomiting, 
hematuria, infection, hydronephrosis. 

Resistive Exercise Dynamic exercises involving concentric (shortening) 
and eccentric (lengthening) muscle actions that recruit 
a muscle in isolation or multiple muscle groups. 

 

Resource Availability Availability of necessary items needed for prevention,  
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detection, and treatment of anomalies in the human 
and the vehicle. 

Resupply The ability to restock consumables (i.e., medications, 
medical supplies, food, water, spare parts, etc.). 

 

Retinal Nerve Fiber Layer 
Atrophy 

Permanent loss of the axons that transmit neural 
signals from the retina to the brain, a process which 
ultimately provides the perception of vision. 

 

Rhabdomyolysis The destruction or degeneration of muscle tissue (as 
from traumatic injury, excessive exertion, or stroke) 
accompanied by the release of breakdown products 
into the bloodstream. 

 

Rhabdomyolysis Treatment Medical management and care for the destruction or 
degeneration of muscle tissue (as from traumatic 
injury, excessive exertion, or stroke). 

 

SANS (Risk) Risk of Space flight Associated Neuro-ocular Syndrome.  

Risk Statement: Given that ocular and brain structural changes 
develop during space flight, there is a possibility that these 
changes could lead to short-term or long-term vision 
alterations, cognitive effects, or other deleterious health effects. 

Schedule Shifting Shifting sleep-wake timing to accommodate mission 
events.  

Schedule shifting may involve small shifts in sleep timing or 
large shifts. Small and large schedule shifts can lead to circadian 
misalignment, sleep loss, and subsequent cognitive impairment. 

Scheduling Arranging, controlling, and optimizing work and 
workloads to facilitate crew timeline of activities. 

 

Seals/Gaskets Potentially vulnerable portions of a suit system from a 
dust perspective. 

 

Self-Administered Rehab A set of exercises that are designed to incrementally 
increase in difficulty and challenge the sensorimotor 
system.  

These will presumably result in a faster readaptation. 

Sensorimotor (Risk) Risk of Altered Sensorimotor/Vestibular Function 
Impacting Critical Mission Tasks. 

Risk Statement: Given that altered gravity leads to changes in 
sensorimotor/vestibular function that manifest in motion 
sickness, spatial disorientation, decrements in postural control 
and locomotion, and manual and fine motor control deficits, 
there is a possibility that crew will experience performance 
decrements in manual/vehicle control, extravehicular activities, 
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and egress during and following these transitions.  

Sensory Augmentation External tools such as vibrotactile feedback, an external 
horizon, galvanic vestibular stimulation, or others that 
help enhance the accuracy/sensitivity of the 
individual's information-gathering abilities. 

Sensory abilities include the abilities to see, hear, touch, smell, 
and taste. Includes temperature, pain, kinesthesia, and 
equilibrium. (NASA-STD-3001) 

Sepsis A potentially life-threatening medical condition that 
occurs when the body's response to an infection 
damages its own tissues. 

 

Shielding A barrier between a source of radiation and a potential 
target (e.g., the astronaut); shielding can be solid, liquid 
or gas which absorbs the energy of the radiation. 

 

Side Effects Unwanted or undesirable effects related to a drug. Also 
known as adverse effects.   

 

Skeletal Fragility A condition of bone that renders its biomechanical 
capacity so low that bone will fracture with minimal or 
no loading. 

 

Skin Injury Any injury (environmental or traumatic) that occurs to 
the body's outermost organ, often affecting the 
epidermis and dermis layers. 

 

Skin Irritation Redness, abrasion, or damage of the skin related to 
mechanical contact with celestial dust. 

 

Sleep Deficiencies Obtaining sleep of insufficient quantity or quality.  Insufficient quantity of sleep leads to chronic sleep deprivation 
and subsequent performance impairment. Insufficient quality of 
sleep may occur when sleep is disrupted due to environmental 
factors or schedule shifting (i.e., sleeping in a circadian 
misaligned state). Insufficient sleep quality may involve 
disrupted or fragmented sleep or altered sleep architecture 
(e.g., reduced quantity of REM/NREM sleep, atypical sleep cycle 
stages). Sleep deficiency leads to cognitive impairment. 

Sleep Inertia Sleep inertia is a transitional state between sleep and 
wake (i.e., grogginess experienced upon waking), 
accompanied by cognitive impairment and desire to 
return to sleep.  

The severity of sleep inertia depends on the stage of sleep from 
which one has awoken, the circadian phase at which one wakes, 
and prior sleep history. The cognitive impairment experienced 
in conjunction with sleep inertia can be as severe as 24 hours of 
sleep loss. Sleep inertia symptoms are worst immediately upon 
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waking. Recovery from sleep inertia can last for up to two 
hours. 

Sleep (Risk) 
Risk of Performance Decrements and Adverse Health 
Outcomes Resulting from Sleep Loss, Circadian 
Desynchronization, and Work Overload. 

Risk Statement: Given that astronauts experience sleep loss, 
circadian desynchronization, and work overload, there is a 
possibility that performance decrements and adverse health 
outcomes will occur. 

Social Dynamics The social interaction dynamics within the crew and 
between the crew and ground support teams.  

Social dynamics include group living competencies, culture, 
language, and personality, among other factors.   

Social Support Collective structure (perceived or real) for help or aid 
from a mixture of relationships such as friends, family, 
colleagues, acquaintances, and the public; perceived 
social support is when individuals believe they have 
support available. 

 

Solar Cycle An approximately 11-year cycle experienced by the 
Sun. 

During the solar cycle, the Sun's stormy behavior builds to a 
maximum, and its magnetic field reverses. Then, the Sun settles 
back down to a minimum before another cycle begins 

Solar Particle Event Phenomenon which occurs when particles from the Sun 
are accelerated and transiently alter the local radiation 
environment. 

 

Spatial Orientation The accuracy of perceived body position with respect to 
a gravity-inertial vector and/or external surroundings 
(e.g., spacecraft). 

 

Staged Denitrogenation Gradual or phased reduction of nitrogen in lungs and 
body tissues by breathing gases devoid of nitrogen. 

 

Standards/Requirements NASA documents (in HSRB DAGs, usually refers to the 
NASA STD 3001 Vol 1 and Vol 2) that contain common 
and repeated use of rules, conditions, guidelines, or 
characteristics for products or related processes and 
production methods and related management system 
practices. Requirements are usually much more 
detailed "children" of these Standards and are 
negotiated with the Space flight Programs and HMTA at 
the onset of the Program.  

Standards for the HSIA Risk include NASA documents (e.g., 
NASA STD 3001 Vol 1 and Vol 2) that contain the desired 
functionality, features, or other attributes of systems being 
developed or acquired without stating a method for achieving it.  

Startle Reaction An unconscious defensive response to sudden or  
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threatening stimuli such as a loud noise, sharp 
movement, or shock.  

Starvation Starvation is a severe deficiency in caloric energy 
intake, below the level necessary to sustain life.  

Starvation results in suffering or death caused by extreme 
hunger and undernourishment. 

Stress Measurable physiological response which may be 
characterized as emotional or physical tension, to 
environmental factors.  It is mediated by various 'stress 
hormones' which the body produces to respond to such 
stressors.  

Stress may be acute (EVA) or chronic (prolonged isolation), 
resulting in differing effects on physiology.  Stress can result in 
negative physiological responses, such as immune suppression, 
negative cardiovascular events or outcomes, sleep disturbances 
and ultimately, decreased task performance and cognition. 

Stress Relieving VR Virtual reality (VR) systems and/or programming that 
mitigates stress.    

 

Strobe Goggles Goggles that flash between a transparent and opaque 
view with the goal of helping people who are 
undergoing vestibular readaptation to maintain gaze 
without suffering from retinal slip, or an object slipping 
over your retina instead of stabilizing there.  

 

Sudden Sensorineural Loss An unexplained, rapid loss of hearing (in the inner ear) 
that occurs all at once or over a few days.  One or both 
ears may be affected. 

 

Suit Damage Harm or injury to the flight or EVA suit.  For example, an actor (topical medication) causes an 
impairment or negatively impacts the usefulness of the suit. 

Suit Design The form and function of the spacesuit to support the 
operational mission goals and performance 
environment. 

 

Suit Failure Compromised function of the suit system possibly due 
to the unanticipated malfunction of a component, 
unexpected interaction of subsystems, unintended 
behavior, or external environmental effect. 

 

Suit Habitability Capability of an EVA suit to provide a micro-
environment for crew that must provide all the life 
support, nutrition, hydration, waste, and consumables 
management function of an actual space vehicle, while 
allowing crewmembers to perform mission tasks.  

EVA spacesuits are designed to be used for durations of less 
than a day due to potential human and suit system constraints. 
This includes all suited phases (e.g., prebreathe, leak checks, 
airlock depress, repress). 

Suit-Vehicle/Habitat Contact Suit, vehicle, and/or habitat exposure to charged  
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surfaces. 

Sunlight Solar radiation, includes ultraviolet, visible, infrared, 
and near-infrared ranges of the electromagnetic 
spectrum. 

 

Supplements Consumable products that contain a dietary ingredient 
such as vitamins, minerals, amino acids, herbs or 
botanicals;  

Supplements are designed to enhance nutrient composition of 
diet which may be lower than needed (such as Vitamin D or B 
complex) or to improve a condition which has been associated 
with loss or lowered levels of a nutrient (such as chondroitin 
sulfate and glucosamine for arthritis). Certain nutritional 
supplements are included in the proposed immune 
countermeasures suite. 

Surface Contamination Harmful or poisonous substances affecting surface 
quality within the vehicle, suit, or habitat in-mission.  

Microbes on surfaces are found regularly on ISS, cleaning 
procedures can decrease impact on crew. 

Surface Dust Level The quantity of particulate matter on the surfaces 
within the within the vehicle, suit, or habitat in-mission. 

 

Surveillance Monitoring and diagnostic services available to active 
and retired astronauts to facilitate early detection of 
health conditions that may be associated with 
exposures incurred during space flight or space flight 
training. 

 

Sympathomimetics A group of chemical substances (stimulant compounds) 
that elicit an effect on the sympathetic nervous system. 

 

System Complexity A measure of the number, diversity, and intricacy of 
vehicle systems and their interactions. 

 

System Knowledge Resources The information that describes and fully specifies the 
system, including analyses, drawings, and 
requirements.  

Crew performance for maintenance and repair if spacesuit, 
vehicle, and habitat issues is dependent on ready access to 
information and manuals needed. 

System Telemetry Vehicle/system state information received from distal 
sensors. 

 

Tamsulosin A medication (alpha-1 blocker) used to treat BPH.  Off 
label use treatment for kidney stone expulsion. 

 

Task A specific type, piece, or amount of work; a subset of 
an activity or job that is called out in a procedure.
 
(NASA-STD-3001) 
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Task Performance Likelihood of successful performance of a task based on 

factors such as response time, efficiency, or accuracy. 
 

Team A collection of individuals who are assigned to support 
and achieve a particular mission. This can encompass 
both the spaceflight crew and ground support for a 
particular mission. 

 

Team Cognition Shared understanding among team members that is 
related to roles and responsibilities; team norms; 
familiarity with team members’ knowledge, skills, and 
abilities; and engaging in team decision-making and 
problem-solving. 

 

Team Cohesion Tendency for a group to operate in a unified fashion 
while working towards a goal or to satisfy the 
emotional needs of its members. 

 

Team Composition The mix of individuals on a team that evolves to meet 
mission demands pre-mission through post mission 
phases. This includes those the ground support, 
intelligent systems, and sub-teams; composition factors 
for mission performance include personality traits, 
values, culture, demographics, knowledge, skills, and 
abilities. 

 

Team Functionality The degree of coordination, cooperation, 
communication, and psychosocial adaptation that 
enables a team to successfully complete tasks and live 
and work as a team. 

 

Team Monitoring Observing changes in team task performance, team 
processes, and interpersonal dynamics through surveys 
and unobtrusive tools such as semantic analysis. 

 

Team (Risk) 

Risk of Performance and Behavioral Health Decrements 
Due to Inadequate Cooperation, Coordination, 
Communication, and Psychosocial Adaptation within a 
Team.  

Risk Statement: Given that the conditions of space missions may 
lead to inadequate functioning within a team (inadequate 
cooperation, coordination, communication and/or psychosocial 
adaptation), which includes flight crew and ground support, 
there is a possibility that performance and behavioral health 
decrements will occur. 
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Team Skills Skills that enable team functioning and performance.  Team skills include information sharing, backup behaviors, 

leadership/followership, team care, and providing social 
support, among others. 

Team Training Training focused on team skills for living and working 
together in space. 

 

Technical Training Training focused on technical skills needed to perform 
tasks in space. 

 

Temperature The degree or intensity of heat present in a substance 
or object; an environmental factor which may 
contribute to several Risks. 

 

Thermal Degradation Chemicals produced when a material is exposed to 
elevated temperatures  

For example, Teflon releases PFIB at very high temps. 

Thermal Environment Cabin temperature and humidity environment during 
and post landing. 

 

Thiazides A class of drugs that act directly on the kidneys to 
promote diuresis and increase urine flow.  

Thiazides are primarily used in the treatment of hypertension.  
It is also used to reduce kidney stone recurrence. 

Thigh Cuffs Cuffs placed around the upper thigh which can be 
tightened or inflated to occlude venous (i.e., 
sequestering blood in the lower body) and arterial 
blood flow (i.e., blood flow restriction). 

 

Time Critical Procedure 
Execution 

Accomplishing the steps in a procedure that must be 
completed within a specific period to prevent 
unwanted consequences and/or achieve the desired 
outcome. 

 

Tool Design The form and function of a hardware/software device, 
implement, or method to accomplish a particular 
outcome in a specific operating environment. 

 

Tox (Risk) Risk of Toxic Exposure.  

Risk Statement: Given that the numerous sources of toxic 
chemicals onboard spacecraft cannot be eliminated, there is a 
risk of toxic exposure that will impact crew performance and 
lead to Loss of Mission Objectives (LOMO), Loss of Mission 
(LOM), Loss of Crew (LOC), or Long-Term Health (LTH) 
Conditions. 

Toxic Exposure Contact with agents or substances in the interior of the  
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spacecraft or spacesuit that can affect the health and 
performance of the astronauts. 

Toxic Substance Monitoring Monitoring for specific toxic compounds of potential 
concern. 

 

Training The act of undertaking a course of instruction in skills, 
knowledge or fitness that relate to specific 
competencies needed for space flight missions.  

Training has specific goals of improving an individual or team's 
capability, capacity, and performance. 

Trapped Radiation Charged particles trapped by Earth's magnetic field.  
Traumatic Injury Any injury that occurs as a result of as a result of 

penetrating or blunt forces or thermal loads. 
 

Treatment Decision Determination of need to manage and provide care for 
crew with medications or procedures during a space 
flight mission. 

 

Ultrasound An imaging modality to examine the internal organs 
using very high frequency sound waves. 

 

Ultrasound Manipulation Treatment modality to aid in movement of a renal 
stone either before it enters the ureter or moving it out 
of the ureter thus decreasing time of symptoms.  

Ultrasound Manipulation is also known as propulsive ultrasound 
or ultrasound propulsion. 

Ureterolithiasis Stones in the ureter.  
Urinary Muscle Changes Alterations in muscle function due to altered gravity 

environment, side effects of medications, etc.  
 

Urinary Retention A condition in which all the urine from the bladder 
cannot be emptied. 

 

Urinary Retention (Risk) Risk of Urinary Retention.  

Risk Statement: Given that the space flight environment alters 
the gravity vector involved in terrestrial micturition and causes 
physiological changes that may require use of predisposing 
medications, and that mission operational schedules may limit 
access to voiding, there is a possibility of health and 
performance impact during space flight by significant discomfort 
from urinary retention and associated urinary tract infection. 

Urine Chemistry The levels of stone-promoting substances (Ca, oxalate, 
uric acid, pH) in the urine and its pH. 

 

Urine Concentration The state of saturation of urine relative to water 
content. 
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Nodes Definitions  Additional Notes 
Urine Flow The ability for urine to flow normally through the 

urinary tract. 
 

Vascular Congestion Increased blood volume in a vessel as a result of 
changes in pressure and/or obstruction. 

 

Vascular Structure/Function Anatomy and physiological function of the arteries, 
arterioles, venules, veins, and capillaries. 

 

Vehicle Design Determining and developing the form and function of 
space vehicles toward the operational mission goals 
and performance environment.  

Vehicle design includes restraints and occupant protection 
measures. 

Vehicle Dynamics Angular and linear accelerations of a vehicle.  
Vehicle Failure Compromised function of the vehicle system.  Vehicle failure could possibly occur due to the unanticipated 

malfunction of a component, unexpected interaction of 
subsystems, unintended behavior, or external environmental 
effect. 

Vehicle Systems The set of systems, subsystems, and components (e.g., 
thermal control system, pump module, flow control 
valve) that make up a whole vehicle. Also, may refer to 
vehicle systems across multiple vehicles (Orion, 
Gateway, HLS). 

 

Venous Thrombosis The development of a blood clot in a vein.  
Vestibular Gain Change The relationship between accelerations, including 

gravitational, and vestibular responses. 
 

Vestibular Motor Neuron 
Change 

Vestibular neurons adapt to reduced or increased firing 
rates and become more, or less, sensitive. 

 

Vibration Isolation System Passive or active mechanical interface between the 
exercise device and the vehicle to isolate the exercise 
system and eliminate/attenuate exercise reaction loads 
transmitted to the vehicle. 

 

Vison and Gaze Control Vision is the ability to see and gaze control is the ability 
to orient the eyes, and maintain fixation, on a desired 
visual target. 

 

Visual Acuity Test A primary vision test which measures the visual 
system's ability to discern targets (e.g., letters) at a 
given distance (e.g., 20 feet) from the patient. 

Visual Acuity is defined by the smallest letters that can be 
identified under standard 
viewing conditions. An average acuity for young adults is about -
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Nodes Definitions  Additional Notes 
0.1 logMAR but declines with age. (NASA-STD-3001) 
age. 

Visual Field Defect Dysfunction in central or peripheral vision.  
Visual Fields Test Ophthalmic diagnostic test which detects defects in 

central and peripheral vision. 
 

Void Trial Measure of the ability of the bladder to empty.  
Vomit Disgorging the contents of the stomach through the 

mouth. 
 

VTE (Concern) Concern of Venous Thromboembolism (VTE).  

Risk Statement: Given there has been an asymptomatic in-flight 
venous thrombosis of unknown origin aboard the International 
Space Station (ISS), there is a potential risk for a crewmember to 
encounter the terrestrial consequences of venous thromboses 
and treatment adverse events which include pain, post-
thrombotic syndrome, pulmonary embolism, death, recurrence, 
and bleeding (treatment-related risk). 

Waste Management System The combination of elements that function together to 
produce the capability to facilitate the clean, efficient, 
and reliable collection and management of human 
waste (urine, feces, vomitus, and menses). 

Waste Management Systems include systems for food waste, 
body waste, personal hygiene, and exercise. Elements of the 
systems include all hardware, software, equipment, facilities, 
personnel, processes, and procedures. 

Water Contamination Harmful or poisonous substances affecting water 
quality within the vehicle or habitat in-mission.   

Regular monitoring and use of disinfectants (iodine and silver as 
examples) helps limit infections in crew. 

Water Intake Water intake encompasses the total fluid intake 
consumed from foods, plain drinking water, and other 
beverages. 

 

Workload Level of demand placed on a crewmember's physical, 
cognitive, and/or temporal resources in a unit of time.  

Physical workload refers to the number of individual physical 
activities that are conducted simultaneously or in close 
succession. Similarly, mental, or cognitive workload refers to the 
number of mental operations or activities that are conducted 
simultaneously or in close succession. 
  (NASA-STD-3001) Such 
demands tax time/schedules, physical abilities, and cognitive 
abilities of the crew which are finite resources. 
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Appendix B – DAG Nodes to Risks Mapping 
 
 The following is a tabular representation of each node in the Human System Risk DAGs 

and all of the Risks using that particular node. The node names appear on the left side and the 
Risk names appear at the top. Each blue box intersection represents a node appearing in that 
DAG. Some nodes are common across many Risks like “Altered Gravity”, others appear in only 
one Risk like “Blood Viscosity”. 
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Absorption                                       1                   
Acoustics (Risk)                                                 1 1 1     
Aerobic (Risk)     1 1   1           1       1                           
Aerobic Fitness                                   1                       
Air Contamination                                 1                         
Airlock Design             1                                             
Altered Gravity 1   1 1 1 1 1   1   1 1   1 1 1 1 1   1   1 1 1 1   1 1 1 
Ambient CO2 Level         1                         1                       
Anomalous Events                         1                                 
Anthropometry                  1                                         
Anticholergics                                                        1   
Anticoagulants                                                         1 
Antimicrobial Resistance                                       1                   
Arc Flash/Sparking                   1                                       
Arterial Gas Embolism             1                                             
Artificial Gravity                                               1           
Aspiration           1                                               
Astronaut Selection 1 1 1 1     1   1   1 1     1 1 1 1     1 1 1 1 1 1   1 1 
Atmospheric Conditions             1             1 1                           1 
Atmospheric Dust Level               1                                           
Atmospheric Mixing         1                                                 
Atmospheric Scrubbers                                                     1     
Autonomous Systems                         1                                 
Balance Training                                               1           
Barotrauma  1                                                         
Behavioral (Risk)         1             1     1 1 1     1         1 1 1     
BHP Countermeasures                                                   1       
BHP Family Services   1                                                       
BHP Intervention 
Capability   1                                                       
BHP Monitoring Capability   1                                                       
BHP Prevention Capability   1                                                       
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Biologic Response                                         1                 
Biomedical Exposures                                         1                 
Bisphosphonates                                            1               
Blood Stagnation                                                         1 
Blood Viscosity                                                         1 
Body Posture                 1                                         
Bone Density     1                                                     
Bone Formation     1                                                     
Bone Fracture     1                                                     
Bone Fracture (Risk)         1 1           1               1   1               
Bone Remodeling                 1                         1               
Bone Resorption     1                                                     
Bone Structure     1                                                     
Brain Structural Changes                                             1             
Breathing Masks                           1                               
Burn Treatment Capability                   1                                       
Burns                    1                                       
Cabin Visibility               1                                           
Cancer                                         1                 
Cancer Model                                         1                 
Cancer Treatment                                         1                 
Cardiac Structure/Function       1                                                   
Cardiovascular (Risk)           1   1       1           1   1     1       1     
Cartilage Defect     1                                                     
Catheterization                                                        1   
Central Nervous System 
Changes   1             1                                         
Charged Particles                                         1                 
Charged Surface                   1                                       
Chondrocyte Metabolism     1                                                     
Chorioretinal Folds                                             1             
Circadian Misalignment                             1                   1         
Cleaning                1                                           
Clinically Significant 
Immune Dysregulation                             1                             
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CO2 (Risk)                             1             1 1   1 1 1   1 
CO2 Physiologic Changes         1                                                 
CO2 Production         1                                                 
CO2 Removal         1                                                 
Coagulability                                                         1 
Cochlear Changes 1                                                         
Cognitive Function   1                 1     1                               
Combustion/Smoldering 
Events                                                     1     
Communication Factors   1                     1     1                     1     
Communications Delay                                                   1       
Compartment Isolation                           1                               
Connective Tissue Changes                 1                                         
Crew Capability 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1   1 1 1 1 1 1 1 1 
Crew Composition   1                                                       
Crew Egress (Risk)                               1                           
Crew Health and 
Performance System 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
Crew Metabolism                                                     1     
Crew Size         1               1                         1       
Crew Vehicle Integration           1       1     1                                 
Data Accessibility                         1     1                           
Data Architecture                         1     1                           
DCS (Risk)     1     1         1     1           1                   
DCS Type I             1                                             
DCS Type II             1                                             
Denitrogenation              1                                             
Depressurization             1             1                               
Detect Atmospheric 
Changes                           1                               
Detect Atmospheric Dust               1                                           
Detect BHP Changes   1                                                       
Detect Bone Density 
Changes     1                                                     
Detect Bone Structure 
Changes     1                                                     
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Detect Brain Structural 
Changes                                             1             
Detect CO2 Level         1                                                 
Detect Contamination                                 1                         
Detect CV Events       1                                                   
Detect DCS             1                                             
Detect Diagnosis                               1                     1     
Detect Dysrhythmia                   1                                       
Detect Environmental 
Conditions                               1                 1         
Detect EVA Readiness                     1                                     
Detect Events                         1                                 
Detect Hearing Changes 1                                                         
Detect Immune Changes                             1                             
Detect Intracranial 
Pressure Changes                                             1             
Detect Long Term Health 
Outcomes 1 1 1 1   1 1 1 1 1 1 1     1 1 1   1 1 1 1 1   1   1 1 1 
Detect MRM/Stone                                           1               
Detect Noise Levels 1                                                         
Detect Ocular Structural 
Changes                                             1             
Detect Physiologic Changes                               1                           
Detect Post-Void Residual                                                       1   
Detect Pressure Changes 1                                                         
Detect Radiation                                         1                 
Detect Team Performance 
and Cohesion                                                   1       
Detect Thrombosis                                                         1 
Detect Toxic Exposure                                                     1     
Detect Visual Changes                                             1             
Diagnose Events                         1                                 
Diagnose Rhabdomyolysis                   1                                       
Diagnostic Capability                         1                                 
Distance from Earth 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
Distribution                                       1                   
Dust (Risk)                             1                       1     
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Dust Monitor               1                                           
Dust Removal               1                                           
Dust Source               1                                           
Dust Suspension               1                                           
DXA      1                                                     
Dynamic Loads (Risk)     1     1         1                                     
Dysrhythmia                    1                                       
Dysrhythmia Monitor                   1                                       
Dysrhythmia Treatment                   1                                       
Ebullism              1                                             
ECLS System         1     1                   1             1   1     
Effective Exposure 
Duration 1       1 1               1                               
Effective Gravity Level           1                       1                       
Effective Mission Duration                       1 1         1   1 1         1       
Electric Shock (Risk)                                       1             1     
Electrical Hardware                   1                                       
Electrical Muscle Effects                   1                                       
Electrical Shock                   1                                       
Electrical System Design                   1                                       
Elimination                                       1                   
Endocrine Factors     1 1                           1                     1 
Endothelial Damage                                                         1 
Energy (Calories)                       1                                   
Environmental Conditions 1     1                       1                 1         
Environmental Control 1       1                                       1         
Environmental Injury           1         1         1                           
Environmental Monitoring 
Capability 1       1                 1   1 1               1         
Environmental Risks                               1                           
Estimated Career Dose                                         1                 
Estimated Dose Rate                                         1                 
Estimated Mission 
Radiation Dose                                         1                 
EVA (Risk)                               1       1         1     1   
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EVA Decision Support                     1                                     
EVA Duration                     1                                     
EVA Frequency                     1                                     
EVA Operations             1 1   1       1                               
EVA Task Timeline                     1                                     
Evacuation   1 1 1 1 1   1 1 1   1 1   1 1 1     1   1       1 1 1 1 
Exercise   1   1 1                   1         1       1           
Exercise Hardware                                   1           1           
Exercise Prescription                                   1                       
External Contaminants                                                     1     
Extraterrestrial Surface                                         1                 
Eye Injury               1                     1                     
Fall Height           1         1                                     
Family Effects                                                   1       
Family/World Events   1                                                       
Fatigue                      1             1             1         
Fine Motor Control                                               1           
Flight Recertification     1 1   1   1 1           1 1     1   1 1 1             
Fluid Shifts 1     1                               1     1 1         1 
Food Acceptability                       1                                   
Food and Nutrition (Risk)     1 1 1                   1   1 1   1   1 1   1 1     1 
Food Contamination                                 1                         
Food Preparation                       1                                   
Food Production                       1                                   
Food Safety                       1                                   
Food Storage                       1                                   
Food System                       1                                   
Food Variety                       1                                   
Fundoscopy                                             1             
Galactic Cosmic Radiation                                         1                 
Gamma Rays                                         1                 
Globe Flattening                                             1             
Ground Support   1       1             1     1                   1 1     
Hardware/System Failure                   1                                       
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Hearing Countermeasures 1                                                         
Helmet/Protective Visors                                     1                     
Hematologic Index 
Alterations                                                         1 
Hostile Closed 
Environment 1     1 1 1 1 1 1 1 1 1   1 1 1 1     1   1   1 1   1 1 1 
HSI Processes                         1                                 
HSIA (Risk) 1 1 1 1 1 1 1 1   1 1 1   1 1 1 1 1 1 1 1 1 1 1 1 1 1 1   
Human Error                   1                                       
Human-Electrical Contact                   1                                       
Humidity                                   1       1               
Hydration                       1               1   1               
Hygiene                                  1                         
Hypoxia                           1                               
Hypoxia (Risk)         1 1                 1                   1       1 
Immune (Risk)       1       1       1   1     1     1         1         
Impedance Factors                   1                                       
Incapacitation/ Crew 
Rescue                     1                                     
Individual Factors 1 1 1 1 1   1   1   1 1   1 1 1 1 1   1   1 1 1 1 1 1 1 1 
Individual Readiness 1 1 1 1 1 1 1 1 1 1 1 1   1 1 1 1 1 1 1   1 1 1 1 1 1 1 1 
Infection                                 1                         
Inflammation   1   1                     1                         1 1 
Inflight Hearing Exams 1                                                         
Ingestion Toxicity               1                                           
In-Mission Shelf Life                                       1                   
Insomnia                                                 1         
Interpersonal 
Relationships                                                   1       
Intervention Decision                         1                                 
Intervention Measures                                         1                 
Intervention Source 
Control                                 1                         
Intracochlear Pressure 1                                                         
Intracranial Pressure 
Changes                                             1             
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Intracranial Pressure 
Monitoring                                             1             
Intravascular Volume       1                                                   
Isolation and Confinement   1                 1       1 1 1 1             1 1   1 1 
K+ Citrate                                           1               
Lab Blood Monitoring                             1                             
Landing Profile           1                                               
Landing Site Environment           1                                               
Laser                                      1                     
Lenses                                             1             
Long Term Health Clinical 
Decisions     1                                                     
Long Term Health 
Outcomes 1 1 1 1   1 1 1 1 1 1 1     1 1 1   1 1 1 1 1   1   1 1 1 
Loss of Crew Life   1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1   1   1   1 1 1 1 1 1 
Loss of EVA Content                     1                                     
Loss of EVA(s)             1                                             
Loss of Mission   1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1   1 1 1 1 1 1 1 1 
Loss of Mission Objectives 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1   1 1 1 1 1 1 1 1 
Loss of Vehicle                         1 1                       1       
Lower Body Negative 
Pressure                                             1             
Lung Injury               1                                           
Maintainability                         1                                 
Manufacturer Shelf Life                                       1                   
Materials Offgassing                                                     1     
Measurable Hearing Shift 1                                                         
Mechanical Obstruction                                                       1   
Mechanical Systems         1                                                 
Medical (Risk) 1       1     1       1   1           1         1 1 1   1 
Medical Diagnostic 
Capability             1     1           1       1                   
Medical Illness       1                     1 1           1           1   
Medical Monitoring 
Capability       1                                   1             1 
Medical Prevention 
Capability       1   1   1             1 1 1   1 1 1 1 1 1 1   1 1 1 
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Medical Treatment 
Capability     1 1   1 1 1 1 1 1       1 1 1   1 1   1 1 1 1     1 1 
Medication Compatibility                                       1                   
Medications                                           1 1             
Metabolism                                       1                   
Microbial Resistance 
Factors                                 1                         
Microbial Virulence Factors                             1   1                         
Microbiome                             1   1         1               
Microhost (Risk)                       1     1         1   1               
Mild Hypoxia                           1                               
Mineralized Renal Material                                           1               
Mission Architecture 
Complexity                         1                                 
Mitigation Options                         1                                 
Modifiable Individual 
Factors                                         1                 
Monitoring Capability                         1                                 
Morphological G-Receptor 
Changes                                               1           
Motion Sickness           1                                   1           
Motivation                                   1                       
MRI      1                                       1             
Multi-Sensory Integration 
Alterations                                               1           
Muscle (Risk)     1     1           1       1               1           
Muscle Performance                 1                 1                       
Muscle Physiologic 
Changes                                   1           1           
Musculoskeletal Injury                 1                                         
Musculoskeletal Loads     1                             1           1           
Nephrolithiasis                                           1               
Net Habitable Volume         1                                         1       
Neuro/Ocular Injury                 1                                         
Neutrons                                         1                 
Noise Exposure 1                                                         
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Non-Modifiable Individual 
Factors                                         1                 
Nuclear Technology                                         1                 
Nutrient Deficiencies                       1                                   
Nutrient Toxicities                       1                                   
Nutrients                       1     1             1               
On-Board Expertise                         1     1                           
Operations Design           1                                               
Optic Disc Edema                                             1             
Optical Coherence 
Tomography                                             1             
Oral Contraceptives                                                         1 
Organ Perfusion       1   1                                               
Orthostatic Intolerance       1                                                   
Orthostatic Intolerance 
Countermeasures       1                                                   
Osteoarthritis     1                                                     
Other Risks   1                     1     1                           
Ototoxins  1                                                         
Oxidative Stress   1   1                     1                           1 
Payload Chemicals                                                     1     
Percutaneous 
Nephrostomy                                           1               
Persistent Subclinical 
Immune Dysregulation                             1                             
Pharm (Risk) 1   1 1 1     1       1     1 1 1 1     1 1 1 1 1   1 1 1 
Pharmaceutical 
Contamination                                 1                         
Pharmaceutical 
Effectiveness                                       1                   
Pharmaceutical Storage 
Conditions                                       1                   
Pharmaceutical Toxicity                                       1                   
Pharmacodynamics                                       1                   
Pharmacogenomics                                       1                   
Pharmacokinetics                                       2                   
Physical Status                     1                                     
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Physiologic Monitoring 
Capability                   1 1         1             1       1     
Planned EVA Content                     1                                     
Plasma Induced Shock                   1                                       
Post-Landing Task 
Performance           1                                               
Postural Control and 
Locomotion                                               1           
Post-Void Residual                                                       1   
Preflight Hearing Status 1                                                         
Pressure Suits                           1                               
Pre-syncope/Syncope       1                                                   
Preventive Source Control                                 1                         
Previous Injury                     1                                     
Prior Mission Exposures                                         1                 
Privacy/Team Space                                                   1       
Private Astronaut Missions                                                   1       
Probiotics                              1                             
Procedure Design           1         1   1                                 
Proprioception Change                                               1           
Protective Equipment                                                     1     
Protective Glasses                                     1                     
Protective Windows and 
Filters                                     1                     
Psychological Status   1                                                       
QCT      1                                                     
Radiation    1 1 1           1 1 1     1 1     1 1 1     1 1     1 1 
Radiation Carcinogenesis 
(Risk)                       1               1                   
Radiation Monitors                                         1                 
Recycling                        1                                   
Refractive Error Shift                                             1             
Renal Stone (Risk)         1             1               1                   
Resistive Exercise     1                             1       1               
Resource Availability                         1     1       1                   
Resupply                       1 1     1       1                   
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Retinal Nerve Fiber Layer 
Atrophy                                             1             
Rhabdomyolysis                    1                                       
Rhabdomyolysis 
Treatment                   1                                       
SANS (Risk)         1       1         1           1       1           
Schedule Shifting                                                 1         
Scheduling                                    1                       
Seals/Gaskets               1                                           
Self-Administered Rehab                                               1           
Sensorimotor (Risk)     1     1     1                 1                   1   
Sensory Augmentation                                               1           
Sepsis                                  1                         
Shielding                                         1                 
Side Effects                                       1                   
Skeletal Fragility     1                                                     
Skin Injury                                     1                     
Skin Irritation               1                                           
Sleep (Risk)       1 1             1   1 1     1   1           1       
Sleep Deficiencies                                                 1         
Sleep Inertia                                                 1         
Social Dynamics   1                                                       
Social Support                                                   1       
Solar Cycle                                         1                 
Solar Particle Event                                         1                 
Spatial Orientation                                               1           
Staged Denitrogenation                           1                               
Standards/Requirements   1                     1                           1     
Startle Reaction                   1                                       
Starvation                       1                                   
Stress                             1                   1       1 
Stress Relieving VR                             1                             
Strobe Goggles                                               1           
Sudden Sensorineural Loss 1                                                         
Suit Damage                                       1                   
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Suit Design 1   1 1 1 1 1 1 1 1     1 1   1     1 1                   
Suit Failure             1       1     1                               
Suit Habitability                     1                                     
Suit-Vehicle/Habitat 
Contact                   1                                       
Sunlight                                     1                     
Supplements                             1               1             
Surface Contamination                                 1                         
Surface Dust Level               1                                           
Surveillance  1 1 1 1   1 1 1 1 1 1 1     1 1 1   1 1 1 1 1   1   1 1 1 
Sympathomimetics                                                       1   
System Complexity                         1                                 
System Knowledge 
Resources                         1                                 
System Telemetry                         1                                 
Tamsulosin                                           1               
Task Performance 1 1 1 1 1   1 1 1 1 1 1 1 1 1 1 1 1 1 1   1 1 1 1 1 1 1 1 
Team (Risk)   1     1 1           1     1 1 1               1   1     
Team Cognition                                                   1       
Team Cohesion                                                   1       
Team Composition                                                   1       
Team Functionality                                                   1       
Team Monitoring                                                   1       
Team Skills                                                   1       
Team Training                                                   1       
Technical Training                                                   1       
Temperature                                   1                       
Thermal Degradation                                                     1     
Thermal Environment           1                                               
Thiazides                                           1               
Thigh Cuffs                                             1             
Time Critical Procedure 
Execution                         1                                 
Tool Design                     1                                     
Tox (Risk) 1     1                                                   
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Toxic Exposure                           1                         1     
Toxic Substance 
Monitoring                                                     1     
Training   1                 1   1     1                           
Trapped Radiation                                         1                 
Traumatic Injury           1         1         1               1           
Treatment Decision                               1                           
Ultrasound     1                                     1 1         1 1 
Ultrasound Manipulation                                           1               
Ureterolithiasis                                            1               
Urinary Muscle Changes                                                       1   
Urinary Retention                                                       1   
Urinary Retention (Risk)                                       1   1               
Urine Chemistry                                           1               
Urine Concentration                                           1               
Urine Flow                                           1           1   
Vascular Congestion                                             1             
Vascular 
Structure/Function       1         1                                       1 
Vehicle Design 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 
Vehicle Dynamics                 1                             1           
Vehicle Failure             1             1                               
Vehicle Systems                         1                                 
Venous Thrombosis                                                         1 
Vestibular Gain Change                                               1           
Vestibular Motor Neuron 
Change                                               1           
Vibration Isolation System                                   1                       
Vison and Gaze Control                                               1           
Visual Acuity Test                                             1             
Visual Field Defect                                             1             
Visual Fields Test                                             1             
Void Trial                                                       1   
Vomit            1                                               
VTE (Concern)                       1               1                   
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Appendix C – Risk Formatting Instructions 
DAG Formatting from DAGitty 3.0 

 
 
The Human System Risk DAGs were created using DAGitty 3.0 (3) a publicly available 

browser-based environment for creating, editing, and analyzing causal diagrams. DAGitty is 
available under the terms of the GNU general public license.  Text formatting files for each Risk 
(as of May 2022) are included here. Note that a limitation of the DAGitty program is that it does 
not capture the complete information held in the official versions of the DAG.  The program is 
unable to provide capture information such as the dotted lines seen in some of the DAGs in this 
document.  These dotted lines signify causal connections that are weakly hypothetical at this 
point when evaluated based on evidence in the literature or within NASA’s available data.  The 
DAGitty files below should be thought of as representing the basic skeleton of the DAG.  NASA 
is both investigating currently available software and developing internal software to enable 
DAG creation and visualization with the appropriate amount of information captured.  These will 
be released to the public when available.   
 

http://www.gnu.org/licenses/gpl.html
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Acoustics Risk  
dag { 
"Altered Gravity" [exposure,pos="-1.554,-0.472"] 
"Astronaut Selection" [pos="-1.509,-0.473"] 
"Cochlear Changes" [pos="-1.528,-0.465"] 
"Crew Capability" [pos="-1.504,-0.466"] 
"Crew Health and Performance System" [pos="-
1.539,-0.443"] 
"Detect Hearing Changes" [pos="-1.517,-0.448"] 
"Detect Long Term Health Outcomes" [pos="-
1.504,-0.448"] 
"Detect Noise Levels" [pos="-1.523,-0.454"] 
"Detect Pressure Changes" [pos="-1.535,-0.450"] 
"Distance from Earth" [exposure,pos="-1.554,-
0.452"] 
"Effective Exposure Duration" [pos="-1.539,-
0.472"] 
"Environmental Conditions" [pos="-1.543,-0.452"] 
"Environmental Control" [pos="-1.532,-0.454"] 
"Environmental Monitoring Capability" [pos="-
1.537,-0.446"] 
"Fluid Shifts" [pos="-1.548,-0.470"] 
"HSIA (Risk)" [latent,pos="-1.552,-0.441"] 
"Hearing Countermeasures" [pos="-1.509,-0.453"] 
"Hostile Closed Environment" [exposure,pos="-
1.553,-0.458"] 
"Individual Factors" [pos="-1.517,-0.470"] 
"Individual Readiness" [pos="-1.505,-0.462"] 
"Inflight Hearing Exams" [pos="-1.520,-0.444"] 
"Intracochlear Pressure" [pos="-1.541,-0.467"] 
"Long Term Health Outcomes" [outcome,pos="-
1.502,-0.455"] 
"Loss of Mission Objectives" [outcome,pos="-
1.502,-0.474"] 
"Measurable Hearing Shift" [pos="-1.517,-0.459"] 
"Medical (Risk)" [latent,pos="-1.509,-0.459"] 
"Noise Exposure" [pos="-1.545,-0.457"] 
"Pharm (Risk)" [latent,pos="-1.550,-0.461"] 
"Preflight Hearing Status" [pos="-1.527,-0.448"] 
"Sudden Sensorineural Loss" [pos="-1.522,-
0.468"] 
"Suit Design" [pos="-1.545,-0.447"] 
"Task Performance" [outcome,pos="-1.503,-
0.469"] 
"Tox (Risk)" [latent,pos="-1.549,-0.465"] 
"Vehicle Design" [pos="-1.552,-0.447"] 
Barotrauma [pos="-1.528,-0.458"] 
Ototoxins [pos="-1.539,-0.462"] 
Surveillance [pos="-1.508,-0.443"] 
"Altered Gravity" -> "Fluid Shifts" 
"Astronaut Selection" -> "Individual Factors" 

"Cochlear Changes" -> "Measurable Hearing Shift" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Environmental Monitoring Capability" 
"Crew Health and Performance System" -> 
"Hearing Countermeasures" 
"Crew Health and Performance System" -> 
"Inflight Hearing Exams" 
"Detect Hearing Changes" -> "Hearing 
Countermeasures" 
"Detect Noise Levels" -> "Hearing 
Countermeasures" 
"Detect Pressure Changes" -> "Environmental 
Control" 
"Distance from Earth" -> "Vehicle Design" 
"Effective Exposure Duration" -> "Cochlear 
Changes" 
"Environmental Conditions" -> "Detect Pressure 
Changes" 
"Environmental Conditions" -> Barotrauma 
"Environmental Control" -> Barotrauma 
"Environmental Monitoring Capability" -> "Detect 
Noise Levels" 
"Environmental Monitoring Capability" -> "Detect 
Pressure Changes" 
"Fluid Shifts" -> "Intracochlear Pressure" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hearing Countermeasures" -> "Individual 
Readiness" 
"Hostile Closed Environment" -> "Noise Exposure" 
"Individual Factors" -> "Measurable Hearing Shift" 
"Individual Factors" -> "Sudden Sensorineural 
Loss" 
"Individual Readiness" -> "Crew Capability" 
"Inflight Hearing Exams" -> "Detect Hearing 
Changes" 
"Intracochlear Pressure" -> "Cochlear Changes" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Measurable Hearing Shift" -> "Detect Hearing 
Changes" 
"Measurable Hearing Shift" -> "Individual 
Readiness" 
"Measurable Hearing Shift" -> "Long Term Health 
Outcomes" 
"Measurable Hearing Shift" -> "Medical (Risk)" 
"Medical (Risk)" -> "Individual Readiness" 
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"Medical (Risk)" -> "Long Term Health Outcomes" 
"Noise Exposure" -> "Cochlear Changes" 
"Noise Exposure" -> "Detect Noise Levels" 
"Noise Exposure" -> "Task Performance" 
"Pharm (Risk)" -> Ototoxins 
"Preflight Hearing Status" -> "Detect Hearing 
Changes" 
"Sudden Sensorineural Loss" -> "Cochlear 
Changes" 
"Suit Design" -> "Environmental Conditions" 
"Task Performance" -> "Loss of Mission 
Objectives" 

"Tox (Risk)" -> Ototoxins 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Environmental Conditions" 
"Vehicle Design" -> "Noise Exposure" 
Barotrauma -> "Cochlear Changes" 
Barotrauma -> "Measurable Hearing Shift" 
Ototoxins -> "Cochlear Changes" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Behavioral Risk Narrative  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Astronaut Selection" [pos="-0.239,0.215"] 
"BHP Family Services" [pos="-0.036,-0.353"] 
"BHP Intervention Capability" [pos="0.284,0.399"] 
"BHP Monitoring Capability" [pos="0.151,0.259"] 
"BHP Prevention Capability" [pos="0.049,0.173"] 
"Central Nervous System Changes" [pos="-0.042,-
0.109"] 
"Cognitive Function" [pos="0.118,0.015"] 
"Communication Factors" [pos="-0.224,0.418"] 
"Crew Capability" [pos="0.295,-0.216"] 
"Crew Composition" [pos="-0.253,-0.450"] 
"Crew Health and Performance System" [pos="-
0.076,0.296"] 
"Detect BHP Changes" [pos="0.198,0.128"] 
"Detect Long Term Health Outcomes" 
[pos="0.392,0.217"] 
"Distance from Earth" [exposure,pos="-
0.435,0.334"] 
"Family/World Events" [pos="0.108,-0.434"] 
"Ground Support" [pos="0.010,0.413"] 
"HSIA (Risk)" [latent,pos="-0.354,0.416"] 
"Individual Factors" [pos="-0.068,0.123"] 
"Individual Readiness" [pos="0.226,-0.169"] 
"Isolation and Confinement" [exposure,pos="-
0.414,-0.239"] 
"Long Term Health Outcomes" 
[outcome,pos="0.389,0.100"] 
"Loss of Crew Life" [outcome,pos="0.429,-0.055"] 
"Loss of Mission Objectives" 
[outcome,pos="0.366,-0.431"] 
"Loss of Mission" [outcome,pos="0.450,-0.460"] 
"Other Risks" [latent,pos="-0.273,-0.117"] 
"Oxidative Stress" [pos="-0.339,0.119"] 
"Psychological Status" [pos="0.109,-0.271"] 
"Social Dynamics" [pos="-0.090,-0.453"] 
"Standards/Requirements" [pos="-0.396,0.217"] 
"Task Performance" [outcome,pos="0.337,-
0.302"] 
"Team (Risk)" [latent,pos="0.220,-0.367"] 
"Vehicle Design" [pos="-0.225,0.329"] 
Evacuation [outcome,pos="0.428,-0.275"] 
Exercise [pos="-0.205,-0.023"] 
Inflammation [pos="-0.239,0.116"] 
Radiation [exposure,pos="-0.450,0.119"] 
Surveillance [pos="0.413,0.380"] 
Training [pos="-0.369,-0.104"] 
Workload [pos="-0.174,-0.302"] 
"Astronaut Selection" -> "Individual Factors" 

"BHP Family Services" -> "Psychological Status" 
"BHP Intervention Capability" -> "Individual 
Readiness" 
"BHP Monitoring Capability" -> "Detect BHP 
Changes" 
"BHP Prevention Capability" -> "Cognitive 
Function" 
"BHP Prevention Capability" -> "Psychological 
Status" 
"Central Nervous System Changes" -> "Cognitive 
Function" 
"Central Nervous System Changes" -> "Long Term 
Health Outcomes" 
"Central Nervous System Changes" -> 
"Psychological Status" 
"Cognitive Function" -> "Detect BHP Changes" 
"Cognitive Function" -> "Individual Readiness" 
"Cognitive Function" -> "Team (Risk)" 
"Communication Factors" -> "Ground Support" 
"Crew Capability" -> "Task Performance" 
"Crew Composition" -> "Social Dynamics" 
"Crew Health and Performance System" -> "BHP 
Intervention Capability" 
"Crew Health and Performance System" -> "BHP 
Monitoring Capability" 
"Crew Health and Performance System" -> "BHP 
Prevention Capability" 
"Crew Health and Performance System" -> 
Exercise 
"Detect BHP Changes" -> "BHP Intervention 
Capability" 
"Distance from Earth" -> "Communication 
Factors" 
"Distance from Earth" -> "Vehicle Design" 
"Family/World Events" -> "Psychological Status" 
"Ground Support" -> "BHP Family Services" 
"Ground Support" -> "BHP Intervention 
Capability" 
"Ground Support" -> "BHP Monitoring Capability" 
"Ground Support" -> "BHP Prevention Capability" 
"HSIA (Risk)" -> "Standards/Requirements" 
"HSIA (Risk)" -> "Vehicle Design" 
"Individual Factors" -> "Central Nervous System 
Changes" 
"Individual Factors" -> "Cognitive Function" 
"Individual Factors" -> "Psychological Status" 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> "Central Nervous 
System Changes" 
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"Isolation and Confinement" -> "Psychological 
Status" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Other Risks" -> "Central Nervous System 
Changes" 
"Other Risks" -> "Cognitive Function" 
"Other Risks" -> "Psychological Status" 
"Oxidative Stress" -> Inflammation 
"Psychological Status" -> "Detect BHP Changes" 
"Psychological Status" -> "Individual Readiness" 
"Psychological Status" -> "Long Term Health 
Outcomes" 
"Psychological Status" -> "Team (Risk)" 
"Social Dynamics" -> "Psychological Status" 
"Standards/Requirements" -> "Astronaut 
Selection" 
"Standards/Requirements" -> "Vehicle Design" 
"Task Performance" -> "Loss of Crew Life" 

"Task Performance" -> "Loss of Mission 
Objectives" 
"Task Performance" -> Evacuation 
"Team (Risk)" -> "Individual Readiness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
Evacuation -> "Loss of Mission Objectives" 
Exercise -> "Cognitive Function" 
Exercise -> "Psychological Status" 
Inflammation -> "Central Nervous System 
Changes" 
Radiation -> "Oxidative Stress" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Training -> "Individual Factors" 
Training -> "Social Dynamics" 
Workload -> "Cognitive Function" 
Workload -> "Psychological Status" 
} 
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Bone Fracture Risk  
dag { 
bb="0,0,1,1" 
"Altered Gravity" [exposure,pos="0.054,0.304"] 
"Astronaut Selection" [pos="0.052,0.743"] 
"Bone Density" [pos="0.371,0.551"] 
"Bone Formation" [pos="0.219,0.690"] 
"Bone Fracture" [pos="0.679,0.368"] 
"Bone Resorption" [pos="0.221,0.517"] 
"Bone Structure" [pos="0.366,0.740"] 
"Cartilage Defect" [pos="0.368,0.898"] 
"Chondrocyte Metabolism" [pos="0.185,0.895"] 
"Crew Capability" [pos="0.761,0.214"] 
"Crew Health and Performance System" 
[pos="0.449,0.044"] 
"DCS (Risk)" [latent,pos="0.699,0.875"] 
"Detect Bone Density Changes" 
[pos="0.558,0.480"] 
"Detect Bone Structure Changes" 
[pos="0.535,0.752"] 
"Detect Long Term Health Outcomes" 
[pos="0.881,0.837"] 
"Distance from Earth" 
[exposure,pos="0.054,0.159"] 
"Dynamic Loads (Risk)" [latent,pos="0.465,0.116"] 
"Endocrine Factors" [pos="0.050,0.532"] 
"Flight Recertification" 
[outcome,pos="0.918,0.553"] 
"Food and Nutrition (Risk)" 
[latent,pos="0.158,0.387"] 
"HSIA (Risk)" [latent,pos="0.124,0.039"] 
"Individual Factors" [pos="0.108,0.646"] 
"Individual Readiness" [pos="0.722,0.298"] 
"Long Term Health Clinical Decisions" 
[pos="0.729,0.754"] 
"Long Term Health Outcomes" 
[outcome,pos="0.901,0.672"] 
"Loss of Crew Life" [outcome,pos="0.919,0.446"] 
"Loss of Mission Objectives" 
[outcome,pos="0.827,0.057"] 
"Loss of Mission" [outcome,pos="0.944,0.055"] 
"Medical Treatment Capability" 
[pos="0.676,0.041"] 
"Muscle (Risk)" [latent,pos="0.398,0.294"] 
"Musculoskeletal Loads" [pos="0.338,0.409"] 
"Pharm (Risk)" [latent,pos="0.142,0.791"] 
"Resistive Exercise" [pos="0.222,0.301"] 
"Sensorimotor, Aerobic (Risks)" 
[latent,pos="0.425,0.205"] 
"Skeletal Fragility" [pos="0.730,0.563"] 
"Suit Design" [pos="0.221,0.166"] 

"Task Performance" [outcome,pos="0.775,0.151"] 
"Vehicle Design" [pos="0.276,0.038"] 
DXA [pos="0.469,0.425"] 
Evacuation [outcome,pos="0.840,0.364"] 
MRI [pos="0.464,0.827"] 
Osteoarthritis [pos="0.617,0.896"] 
QCT [pos="0.470,0.602"] 
Radiation [exposure,pos="0.050,0.889"] 
Surveillance [pos="0.759,0.932"] 
Ultrasound [pos="0.653,0.183"] 
"Altered Gravity" -> "Chondrocyte Metabolism" 
"Altered Gravity" -> "Musculoskeletal Loads" 
"Astronaut Selection" -> "Individual Factors" 
"Bone Density" -> "Detect Bone Density Changes" 
"Bone Density" -> "Skeletal Fragility" 
"Bone Formation" -> "Bone Density" 
"Bone Formation" -> "Bone Structure" 
"Bone Fracture" -> "Individual Readiness" 
"Bone Fracture" -> "Long Term Health Outcomes" 
"Bone Fracture" -> Evacuation 
"Bone Fracture" -> Osteoarthritis 
"Bone Resorption" -> "Bone Density" 
"Bone Resorption" -> "Bone Structure" 
"Bone Structure" -> "Detect Bone Structure 
Changes" 
"Bone Structure" -> "Long Term Health 
Outcomes" 
"Bone Structure" -> "Skeletal Fragility" 
"Cartilage Defect" -> Osteoarthritis 
"Chondrocyte Metabolism" -> "Cartilage Defect" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
"Resistive Exercise" 
"Crew Health and Performance System" -> 
Ultrasound 
"DCS (Risk)" -> "Long Term Health Outcomes" 
"Detect Bone Density Changes" -> "Detect Long 
Term Health Outcomes" 
"Detect Bone Density Changes" -> "Flight 
Recertification" 
"Detect Bone Density Changes" -> "Long Term 
Health Clinical Decisions" 
"Detect Bone Structure Changes" -> "Detect Long 
Term Health Outcomes" 
"Detect Bone Structure Changes" -> "Long Term 
Health Clinical Decisions" 
"Distance from Earth" -> "Vehicle Design" 
"Dynamic Loads (Risk)" -> "Bone Fracture" 
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"Endocrine Factors" -> "Bone Formation" 
"Endocrine Factors" -> "Bone Resorption" 
"Food and Nutrition (Risk)" -> "Bone Resorption" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Individual Factors" -> "Bone Formation" 
"Individual Factors" -> "Bone Resorption" 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Clinical Decisions" -> "Long 
Term Health Outcomes" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Muscle (Risk)" -> "Bone Fracture" 
"Muscle (Risk)" -> "Musculoskeletal Loads" 
"Musculoskeletal Loads" -> "Bone Formation" 
"Musculoskeletal Loads" -> "Bone Fracture" 
"Musculoskeletal Loads" -> "Bone Resorption" 
"Pharm (Risk)" -> "Bone Formation" 
"Pharm (Risk)" -> "Bone Resorption" 
"Resistive Exercise" -> "Muscle (Risk)" 
"Resistive Exercise" -> "Musculoskeletal Loads" 
"Sensorimotor, Aerobic (Risks)" -> "Bone Fracture" 
"Skeletal Fragility" -> "Bone Fracture" 
"Skeletal Fragility" -> "Long Term Health 
Outcomes" 
"Suit Design" -> "Bone Fracture" 
"Suit Design" -> "Dynamic Loads (Risk)" 
"Task Performance" -> "Loss of Crew Life" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Bone Fracture" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Dynamic Loads (Risk)" 
DXA -> "Detect Bone Density Changes" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
MRI -> "Detect Bone Structure Changes" 
Osteoarthritis -> "Individual Readiness" 
Osteoarthritis -> "Long Term Health Outcomes" 
QCT -> "Detect Bone Density Changes" 
QCT -> "Detect Bone Structure Changes" 
Radiation -> "Bone Resorption" 
Radiation -> "Chondrocyte Metabolism" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Ultrasound -> "Detect Bone Structure Changes" 
} 
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Cardiovascular Risk  
 
dag { 
"Aerobic (Risk)" [latent,pos="-1.237,-3.915"] 
"Altered Gravity" [exposure,pos="-1.242,-1.448"] 
"Astronaut Selection" [pos="-1.242,-2.613"] 
"Cardiac Structure/Function" [pos="-1.239,-
2.226"] 
"Crew Capability" [pos="-1.236,-3.025"] 
"Crew Health and Performance System" [pos="-
1.240,-3.728"] 
"Detect CV Events" [pos="-1.238,-2.468"] 
"Detect Long Term Health Outcomes" [pos="-
1.236,-0.384"] 
"Distance from Earth" [exposure,pos="-1.242,-
4.223"] 
"Endocrine Factors" [pos="-1.241,-1.952"] 
"Environmental Conditions" [pos="-1.238,-0.082"] 
"Flight Recertification" [outcome,pos="-1.235,-
1.394"] 
"Fluid Shifts" [pos="-1.241,-1.621"] 
"Food and Nutrition, Immune, Sleep (Risks)" 
[latent,pos="-1.241,-0.594"] 
"HSIA (Risk)" [latent,pos="-1.242,-3.207"] 
"Hostile Closed Environment" [exposure,pos="-
1.242,-0.026"] 
"Individual Factors" [pos="-1.241,-2.441"] 
"Individual Readiness" [pos="-1.237,-3.520"] 
"Intravascular Volume" [pos="-1.240,-2.090"] 
"Long Term Health Outcomes" [outcome,pos="-
1.235,-0.944"] 
"Loss of Crew Life" [outcome,pos="-1.235,-1.803"] 
"Loss of Mission Objectives" [outcome,pos="-
1.236,-3.619"] 
"Loss of Mission" [outcome,pos="-1.235,-4.213"] 
"Medical Illness" [pos="-1.238,-1.739"] 
"Medical Monitoring Capability" [pos="-1.239,-
3.566"] 
"Medical Prevention Capability" [pos="-1.239,-
3.123"] 
"Medical Treatment Capability" [pos="-1.238,-
3.936"] 
"Organ Perfusion" [pos="-1.237,-1.739"] 
"Orthostatic Intolerance Countermeasures" 
[pos="-1.240,-2.889"] 
"Orthostatic Intolerance" [pos="-1.238,-0.708"] 
"Oxidative Stress" [pos="-1.240,-1.196"] 
"Pharm (Risk)" [latent,pos="-1.239,-4.059"] 
"Pre-syncope/Syncope" [pos="-1.237,-2.478"] 
"Suit Design" [pos="-1.241,-2.813"] 

"Task Performance" [outcome,pos="-1.236,-
2.673"] 
"Tox (Risk)" [latent,pos="-1.238,-1.314"] 
"Vascular Structure/Function" [pos="-1.239,-
1.234"] 
"Vehicle Design" [pos="-1.241,-3.910"] 
Evacuation [outcome,pos="-1.236,-2.144"] 
Exercise [pos="-1.241,-3.161"] 
Inflammation [pos="-1.240,-0.559"] 
Radiation [exposure,pos="-1.242,-0.969"] 
Surveillance [pos="-1.237,0.102"] 
"Aerobic (Risk)" -> "Individual Readiness" 
"Altered Gravity" -> "Endocrine Factors" 
"Altered Gravity" -> "Fluid Shifts" 
"Altered Gravity" -> "Oxidative Stress" 
"Altered Gravity" -> Inflammation 
"Astronaut Selection" -> "Individual Factors" 
"Cardiac Structure/Function" -> "Aerobic (Risk)" 
"Cardiac Structure/Function" -> "Medical Illness" 
"Cardiac Structure/Function" -> "Orthostatic 
Intolerance" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Monitoring Capability" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
Exercise 
"Detect CV Events" -> "Medical Treatment 
Capability" 
"Distance from Earth" -> "Vehicle Design" 
"Endocrine Factors" -> "Fluid Shifts" 
"Endocrine Factors" -> "Orthostatic Intolerance" 
"Environmental Conditions" -> "Orthostatic 
Intolerance" 
"Fluid Shifts" -> "Cardiac Structure/Function" 
"Fluid Shifts" -> "Intravascular Volume" 
"Fluid Shifts" -> "Oxidative Stress" 
"Fluid Shifts" -> "Vascular Structure/Function" 
"Fluid Shifts" -> Inflammation 
"Food and Nutrition, Immune, Sleep (Risks)" -> 
"Oxidative Stress" 
"Food and Nutrition, Immune, Sleep (Risks)" -> 
Inflammation 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Suit Design" 
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"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Orthostatic 
Intolerance" 
"Individual Factors" -> "Cardiac 
Structure/Function" 
"Individual Factors" -> "Endocrine Factors" 
"Individual Factors" -> "Fluid Shifts" 
"Individual Factors" -> "Oxidative Stress" 
"Individual Factors" -> "Vascular 
Structure/Function" 
"Individual Factors" -> Inflammation 
"Individual Readiness" -> "Crew Capability" 
"Intravascular Volume" -> "Cardiac 
Structure/Function" 
"Intravascular Volume" -> "Orthostatic 
Intolerance" 
"Intravascular Volume" -> "Vascular 
Structure/Function" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Illness" -> "Detect CV Events" 
"Medical Illness" -> "Flight Recertification" 
"Medical Illness" -> "Long Term Health Outcomes" 
"Medical Illness" -> "Organ Perfusion" 
"Medical Monitoring Capability" -> "Detect CV 
Events" 
"Medical Prevention Capability" -> "Intravascular 
Volume" 
"Medical Prevention Capability" -> "Medical 
Illness" 
"Medical Prevention Capability" -> "Orthostatic 
Intolerance Countermeasures" 
"Medical Treatment Capability" -> "Organ 
Perfusion" 
"Organ Perfusion" -> "Loss of Crew Life" 
"Organ Perfusion" -> "Pre-syncope/Syncope" 
"Organ Perfusion" -> Evacuation 

"Orthostatic Intolerance Countermeasures" -> 
"Orthostatic Intolerance" 
"Orthostatic Intolerance" -> "Organ Perfusion" 
"Oxidative Stress" -> "Cardiac Structure/Function" 
"Oxidative Stress" -> "Vascular 
Structure/Function" 
"Oxidative Stress" -> Inflammation 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Pre-syncope/Syncope" -> "Individual Readiness" 
"Suit Design" -> "Orthostatic Intolerance 
Countermeasures" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Tox (Risk)" -> "Medical Illness" 
"Vascular Structure/Function" -> "Aerobic (Risk)" 
"Vascular Structure/Function" -> "Medical Illness" 
"Vascular Structure/Function" -> "Orthostatic 
Intolerance" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Orthostatic Intolerance 
Countermeasures" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Exercise -> "Cardiac Structure/Function" 
Exercise -> "Intravascular Volume" 
Exercise -> "Oxidative Stress" 
Exercise -> "Vascular Structure/Function" 
Exercise -> Inflammation 
Inflammation -> "Cardiac Structure/Function" 
Inflammation -> "Vascular Structure/Function" 
Radiation -> "Oxidative Stress" 
Radiation -> Inflammation 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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CO2 Risk  
 
dag { 
"Altered Gravity" [exposure,pos="-1.658,-1.415"] 
"Ambient CO2 Level" [pos="-1.329,-1.093"] 
"Atmospheric Mixing" [pos="-1.526,-1.073"] 
"Behavioral (Risk)" [latent,pos="-1.088,-1.390"] 
"Bone Fracture (Risk)" [latent,pos="-1.012,-
0.910"] 
"CO2 Physiologic Changes" [pos="-1.128,-1.166"] 
"CO2 Production" [pos="-1.518,-1.217"] 
"CO2 Removal" [pos="-1.495,-0.999"] 
"Crew Capability" [pos="-0.845,-1.303"] 
"Crew Health and Performance System" [pos="-
1.426,-0.859"] 
"Crew Size" [pos="-1.543,-1.326"] 
"Detect CO2 Level" [pos="-1.174,-0.937"] 
"Distance from Earth" [exposure,pos="-1.683,-
0.928"] 
"ECLS System" [pos="-1.426,-0.779"] 
"Effective Exposure Duration" [pos="-1.275,-
1.299"] 
"Environmental Control" [pos="-1.160,-1.063"] 
"Environmental Monitoring Capability" [pos="-
1.180,-0.775"] 
"Food and Nutrition (Risk)" [latent,pos="-1.649,-
1.216"] 
"HSIA (Risk)" [latent,pos="-1.696,-0.764"] 
"Hostile Closed Environment" [exposure,pos="-
1.641,-1.126"] 
"Hypoxia (Risk)" [latent,pos="-1.327,-1.190"] 
"Individual Factors" [pos="-1.270,-1.390"] 
"Individual Readiness" [pos="-0.933,-1.235"] 
"Loss of Crew Life" [outcome,pos="-0.633,-0.955"] 
"Loss of Mission Objectives" [outcome,pos="-
0.686,-1.438"] 
"Loss of Mission" [outcome,pos="-0.628,-1.497"] 
"Mechanical Systems" [pos="-1.649,-0.998"] 
"Medical (Risk)" [latent,pos="-0.835,-0.919"] 
"Net Habitable Volume" [pos="-1.374,-0.961"] 
"Pharm (Risk)" [latent,pos="-1.669,-1.292"] 
"Renal Stone (Risk)" [latent,pos="-1.013,-0.992"] 
"SANS (Risk)" [latent,pos="-1.014,-0.830"] 
"Sleep (Risk)" [latent,pos="-1.084,-1.283"] 
"Suit Design" [pos="-1.570,-0.766"] 
"Task Performance" [outcome,pos="-0.761,-
1.367"] 
"Team (Risk)" [latent,pos="-0.932,-1.392"] 
"Vehicle Design" [pos="-1.677,-0.843"] 
Evacuation [outcome,pos="-0.714,-1.155"] 
Exercise [pos="-1.472,-1.135"] 

"Altered Gravity" -> "Atmospheric Mixing" 
"Altered Gravity" -> "CO2 Physiologic Changes" 
"Ambient CO2 Level" -> "CO2 Physiologic 
Changes" 
"Ambient CO2 Level" -> "Detect CO2 Level" 
"Ambient CO2 Level" -> "Hypoxia (Risk)" 
"Atmospheric Mixing" -> "Ambient CO2 Level" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"Bone Fracture (Risk)" -> "Medical (Risk)" 
"CO2 Physiologic Changes" -> "Behavioral (Risk)" 
"CO2 Physiologic Changes" -> "Bone Fracture 
(Risk)" 
"CO2 Physiologic Changes" -> "Individual 
Readiness" 
"CO2 Physiologic Changes" -> "Loss of Crew Life" 
"CO2 Physiologic Changes" -> "Medical (Risk)" 
"CO2 Physiologic Changes" -> "Renal Stone (Risk)" 
"CO2 Physiologic Changes" -> "SANS (Risk)" 
"CO2 Physiologic Changes" -> "Sleep (Risk)" 
"CO2 Physiologic Changes" -> Evacuation 
"CO2 Production" -> "Ambient CO2 Level" 
"CO2 Removal" -> "Ambient CO2 Level" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Detect CO2 Level" 
"Crew Health and Performance System" -> 
Exercise 
"Crew Size" -> "CO2 Production" 
"Detect CO2 Level" -> "Environmental Control" 
"Distance from Earth" -> "Vehicle Design" 
"ECLS System" -> "Environmental Control" 
"ECLS System" -> "Environmental Monitoring 
Capability" 
"ECLS System" -> "Mechanical Systems" 
"Effective Exposure Duration" -> "CO2 Physiologic 
Changes" 
"Environmental Control" -> "CO2 Physiologic 
Changes" 
"Environmental Monitoring Capability" -> "Crew 
Health and Performance System" 
"Environmental Monitoring Capability" -> "Detect 
CO2 Level" 
"Food and Nutrition (Risk)" -> "CO2 Production" 
"HSIA (Risk)" -> "Net Habitable Volume" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "CO2 Production" 
"Hostile Closed Environment" -> "CO2 Removal" 
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"Hypoxia (Risk)" -> "CO2 Physiologic Changes" 
"Individual Factors" -> "Behavioral (Risk)" 
"Individual Factors" -> "CO2 Physiologic Changes" 
"Individual Factors" -> "CO2 Production" 
"Individual Readiness" -> "Crew Capability" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Mechanical Systems" -> "Atmospheric Mixing" 
"Mechanical Systems" -> "CO2 Removal" 
"Medical (Risk)" -> "Behavioral (Risk)" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Medical (Risk)" -> Evacuation 
"Net Habitable Volume" -> "Ambient CO2 Level" 
"Pharm (Risk)" -> "CO2 Production" 
"Renal Stone (Risk)" -> "Medical (Risk)" 

"SANS (Risk)" -> "Medical (Risk)" 
"Sleep (Risk)" -> "Behavioral (Risk)" 
"Sleep (Risk)" -> "Individual Readiness" 
"Suit Design" -> "Mechanical Systems" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Crew Capability" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "ECLS System" 
"Vehicle Design" -> "Net Habitable Volume" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Exercise -> "CO2 Production" 
} 
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Crew Egress Risk  
 
dag { 
"Aerobic (Risk)" [latent,pos="-0.691,-1.683"] 
"Altered Gravity" [exposure,pos="-1.768,-2.448"] 
"Bone Fracture (Risk)" [latent,pos="-0.672,-
0.267"] 
"Cardiovascular (Risk)" [latent,pos="-0.684,-
1.218"] 
"Crew Capability" [pos="0.167,-1.917"] 
"Crew Health and Performance System" [pos="-
0.286,1.146"] 
"Crew Vehicle Integration" [pos="-1.137,0.880"] 
"Detect Long Term Health Outcomes" 
[pos="0.976,1.320"] 
"Distance from Earth" [exposure,pos="-1.763,-
0.081"] 
"Dynamic Loads (Risk)" [latent,pos="-
0.628,0.335"] 
"Effective Exposure Duration" [pos="-1.437,-
1.386"] 
"Effective Gravity Level" [pos="-1.368,-1.889"] 
"Environmental Injury" [pos="0.137,-0.341"] 
"Fall Height" [pos="-1.245,0.041"] 
"Flight Recertification" 
[outcome,pos="1.080,0.132"] 
"Ground Support" [pos="0.603,1.175"] 
"HSIA (Risk)" [latent,pos="-1.647,1.660"] 
"Hostile Closed Environment" [exposure,pos="-
1.726,-1.336"] 
"Hypoxia, DCS (Risks)" [latent,pos="-0.591,0.880"] 
"Individual Readiness" [pos="-0.114,-1.706"] 
"Landing Profile" [pos="-1.230,0.481"] 
"Landing Site Environment" [pos="-1.494,-0.400"] 
"Long Term Health Outcomes" 
[outcome,pos="1.042,0.677"] 
"Loss of Crew Life" [outcome,pos="1.127,-0.525"] 
"Loss of Mission Objectives" 
[outcome,pos="0.927,-2.324"] 
"Loss of Mission" [outcome,pos="1.121,-2.674"] 
"Medical Prevention Capability" [pos="-
0.150,0.742"] 
"Medical Treatment Capability" 
[pos="0.374,0.519"] 
"Motion Sickness" [pos="-0.272,-0.426"] 
"Muscle (Risk)" [latent,pos="-0.635,-2.199"] 
"Operations Design" [pos="0.148,1.517"] 
"Organ Perfusion" [pos="-0.199,-1.142"] 
"Post-Landing Task Performance" [pos="0.585,-
2.028"] 
"Procedure Design" [pos="0.399,1.353"] 

"Sensorimotor (Risk)" [latent,pos="-0.684,-0.756"] 
"Suit Design" [pos="-0.933,1.724"] 
"Team (Risk)" [latent,pos="-0.110,-2.396"] 
"Thermal Environment" [pos="-1.147,-0.910"] 
"Traumatic Injury" [pos="0.008,0.210"] 
"Vehicle Design" [pos="-1.717,1.172"] 
Aspiration [pos="0.235,-0.945"] 
Evacuation [pos="0.932,-1.021"] 
Surveillance [pos="0.693,1.779"] 
Vomit [pos="0.003,-0.709"] 
"Aerobic (Risk)" -> "Individual Readiness" 
"Altered Gravity" -> "Effective Gravity Level" 
"Bone Fracture (Risk)" -> "Traumatic Injury" 
"Cardiovascular (Risk)" -> "Aerobic (Risk)" 
"Cardiovascular (Risk)" -> "Individual Readiness" 
"Cardiovascular (Risk)" -> "Organ Perfusion" 
"Crew Capability" -> "Post-Landing Task 
Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Vehicle Integration" -> "Post-Landing Task 
Performance" 
"Distance from Earth" -> "Effective Exposure 
Duration" 
"Distance from Earth" -> "Suit Design" 
"Distance from Earth" -> "Vehicle Design" 
"Dynamic Loads (Risk)" -> "Bone Fracture (Risk)" 
"Dynamic Loads (Risk)" -> "Traumatic Injury" 
"Effective Exposure Duration" -> "Effective Gravity 
Level" 
"Effective Gravity Level" -> "Aerobic (Risk)" 
"Effective Gravity Level" -> "Bone Fracture (Risk)" 
"Effective Gravity Level" -> "Cardiovascular (Risk)" 
"Effective Gravity Level" -> "Muscle (Risk)" 
"Effective Gravity Level" -> "Sensorimotor (Risk)" 
"Environmental Injury" -> "Individual Readiness" 
"Fall Height" -> "Bone Fracture (Risk)" 
"Fall Height" -> "Traumatic Injury" 
"Ground Support" -> "Medical Treatment 
Capability" 
"Ground Support" -> "Post-Landing Task 
Performance" 
"HSIA (Risk)" -> "Crew Vehicle Integration" 
"HSIA (Risk)" -> "Operations Design" 
"HSIA (Risk)" -> "Procedure Design" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
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"Hostile Closed Environment" -> "Dynamic Loads 
(Risk)" 
"Hostile Closed Environment" -> "Landing Profile" 
"Hostile Closed Environment" -> "Landing Site 
Environment" 
"Hypoxia, DCS (Risks)" -> "Environmental Injury" 
"Individual Readiness" -> "Crew Capability" 
"Individual Readiness" -> Evacuation 
"Landing Profile" -> "Dynamic Loads (Risk)" 
"Landing Site Environment" -> "Ground Support" 
"Landing Site Environment" -> "Sensorimotor 
(Risk)" 
"Landing Site Environment" -> "Thermal 
Environment" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Prevention Capability" -> "Motion 
Sickness" 
"Medical Prevention Capability" -> "Organ 
Perfusion" 
"Medical Treatment Capability" -> "Flight 
Recertification" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Long Term 
Health Outcomes" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Motion Sickness" -> Vomit 
"Muscle (Risk)" -> "Individual Readiness" 
"Muscle (Risk)" -> "Traumatic Injury" 
"Operations Design" -> "Post-Landing Task 
Performance" 
"Organ Perfusion" -> Vomit 
"Post-Landing Task Performance" -> "Loss of 
Mission Objectives" 

"Procedure Design" -> "Post-Landing Task 
Performance" 
"Sensorimotor (Risk)" -> "Individual Readiness" 
"Sensorimotor (Risk)" -> "Motion Sickness" 
"Sensorimotor (Risk)" -> "Traumatic Injury" 
"Suit Design" -> "Bone Fracture (Risk)" 
"Suit Design" -> "Crew Vehicle Integration" 
"Suit Design" -> "Dynamic Loads (Risk)" 
"Suit Design" -> "Hypoxia, DCS (Risks)" 
"Suit Design" -> "Thermal Environment" 
"Team (Risk)" -> "Crew Capability" 
"Thermal Environment" -> "Cardiovascular (Risk)" 
"Traumatic Injury" -> "Flight Recertification" 
"Traumatic Injury" -> "Individual Readiness" 
"Traumatic Injury" -> "Long Term Health 
Outcomes" 
"Traumatic Injury" -> "Loss of Crew Life" 
"Traumatic Injury" -> Evacuation 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Crew Vehicle Integration" 
"Vehicle Design" -> "Dynamic Loads (Risk)" 
"Vehicle Design" -> "Fall Height" 
"Vehicle Design" -> "Hypoxia, DCS (Risks)" 
"Vehicle Design" -> "Landing Profile" 
"Vehicle Design" -> "Landing Site Environment" 
"Vehicle Design" -> "Thermal Environment" 
Aspiration -> "Individual Readiness" 
Aspiration -> "Loss of Crew Life" 
Aspiration -> Evacuation 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Vomit -> "Individual Readiness" 
Vomit -> Aspiration 
} 
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DCS Risk  
dag { 
"Airlock Design" [pos="-0.092,-1.722"] 
"Altered Gravity" [exposure,pos="-0.091,-3.232"] 
"Arterial Gas Embolism" [pos="0.014,-2.759"] 
"Astronaut Selection" [pos="-0.020,-5.338"] 
"Atmospheric Conditions" [pos="-0.073,-4.977"] 
"Crew Capability" [pos="0.010,-4.600"] 
"Crew Health and Performance System" [pos="-
0.064,1.500"] 
"DCS Type I" [pos="-0.022,-1.736"] 
"DCS Type II" [pos="-0.007,-1.745"] 
"Detect DCS" [pos="-0.022,-0.734"] 
"Detect Long Term Health Outcomes" 
[pos="0.042,0.221"] 
"Distance from Earth" [exposure,pos="-
0.095,0.079"] 
"EVA Operations" [pos="-0.065,-2.342"] 
"HSIA (Risk)" [latent,pos="-0.094,1.508"] 
"Hostile Closed Environment" [exposure,pos="-
0.088,-4.596"] 
"Individual Factors" [pos="-0.020,-3.983"] 
"Individual Readiness" [pos="-0.006,-4.784"] 
"Long Term Health Outcomes" 
[outcome,pos="0.046,-0.900"] 
"Loss of Crew Life" [outcome,pos="0.047,-2.465"] 
"Loss of EVA(s)" [outcome,pos="0.019,-0.369"] 
"Loss of Mission Objectives" 
[outcome,pos="0.045,-4.023"] 
"Loss of Mission" [outcome,pos="0.050,-4.935"] 
"Medical Diagnostic Capability" [pos="-0.034,-
0.146"] 
"Medical Treatment Capability" 
[pos="0.004,1.493"] 
"Suit Design" [pos="-0.067,-0.329"] 
"Suit Failure" [pos="-0.043,-2.846"] 
"Task Performance" [outcome,pos="0.026,-
4.466"] 
"Vehicle Design" [pos="-0.082,-0.582"] 
"Vehicle Failure" [pos="-0.065,-3.737"] 
Denitrogenation [pos="-0.047,-3.761"] 
Depressurization [pos="-0.033,-4.963"] 
Ebullism [pos="0.029,-3.487"] 
Surveillance [pos="0.037,1.368"] 
Workload [pos="-0.044,-1.963"] 
"Airlock Design" -> "EVA Operations" 
"Altered Gravity" -> "EVA Operations" 
"Altered Gravity" -> Denitrogenation 
"Arterial Gas Embolism" -> "Individual Readiness" 
"Arterial Gas Embolism" -> "Long Term Health 
Outcomes" 

"Arterial Gas Embolism" -> "Loss of Crew Life" 
"Arterial Gas Embolism" -> "Loss of EVA(s)" 
"Astronaut Selection" -> "Individual Factors" 
"Atmospheric Conditions" -> Denitrogenation 
"Atmospheric Conditions" -> Depressurization 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Diagnostic Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"DCS Type I" -> "DCS Type II" 
"DCS Type I" -> "Detect DCS" 
"DCS Type I" -> "Individual Readiness" 
"DCS Type I" -> "Loss of EVA(s)" 
"DCS Type II" -> "Individual Readiness" 
"DCS Type II" -> "Long Term Health Outcomes" 
"DCS Type II" -> "Loss of Crew Life" 
"DCS Type II" -> "Loss of EVA(s)" 
"Detect DCS" -> "Medical Treatment Capability" 
"Detect Long Term Health Outcomes" <-> "Long 
Term Health Outcomes" 
"Distance from Earth" -> "Vehicle Design" 
"EVA Operations" -> "Suit Failure" 
"EVA Operations" -> Workload 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Atmospheric 
Conditions" 
"Hostile Closed Environment" -> "EVA Operations" 
"Individual Factors" -> "DCS Type I" 
"Individual Factors" -> "DCS Type II" 
"Individual Readiness" -> "Crew Capability" 
"Individual Readiness" -> "Loss of EVA(s)" 
"Loss of EVA(s)" -> "Loss of Mission Objectives" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Diagnostic Capability" -> "Detect DCS" 
"Medical Treatment Capability" -> "DCS Type II" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Long Term 
Health Outcomes" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Medical Treatment Capability" -> "Loss of EVA(s)" 
"Suit Design" -> "Atmospheric Conditions" 
"Suit Design" -> "Medical Treatment Capability" 
"Suit Design" -> "Suit Failure" 
"Suit Design" -> Denitrogenation 
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"Suit Failure" -> Depressurization 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Airlock Design" 
"Vehicle Design" -> "Atmospheric Conditions" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Vehicle Failure" 
"Vehicle Failure" -> "Atmospheric Conditions" 
"Vehicle Failure" -> Depressurization 
Denitrogenation -> "DCS Type I" 

Denitrogenation -> "EVA Operations" 
Depressurization -> "Arterial Gas Embolism" 
Depressurization -> "DCS Type I" 
Depressurization -> "DCS Type II" 
Depressurization -> Ebullism 
Ebullism -> "Loss of Crew Life" 
Ebullism -> "Loss of EVA(s)" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Workload -> "DCS Type I" 
} 
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Dust Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.413,-0.450"] 
"Atmospheric Dust Level" [pos="-0.160,-0.215"] 
"Cabin Visibility" [pos="0.071,-0.474"] 
"Cardiovascular (Risk)" [latent,pos="0.055,-
0.361"] 
"Crew Capability" [pos="0.303,-0.313"] 
"Crew Health and Performance System" [pos="-
0.158,0.398"] 
"Detect Atmospheric Dust" [pos="-0.156,0.146"] 
"Detect Long Term Health Outcomes" 
[pos="0.404,0.310"] 
"Distance from Earth" [exposure,pos="-
0.438,0.290"] 
"Dust Monitor" [pos="-0.228,0.255"] 
"Dust Removal" [pos="-0.261,-0.041"] 
"Dust Source" [pos="-0.279,-0.352"] 
"Dust Suspension" [pos="-0.139,-0.454"] 
"ECLS System" [pos="-0.279,0.117"] 
"EVA Operations" [pos="-0.344,-0.277"] 
"Eye Injury" [pos="0.051,-0.189"] 
"Flight Recertification" 
[outcome,pos="0.441,0.009"] 
"HSIA (Risk)" [latent,pos="-0.401,0.416"] 
"Hostile Closed Environment" [exposure,pos="-
0.413,-0.157"] 
"Immune (Risk)" [latent,pos="0.053,-0.277"] 
"Individual Readiness" [pos="0.241,-0.278"] 
"Ingestion Toxicity" [pos="0.056,0.078"] 
"Long Term Health Outcomes" 
[outcome,pos="0.415,0.186"] 
"Loss of Crew Life" [outcome,pos="0.440,-0.113"] 
"Loss of Mission Objectives" 
[outcome,pos="0.391,-0.423"] 
"Loss of Mission" [outcome,pos="0.452,-0.452"] 
"Lung Injury" [pos="0.052,-0.102"] 
"Medical (Risk)" [latent,pos="0.188,-0.146"] 
"Medical Prevention Capability" 
[pos="0.202,0.140"] 
"Medical Treatment Capability" 
[pos="0.244,0.348"] 
"Pharm (Risk)" [latent,pos="0.106,0.416"] 
"Seals/Gaskets" [pos="-0.365,-0.002"] 
"Skin Irritation" [pos="0.053,-0.011"] 
"Suit Design" [pos="-0.395,0.178"] 
"Surface Dust Level" [pos="-0.098,-0.041"] 
"Task Performance" [outcome,pos="0.372,-
0.338"] 

"Vehicle Design" [pos="-0.311,0.366"] 
Cleaning [pos="-0.079,0.265"] 
Evacuation [outcome,pos="0.322,-0.197"] 
Surveillance [pos="0.385,0.430"] 
"Altered Gravity" -> "Dust Suspension" 
"Atmospheric Dust Level" -> "Cabin Visibility" 
"Atmospheric Dust Level" -> "Cardiovascular 
(Risk)" 
"Atmospheric Dust Level" -> "Detect Atmospheric 
Dust" 
"Atmospheric Dust Level" -> "Dust Suspension" 
"Atmospheric Dust Level" -> "Eye Injury" 
"Atmospheric Dust Level" -> "Immune (Risk)" 
"Atmospheric Dust Level" -> "Ingestion Toxicity" 
"Atmospheric Dust Level" -> "Lung Injury" 
"Atmospheric Dust Level" -> "Skin Irritation" 
"Atmospheric Dust Level" -> "Surface Dust Level" 
"Cabin Visibility" -> "Task Performance" 
"Cardiovascular (Risk)" -> "Medical (Risk)" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Detect Atmospheric Dust" -> "Detect Long Term 
Health Outcomes" 
"Detect Atmospheric Dust" -> "Dust Removal" 
"Detect Atmospheric Dust" -> "Medical 
Prevention Capability" 
"Detect Atmospheric Dust" -> Cleaning 
"Distance from Earth" -> "Suit Design" 
"Distance from Earth" -> "Vehicle Design" 
"Dust Monitor" -> "Detect Atmospheric Dust" 
"Dust Removal" -> "Atmospheric Dust Level" 
"Dust Source" -> "Atmospheric Dust Level" 
"Dust Suspension" -> "Cabin Visibility" 
"ECLS System" -> "Dust Removal" 
"EVA Operations" -> "Atmospheric Dust Level" 
"Eye Injury" -> "Medical (Risk)" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Atmospheric 
Dust Level" 
"Immune (Risk)" -> "Flight Recertification" 
"Immune (Risk)" -> "Medical (Risk)" 
"Individual Readiness" -> "Crew Capability" 
"Ingestion Toxicity" -> "Medical (Risk)" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
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"Loss of Mission Objectives" -> "Loss of Mission" 
"Lung Injury" -> "Medical (Risk)" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Long Term Health Outcomes" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Medical (Risk)" -> Evacuation 
"Medical Prevention Capability" -> "Eye Injury" 
"Medical Prevention Capability" -> "Ingestion 
Toxicity" 
"Medical Prevention Capability" -> "Lung Injury" 
"Medical Prevention Capability" -> "Skin Irritation" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Long Term 
Health Outcomes" 
"Medical Treatment Capability" -> "Medical (Risk)" 
"Medical Treatment Capability" -> Evacuation 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 

"Seals/Gaskets" -> "Atmospheric Dust Level" 
"Skin Irritation" -> "Medical (Risk)" 
"Suit Design" -> "Seals/Gaskets" 
"Surface Dust Level" -> "Immune (Risk)" 
"Surface Dust Level" -> "Ingestion Toxicity" 
"Surface Dust Level" -> "Skin Irritation" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Dust Monitor" 
"Vehicle Design" -> "ECLS System" 
"Vehicle Design" -> "Seals/Gaskets" 
"Vehicle Design" -> Cleaning 
Cleaning -> "Surface Dust Level" 
Evacuation -> "Loss of Crew Life" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Dynamic Loads Risk  
dag { 
bb="0,0,1,1" 
"Altered Gravity" [exposure,pos="0.070,0.118"] 
"Astronaut Selection" [pos="0.052,0.416"] 
"Body Posture" [pos="0.456,0.768"] 
"Bone Remodeling" [pos="0.300,0.572"] 
"Central Nervous System Changes" 
[pos="0.309,0.029"] 
"Connective Tissue Changes" [pos="0.307,0.329"] 
"Crew Capability" [pos="0.712,0.172"] 
"Crew Health and Performance System" 
[pos="0.439,0.893"] 
"Detect Long Term Health Outcomes" 
[pos="0.866,0.856"] 
"Distance from Earth" 
[exposure,pos="0.084,0.853"] 
"Flight Recertification" 
[outcome,pos="0.925,0.636"] 
"Hostile Closed Environment" 
[exposure,pos="0.090,0.666"] 
"Individual Factors" [pos="0.163,0.415"] 
"Individual Readiness" [pos="0.635,0.230"] 
"Long Term Health Outcomes" 
[outcome,pos="0.909,0.744"] 
"Loss of Crew Life" [outcome,pos="0.936,0.479"] 
"Loss of Mission Objectives" 
[outcome,pos="0.885,0.071"] 
"Loss of Mission" [outcome,pos="0.948,0.026"] 
"Medical Treatment Capability" 
[pos="0.636,0.893"] 
"Muscle Performance" [pos="0.307,0.243"] 
"Musculoskeletal Injury" [pos="0.534,0.505"] 
"Neuro/Ocular Injury" [pos="0.532,0.355"] 
"SANS (Risk)" [latent,pos="0.503,0.099"] 
"Sensorimotor (Risk)" [latent,pos="0.571,0.767"] 
"Suit Design" [pos="0.298,0.920"] 
"Task Performance" [outcome,pos="0.786,0.122"] 
"Vascular Structure/Function" 
[pos="0.307,0.145"] 
"Vehicle Design" [pos="0.298,0.805"] 
"Vehicle Dynamics" [pos="0.297,0.687"] 
Anthropometry [pos="0.306,0.423"] 
Evacuation [outcome,pos="0.823,0.371"] 
Surveillance [pos="0.758,0.914"] 
"Altered Gravity" -> "Bone Remodeling" 
"Altered Gravity" -> "Central Nervous System 
Changes" 
"Altered Gravity" -> "Connective Tissue Changes" 
"Altered Gravity" -> "Muscle Performance" 
"Altered Gravity" -> "Vascular Structure/Function" 

"Altered Gravity" -> Anthropometry 
"Astronaut Selection" -> "Individual Factors" 
"Body Posture" -> "Musculoskeletal Injury" 
"Body Posture" -> "Neuro/Ocular Injury" 
"Bone Remodeling" -> "Musculoskeletal Injury" 
"Central Nervous System Changes" -> 
"Neuro/Ocular Injury" 
"Connective Tissue Changes" -> "Musculoskeletal 
Injury" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Distance from Earth" -> "Suit Design" 
"Distance from Earth" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Vehicle 
Dynamics" 
"Individual Factors" -> "Bone Remodeling" 
"Individual Factors" -> "Connective Tissue 
Changes" 
"Individual Factors" -> "Muscle Performance" 
"Individual Factors" -> "Musculoskeletal Injury" 
"Individual Factors" -> Anthropometry 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Medical Treatment Capability" -> Evacuation 
"Muscle Performance" -> "Musculoskeletal Injury" 
"Musculoskeletal Injury" -> "Flight Recertification" 
"Musculoskeletal Injury" -> "Individual Readiness" 
"Musculoskeletal Injury" -> "Long Term Health 
Outcomes" 
"Musculoskeletal Injury" -> "Loss of Crew Life" 
"Musculoskeletal Injury" -> Evacuation 
"Neuro/Ocular Injury" -> "Flight Recertification" 
"Neuro/Ocular Injury" -> "Individual Readiness" 
"Neuro/Ocular Injury" -> "Long Term Health 
Outcomes" 
"Neuro/Ocular Injury" -> Evacuation 
"SANS (Risk)" -> "Neuro/Ocular Injury" 
"Sensorimotor (Risk)" -> "Body Posture" 
"Suit Design" -> "Body Posture" 
"Suit Design" -> "Musculoskeletal Injury" 
"Task Performance" -> "Loss of Mission 
Objectives" 
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"Vascular Structure/Function" -> "Neuro/Ocular 
Injury" 
"Vehicle Design" -> "Body Posture" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Musculoskeletal Injury" 
"Vehicle Design" -> "Vehicle Dynamics" 
"Vehicle Dynamics" -> "Body Posture" 

"Vehicle Dynamics" -> "Musculoskeletal Injury" 
"Vehicle Dynamics" -> "Neuro/Ocular Injury" 
Anthropometry -> "Musculoskeletal Injury" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Electric Shock Risk  
dag { 
"Arc Flash/Sparking" [pos="-1.336,-1.005"] 
"Burn Treatment Capability" [pos="-1.219,-0.950"] 
"Charged Surface" [pos="-1.394,-0.956"] 
"Crew Capability" [pos="-1.160,-0.991"] 
"Crew Health and Performance System" [pos="-
1.405,-0.937"] 
"Crew Vehicle Integration" [pos="-1.482,-0.973"] 
"Detect Dysrhythmia" [pos="-1.291,-0.960"] 
"Detect Long Term Health Outcomes" [pos="-
1.139,-0.938"] 
"Diagnose Rhabdomyolysis" [pos="-1.282,-0.946"] 
"Distance from Earth" [exposure,pos="-1.490,-
0.933"] 
"Dysrhythmia Monitor" [pos="-1.319,-0.952"] 
"Dysrhythmia Treatment" [pos="-1.238,-0.959"] 
"EVA Operations" [pos="-1.385,-0.968"] 
"Electrical Hardware" [pos="-1.442,-0.980"] 
"Electrical Muscle Effects" [pos="-1.252,-0.995"] 
"Electrical Shock" [pos="-1.334,-0.988"] 
"Electrical System Design" [pos="-1.482,-0.999"] 
"HSIA (Risk)" [latent,pos="-1.488,-0.951"] 
"Hardware/System Failure" [pos="-1.427,-0.991"] 
"Hostile Closed Environment" [exposure,pos="-
1.481,-1.008"] 
"Human Error" [pos="-1.422,-1.005"] 
"Human-Electrical Contact" [pos="-1.380,-0.997"] 
"Impedance Factors" [pos="-1.373,-0.984"] 
"Individual Readiness" [pos="-1.203,-0.991"] 
"Long Term Health Outcomes" [outcome,pos="-
1.138,-0.951"] 
"Loss of Crew Life" [outcome,pos="-1.133,-0.963"] 
"Loss of Mission Objectives" [outcome,pos="-
1.141,-1.009"] 
"Loss of Mission" [outcome,pos="-1.129,-1.015"] 
"Medical Diagnostic Capability" [pos="-1.332,-
0.932"] 
"Medical Treatment Capability" [pos="-1.251,-
0.935"] 
"Physiologic Monitoring Capability" [pos="-1.360,-
0.948"] 
"Plasma Induced Shock" [pos="-1.334,-0.977"] 
"Rhabdomyolysis Treatment" [pos="-1.202,-
0.942"] 
"Startle Reaction" [pos="-1.250,-1.005"] 
"Suit Design" [pos="-1.431,-0.968"] 
"Suit-Vehicle/Habitat Contact" [pos="-1.336,-
0.967"] 
"Task Performance" [outcome,pos="-1.151,-
1.001"] 

"Vehicle Design" [pos="-1.462,-0.943"] 
Burns [pos="-1.254,-0.985"] 
Dysrhythmia [pos="-1.276,-0.978"] 
Evacuation [outcome,pos="-1.136,-0.978"] 
Radiation [exposure,pos="-1.497,-0.963"] 
Rhabdomyolysis [pos="-1.253,-0.970"] 
Surveillance [pos="-1.168,-0.931"] 
"Arc Flash/Sparking" -> "Startle Reaction" 
"Arc Flash/Sparking" -> Dysrhythmia 
"Burn Treatment Capability" -> "Individual 
Readiness" 
"Burn Treatment Capability" -> "Long Term Health 
Outcomes" 
"Burn Treatment Capability" -> "Loss of Crew Life" 
"Burn Treatment Capability" -> Evacuation 
"Charged Surface" -> "Suit-Vehicle/Habitat 
Contact" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Diagnostic Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
"Physiologic Monitoring Capability" 
"Crew Vehicle Integration" -> "Human Error" 
"Detect Dysrhythmia" -> "Dysrhythmia 
Treatment" 
"Diagnose Rhabdomyolysis" -> "Rhabdomyolysis 
Treatment" 
"Distance from Earth" -> "Vehicle Design" 
"Dysrhythmia Monitor" -> "Detect Dysrhythmia" 
"Dysrhythmia Treatment" -> "Individual 
Readiness" 
"Dysrhythmia Treatment" -> "Loss of Crew Life" 
"Dysrhythmia Treatment" -> Evacuation 
"EVA Operations" -> "Suit-Vehicle/Habitat 
Contact" 
"Electrical Hardware" -> "Electrical System 
Design" 
"Electrical Muscle Effects" -> "Individual 
Readiness" 
"Electrical Shock" -> "Electrical Muscle Effects" 
"Electrical Shock" -> "Startle Reaction" 
"Electrical Shock" -> Burns 
"Electrical Shock" -> Dysrhythmia 
"Electrical Shock" -> Rhabdomyolysis 
"Electrical System Design" -> "Hardware/System 
Failure" 
"Electrical System Design" -> "Human Error" 
"HSIA (Risk)" -> "Suit Design" 



Appendix C – Risk Formatting Instructions 

174 

"HSIA (Risk)" -> "Vehicle Design" 
"Hardware/System Failure" -> "Human-Electrical 
Contact" 
"Hostile Closed Environment" -> "Electrical System 
Design" 
"Human Error" -> "Arc Flash/Sparking" 
"Human Error" -> "Human-Electrical Contact" 
"Human-Electrical Contact" -> "Electrical Shock" 
"Impedance Factors" -> "Electrical Shock" 
"Impedance Factors" -> "Plasma Induced Shock" 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Diagnostic Capability" -> "Diagnose 
Rhabdomyolysis" 
"Medical Treatment Capability" -> "Burn 
Treatment Capability" 
"Medical Treatment Capability" -> "Dysrhythmia 
Treatment" 
"Medical Treatment Capability" -> 
"Rhabdomyolysis Treatment" 
"Physiologic Monitoring Capability" -> 
"Dysrhythmia Monitor" 
"Plasma Induced Shock" -> "Startle Reaction" 
"Rhabdomyolysis Treatment" -> "Individual 
Readiness" 
"Rhabdomyolysis Treatment" -> "Long Term 
Health Outcomes" 
"Rhabdomyolysis Treatment" -> "Loss of Crew 
Life" 
"Rhabdomyolysis Treatment" -> Evacuation 

"Startle Reaction" -> "Individual Readiness" 
"Suit Design" -> "EVA Operations" 
"Suit-Vehicle/Habitat Contact" -> "Plasma Induced 
Shock" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Charged Surface" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Crew Vehicle Integration" 
"Vehicle Design" -> "Electrical Hardware" 
"Vehicle Design" -> "Electrical System Design" 
Burns -> "Individual Readiness" 
Burns -> "Long Term Health Outcomes" 
Burns -> "Loss of Crew Life" 
Burns -> Evacuation 
Dysrhythmia -> "Detect Dysrhythmia" 
Dysrhythmia -> "Individual Readiness" 
Dysrhythmia -> "Loss of Crew Life" 
Dysrhythmia -> Evacuation 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Radiation -> "Charged Surface" 
Rhabdomyolysis -> "Diagnose Rhabdomyolysis" 
Rhabdomyolysis -> "Individual Readiness" 
Rhabdomyolysis -> "Long Term Health Outcomes" 
Rhabdomyolysis -> "Loss of Crew Life" 
Rhabdomyolysis -> Evacuation 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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EVA Risk  
dag { 
bb="0,0,1,1" 
"Altered Gravity" [exposure,pos="0.063,0.666"] 
"Astronaut Selection" [pos="0.057,0.508"] 
"Cognitive Function" [pos="0.529,0.224"] 
"Crew Capability" [pos="0.694,0.223"] 
"Crew Health and Performance System" 
[pos="0.448,0.046"] 
"DCS (Risk)" [latent,pos="0.653,0.663"] 
"Detect EVA Readiness" [pos="0.448,0.484"] 
"Detect Long Term Health Outcomes" 
[pos="0.900,0.769"] 
"Distance from Earth" 
[exposure,pos="0.062,0.047"] 
"Dynamic Loads (Risk)" [latent,pos="0.189,0.844"] 
"EVA Decision Support" [pos="0.285,0.143"] 
"EVA Duration" [pos="0.285,0.325"] 
"EVA Frequency" [pos="0.284,0.396"] 
"EVA Task Timeline" [pos="0.169,0.146"] 
"Environmental Injury" [pos="0.675,0.398"] 
"Fall Height" [pos="0.617,0.867"] 
"HSIA (Risk)" [latent,pos="0.542,0.544"] 
"Hostile Closed Environment" 
[exposure,pos="0.079,0.931"] 
"Incapacitation/ Crew Rescue" 
[pos="0.901,0.393"] 
"Individual Factors" [pos="0.179,0.648"] 
"Individual Readiness" [pos="0.623,0.158"] 
"Isolation and Confinement" 
[exposure,pos="0.077,0.216"] 
"Long Term Health Outcomes" 
[outcome,pos="0.909,0.670"] 
"Loss of Crew Life" [outcome,pos="0.898,0.578"] 
"Loss of EVA Content" [pos="0.902,0.227"] 
"Loss of Mission Objectives" 
[outcome,pos="0.900,0.132"] 
"Loss of Mission" [outcome,pos="0.901,0.037"] 
"Medical Treatment Capability" 
[pos="0.674,0.048"] 
"Physical Status" [pos="0.284,0.563"] 
"Physiologic Monitoring Capability" 
[pos="0.448,0.143"] 
"Planned EVA Content" [pos="0.170,0.398"] 
"Previous Injury" [pos="0.284,0.733"] 
"Procedure Design" [pos="0.704,0.907"] 
"Suit Design" [pos="0.462,0.686"] 
"Suit Failure" [pos="0.545,0.673"] 
"Suit Habitability" [pos="0.371,0.929"] 
"Task Performance" [pos="0.792,0.224"] 
"Tool Design" [pos="0.779,0.873"] 

"Traumatic Injury" [pos="0.740,0.544"] 
"Vehicle Design" [pos="0.286,0.048"] 
Fatigue [pos="0.528,0.316"] 
Radiation [exposure,pos="0.063,0.343"] 
Surveillance [pos="0.898,0.887"] 
Training [pos="0.411,0.590"] 
Workload [pos="0.374,0.399"] 
"Altered Gravity" -> "Physical Status" 
"Altered Gravity" -> "Planned EVA Content" 
"Altered Gravity" -> "Suit Habitability" 
"Altered Gravity" -> Workload 
"Astronaut Selection" -> "Individual Factors" 
"Cognitive Function" -> "Individual Readiness" 
"Cognitive Function" -> "Traumatic Injury" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
"Physiologic Monitoring Capability" 
"DCS (Risk)" -> "Environmental Injury" 
"Detect EVA Readiness" -> "Loss of EVA Content" 
"Detect Long Term Health Outcomes" -> "Long 
Term Health Outcomes" 
"Distance from Earth" -> "EVA Decision Support" 
[pos="0.151,0.087"] 
"Distance from Earth" -> "Vehicle Design" 
"Dynamic Loads (Risk)" -> "Previous Injury" 
"EVA Decision Support" -> "Cognitive Function" 
"EVA Decision Support" -> Workload 
"EVA Duration" -> "Cognitive Function" 
"EVA Duration" -> Workload 
"EVA Frequency" -> "Cognitive Function" 
"EVA Frequency" -> Workload 
"EVA Task Timeline" -> "EVA Decision Support" 
"EVA Task Timeline" -> "EVA Duration" 
"Environmental Injury" -> "Incapacitation/ Crew 
Rescue" 
"Environmental Injury" -> "Individual Readiness" 
"Environmental Injury" -> "Loss of EVA Content" 
"Fall Height" -> "Traumatic Injury" 
"HSIA (Risk)" -> "Fall Height" 
"HSIA (Risk)" -> "Procedure Design" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Tool Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"HSIA (Risk)" -> Training 
"Hostile Closed Environment" -> "Physical Status" 
"Hostile Closed Environment" -> "Planned EVA 
Content" 
"Hostile Closed Environment" -> "Suit Habitability" 



Appendix C – Risk Formatting Instructions 

176 

"Incapacitation/ Crew Rescue" -> "Loss of Crew 
Life" 
"Incapacitation/ Crew Rescue" -> "Loss of EVA 
Content" 
"Individual Factors" -> "Previous Injury" 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> "Cognitive 
Function" 
"Loss of EVA Content" -> "Loss of Mission 
Objectives" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Physical Status" -> "Detect EVA Readiness" 
"Physical Status" -> "Individual Readiness" 
"Physical Status" -> Workload 
"Physiologic Monitoring Capability" -> "Detect 
EVA Readiness" 
"Physiologic Monitoring Capability" -> "EVA 
Decision Support" 
"Planned EVA Content" -> "EVA Decision Support" 
"Planned EVA Content" -> "EVA Duration" 
"Planned EVA Content" -> "EVA Frequency" 
"Planned EVA Content" -> "EVA Task Timeline" 
"Previous Injury" -> "Physical Status" 
"Previous Injury" -> Workload 
"Procedure Design" -> "Task Performance" 
"Procedure Design" -> "Traumatic Injury" 
"Suit Design" -> "Suit Failure" 

"Suit Design" -> "Suit Habitability" 
"Suit Failure" -> "Environmental Injury" 
"Suit Failure" -> "Individual Readiness" 
"Suit Failure" -> "Traumatic Injury" 
"Suit Habitability" -> "Suit Failure" 
"Suit Habitability" -> Workload 
"Task Performance" -> "Loss of EVA Content" 
"Tool Design" -> "Task Performance" 
"Tool Design" -> "Traumatic Injury" 
"Traumatic Injury" -> "Incapacitation/ Crew 
Rescue" 
"Traumatic Injury" -> "Individual Readiness" 
"Traumatic Injury" -> "Long Term Health 
Outcomes" 
"Traumatic Injury" -> "Loss of EVA Content" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
Fatigue -> "Cognitive Function" 
Fatigue -> "Individual Readiness" 
Fatigue -> "Traumatic Injury" 
Radiation -> "Cognitive Function" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Training -> "Individual Readiness" 
Training -> "Previous Injury" 
Workload -> "Environmental Injury" 
Workload -> Fatigue 
} 
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Food and Nutrition Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.439,0.153"] 
"Astronaut Selection" [pos="-0.344,-0.409"] 
"Behavioral (Risk)" [latent,pos="0.090,-0.438"] 
"Cardiovascular (Risk)" [latent,pos="0.083,0.141"] 
"Crew Capability" [pos="0.244,-0.324"] 
"Crew Health and Performance System" [pos="-
0.353,-0.283"] 
"Detect Long Term Health Outcomes" 
[pos="0.385,0.194"] 
"Distance from Earth" [exposure,pos="-0.440,-
0.436"] 
"Effective Mission Duration" [pos="-0.166,-0.443"] 
"Energy (Calories)" [pos="-0.055,-0.019"] 
"Food Acceptability" [pos="-0.171,-0.169"] 
"Food Preparation" [pos="-0.264,-0.147"] 
"Food Production" [pos="-0.304,0.025"] 
"Food Safety" [pos="-0.179,0.236"] 
"Food Storage" [pos="-0.311,0.322"] 
"Food System" [pos="-0.355,-0.120"] 
"Food Variety" [pos="-0.171,0.061"] 
"HSIA (Risk)" [latent,pos="-0.442,-0.113"] 
"Hostile Closed Environment" [exposure,pos="-
0.424,0.402"] 
"Immune (Risk)" [latent,pos="0.085,0.023"] 
"Individual Factors" [pos="-0.274,-0.317"] 
"Individual Readiness" [pos="0.189,-0.253"] 
"Long Term Health Outcomes" 
[outcome,pos="0.386,0.033"] 
"Loss of Crew Life" [outcome,pos="0.416,-0.109"] 
"Loss of Mission Objectives" 
[outcome,pos="0.342,-0.450"] 
"Loss of Mission" [outcome,pos="0.436,-0.479"] 
"Medical (Risk)" [latent,pos="0.197,-0.142"] 
"Microhost, Renal Stone, Bone Fracture (Risks), 
VTE (Concern)" [latent,pos="0.076,-0.100"] 
"Muscle, Aerobic (Risk)" [latent,pos="0.089,-
0.317"] 
"Nutrient Deficiencies" [pos="0.202,0.289"] 
"Nutrient Toxicities" [pos="0.158,0.185"] 
"Pharm (Risk)" [latent,pos="0.037,0.379"] 
"Radiation Carcinogenesis (Risk)" 
[latent,pos="0.211,0.384"] 
"Sleep (Risk)" [latent,pos="0.087,-0.199"] 
"Task Performance" [outcome,pos="0.294,-
0.383"] 
"Team (Risk)" [latent,pos="0.207,-0.438"] 
"Vehicle Design" [pos="-0.439,-0.318"] 
Evacuation [outcome,pos="0.292,-0.144"] 

Hydration [pos="-0.040,-0.431"] 
Nutrients [pos="-0.054,0.243"] 
Radiation [exposure,pos="-0.430,0.272"] 
Recycling [pos="-0.168,-0.346"] 
Resupply [pos="-0.280,-0.442"] 
Starvation [pos="0.252,-0.034"] 
Surveillance [pos="0.386,0.337"] 
"Altered Gravity" -> "Food System" 
"Astronaut Selection" -> "Individual Factors" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"Cardiovascular (Risk)" -> "Medical (Risk)" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> "Food 
System" 
"Detect Long Term Health Outcomes" <-> "Long 
Term Health Outcomes" 
"Distance from Earth" -> "Vehicle Design" 
"Distance from Earth" -> Resupply 
"Effective Mission Duration" -> "Food System" 
"Effective Mission Duration" -> Resupply 
"Energy (Calories)" -> "Behavioral (Risk)" 
"Energy (Calories)" -> "Immune (Risk)" 
"Energy (Calories)" -> "Microhost, Renal Stone, 
Bone Fracture (Risks), VTE (Concern)" 
"Energy (Calories)" -> "Muscle, Aerobic (Risk)" 
"Energy (Calories)" -> "Sleep (Risk)" 
"Energy (Calories)" -> Starvation 
"Food Acceptability" -> "Behavioral (Risk)" 
"Food Acceptability" -> "Energy (Calories)" 
"Food Acceptability" -> Hydration 
"Food Acceptability" -> Nutrients 
"Food Preparation" -> "Food Acceptability" 
"Food Preparation" -> "Food Safety" 
"Food Preparation" -> "Food Variety" 
"Food Preparation" -> Hydration 
"Food Production" -> "Energy (Calories)" 
"Food Production" -> "Food Acceptability" 
"Food Production" -> "Food Safety" 
"Food Production" -> "Food Storage" 
"Food Production" -> "Food Variety" 
"Food Production" -> Nutrients 
"Food Safety" -> "Energy (Calories)" 
"Food Safety" -> "Medical (Risk)" 
"Food Safety" -> Hydration 
"Food Safety" -> Nutrients 
"Food Storage" -> "Energy (Calories)" 
"Food Storage" -> "Food Acceptability" 
"Food Storage" -> "Food Safety" 
"Food Storage" -> "Food Variety" 
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"Food Storage" -> Hydration 
"Food Storage" -> Nutrients 
"Food System" -> "Food Preparation" 
"Food System" -> "Food Production" 
"Food System" -> "Food Storage" 
"Food System" -> Recycling 
"Food Variety" -> "Behavioral (Risk)" 
"Food Variety" -> "Energy (Calories)" 
"Food Variety" -> "Food Acceptability" 
"Food Variety" -> Nutrients 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Food System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Food Storage" 
"Immune (Risk)" -> "Medical (Risk)" 
"Individual Factors" -> "Food Acceptability" 
"Individual Readiness" -> "Crew Capability" 
"Individual Readiness" -> "Loss of Crew Life" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> Evacuation 
"Microhost, Renal Stone, Bone Fracture (Risks), 
VTE (Concern)" -> "Medical (Risk)" 
"Muscle, Aerobic (Risk)" -> "Individual Readiness" 
"Muscle, Aerobic (Risk)" -> "Medical (Risk)" 
"Nutrient Deficiencies" -> "Long Term Health 
Outcomes" 
"Nutrient Deficiencies" -> "Medical (Risk)" 
"Nutrient Toxicities" -> "Long Term Health 
Outcomes" 
"Nutrient Toxicities" -> "Medical (Risk)" 
"Pharm (Risk)" -> "Nutrient Deficiencies" 
"Pharm (Risk)" -> "Nutrient Toxicities" 

"Pharm (Risk)" -> Nutrients 
"Radiation Carcinogenesis (Risk)" -> "Long Term 
Health Outcomes" 
"Sleep (Risk)" -> "Individual Readiness" 
"Sleep (Risk)" -> "Medical (Risk)" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Crew Capability" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Hydration -> "Behavioral (Risk)" 
Hydration -> "Microhost, Renal Stone, Bone 
Fracture (Risks), VTE (Concern)" 
Hydration -> "Sleep (Risk)" 
Nutrients -> "Behavioral (Risk)" 
Nutrients -> "Cardiovascular (Risk)" 
Nutrients -> "Immune (Risk)" 
Nutrients -> "Microhost, Renal Stone, Bone 
Fracture (Risks), VTE (Concern)" 
Nutrients -> "Muscle, Aerobic (Risk)" 
Nutrients -> "Nutrient Deficiencies" 
Nutrients -> "Nutrient Toxicities" 
Nutrients -> "Radiation Carcinogenesis (Risk)" 
Nutrients -> "Sleep (Risk)" 
Radiation -> "Food Storage" 
Recycling -> Hydration 
Resupply -> "Food System" 
Starvation -> "Individual Readiness" 
Starvation -> "Loss of Crew Life" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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HSIA Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Anomalous Events" [pos="-0.213,-0.042"] 
"Autonomous Systems" [pos="-0.320,0.203"] 
"Communication Factors" [pos="-0.422,-0.379"] 
"Crew Capability" [pos="-0.005,-0.294"] 
"Crew Health and Performance System" [pos="-
0.330,-0.001"] 
"Crew Size" [pos="-0.036,-0.457"] 
"Crew Vehicle Integration" [pos="-0.290,0.323"] 
"Data Accessibility" [pos="0.159,0.198"] 
"Data Architecture" [pos="0.161,0.297"] 
"Detect Events" [pos="-0.065,-0.047"] 
"Diagnose Events" [pos="0.086,-0.042"] 
"Diagnostic Capability" [pos="0.080,0.083"] 
"Distance from Earth" [exposure,pos="-0.446,-
0.041"] 
"Effective Mission Duration" [pos="-0.328,-0.182"] 
"Ground Support" [pos="-0.292,-0.380"] 
"HSI Processes" [pos="-0.291,0.411"] 
"Intervention Decision" [pos="0.249,-0.041"] 
"Loss of Crew Life" [outcome,pos="0.427,0.037"] 
"Loss of Mission Objectives" 
[outcome,pos="0.349,-0.430"] 
"Loss of Mission" [outcome,pos="0.442,-0.470"] 
"Loss of Vehicle" [pos="0.354,-0.050"] 
"Mission Architecture Complexity" [pos="-0.326,-
0.291"] 
"Mitigation Options" [pos="0.247,0.068"] 
"Monitoring Capability" [pos="-0.107,0.073"] 
"On-Board Expertise" [pos="-0.163,-0.455"] 
"Other Risks" [latent,pos="0.049,-0.458"] 
"Procedure Design" [pos="0.011,0.236"] 
"Resource Availability" [pos="0.305,0.162"] 
"Standards/Requirements" [pos="-0.421,0.405"] 
"Suit Design" [pos="-0.157,0.409"] 
"System Complexity" [pos="-0.212,0.156"] 
"System Knowledge Resources" 
[pos="0.239,0.419"] 
"System Telemetry" [pos="0.079,0.416"] 
"Task Performance" [outcome,pos="0.300,-
0.328"] 
"Time Critical Procedure Execution" [pos="-0.103,-
0.156"] 
"Vehicle Design" [pos="-0.423,0.259"] 
"Vehicle Systems" [pos="-0.111,0.333"] 
Evacuation [outcome,pos="0.396,-0.249"] 
Maintainability [pos="-0.109,0.239"] 
Resupply [pos="-0.404,0.111"] 
Training [pos="-0.180,-0.251"] 

"Anomalous Events" -> "Detect Events" 
"Autonomous Systems" -> "Anomalous Events" 
"Autonomous Systems" -> "Crew Health and 
Performance System" 
"Autonomous Systems" -> "System Complexity" 
"Communication Factors" -> "Ground Support" 
"Crew Capability" -> "Detect Events" 
"Crew Capability" -> "Diagnose Events" 
"Crew Capability" -> "Intervention Decision" 
"Crew Capability" -> "Task Performance" 
"Crew Capability" -> "Time Critical Procedure 
Execution" 
"Crew Health and Performance System" -> "Crew 
Capability" 
"Crew Health and Performance System" -> 
Training 
"Crew Size" -> "Crew Capability" 
"Crew Size" -> "On-Board Expertise" 
"Crew Vehicle Integration" -> "Anomalous Events" 
"Crew Vehicle Integration" -> "Autonomous 
Systems" 
"Crew Vehicle Integration" -> "System 
Complexity" 
"Data Accessibility" -> "Diagnostic Capability" 
"Data Accessibility" -> "Monitoring Capability" 
"Data Architecture" -> "Data Accessibility" 
"Detect Events" -> "Diagnose Events" 
"Diagnose Events" -> "Intervention Decision" 
"Diagnostic Capability" -> "Diagnose Events" 
"Distance from Earth" -> "Communication 
Factors" 
"Distance from Earth" -> "Vehicle Design" 
"Distance from Earth" -> Resupply 
"Effective Mission Duration" -> "Anomalous 
Events" 
"Ground Support" -> "Crew Capability" 
"Ground Support" -> "Detect Events" 
"Ground Support" -> "Diagnose Events" 
"Ground Support" -> "Intervention Decision" 
"HSI Processes" -> "Crew Vehicle Integration" 
"HSI Processes" -> "Suit Design" 
"HSI Processes" -> "Vehicle Design" 
"Intervention Decision" -> "Loss of Vehicle" 
"Intervention Decision" -> "Task Performance" 
"Intervention Decision" -> Evacuation 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Loss of Vehicle" -> "Loss of Crew Life" 
"Mission Architecture Complexity" -> "Anomalous 
Events" 
"Mitigation Options" -> "Intervention Decision" 
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"Monitoring Capability" -> "Crew Health and 
Performance System" 
"Monitoring Capability" -> "Detect Events" 
"Monitoring Capability" -> "Diagnostic Capability" 
"On-Board Expertise" -> "Crew Capability" 
"On-Board Expertise" -> "Diagnostic Capability" 
"On-Board Expertise" -> "Monitoring Capability" 
"Other Risks" -> "Crew Capability" 
"Procedure Design" -> "Task Performance" 
"Resource Availability" -> "Mitigation Options" 
"Resource Availability" -> "Task Performance" 
"Standards/Requirements" -> "HSI Processes" 
"Suit Design" -> "Anomalous Events" 
"Suit Design" -> "System Telemetry" 
"System Complexity" -> "Anomalous Events" 
"System Complexity" -> "Diagnostic Capability" 
"System Complexity" -> Maintainability 
"System Knowledge Resources" -> "Data 
Architecture" 
"System Telemetry" -> "Data Architecture" 
"Task Performance" -> "Loss of Mission 
Objectives" 

"Task Performance" -> "Loss of Vehicle" 
"Time Critical Procedure Execution" -> 
"Anomalous Events" 
"Vehicle Design" -> "Anomalous Events" 
"Vehicle Design" -> "Autonomous Systems" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Crew Vehicle Integration" 
"Vehicle Design" -> "Vehicle Systems" 
"Vehicle Design" -> Maintainability 
"Vehicle Systems" -> "System Knowledge 
Resources" 
"Vehicle Systems" -> "System Telemetry" 
"Vehicle Systems" -> Maintainability 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Maintainability -> "Monitoring Capability" 
Maintainability -> "Procedure Design" 
Maintainability -> "Task Performance" 
Resupply -> "Resource Availability" 
Training -> "Crew Capability" 
} 
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Hypoxia Risk  
dag { 
"Altered Gravity" [exposure,pos="-0.817,-1.515"] 
"Atmospheric Conditions" [pos="-0.725,-1.910"] 
"Breathing Masks" [pos="-0.310,-0.692"] 
"Cognitive Function" [pos="-0.361,-0.979"] 
"Compartment Isolation" [pos="-0.192,0.108"] 
"Crew Capability" [pos="-0.180,-2.805"] 
"Crew Health and Performance System" [pos="-
0.476,0.917"] 
"DCS, Immune, SANS, Sleep (Risks)" [latent,pos="-
0.615,0.587"] 
"Detect Atmospheric Changes" [pos="-
0.451,0.038"] 
"Distance from Earth" [exposure,pos="-
0.803,0.115"] 
"EVA Operations" [pos="-0.724,-2.635"] 
"Effective Exposure Duration" [pos="-0.517,-
1.542"] 
"Environmental Monitoring Capability" [pos="-
0.377,0.449"] 
"HSIA (Risk)" [latent,pos="-0.820,0.912"] 
"Hostile Closed Environment" [exposure,pos="-
0.788,-3.105"] 
"Individual Factors" [pos="-0.344,-1.777"] 
"Individual Readiness" [pos="-0.279,-2.780"] 
"Loss of Crew Life" [outcome,pos="-0.055,-0.536"] 
"Loss of Mission Objectives" [outcome,pos="-
0.034,-2.385"] 
"Loss of Mission" [outcome,pos="-0.017,-3.055"] 
"Loss of Vehicle" [pos="-0.016,-1.225"] 
"Medical (Risk)" [latent,pos="-0.079,0.923"] 
"Mild Hypoxia" [pos="-0.517,-0.974"] 
"Pressure Suits" [pos="-0.254,-0.292"] 
"Staged Denitrogenation" [pos="-0.782,-0.974"] 
"Suit Design" [pos="-0.759,-0.018"] 
"Suit Failure" [pos="-0.615,-2.120"] 
"Task Performance" [outcome,pos="-0.087,-
2.805"] 
"Toxic Exposure" [pos="-0.432,-2.559"] 
"Vehicle Design" [pos="-0.718,0.874"] 
"Vehicle Failure" [pos="-0.503,-2.979"] 
Depressurization [pos="-0.343,-2.979"] 
Hypoxia [pos="-0.135,-0.877"] 
"Altered Gravity" -> "EVA Operations" 
"Altered Gravity" -> "Staged Denitrogenation" 
"Atmospheric Conditions" -> "DCS, Immune, SANS, 
Sleep (Risks)" 
"Atmospheric Conditions" -> "Detect Atmospheric 
Changes" 
"Atmospheric Conditions" -> "Mild Hypoxia" 

"Atmospheric Conditions" -> "Staged 
Denitrogenation" 
"Breathing Masks" -> "Individual Readiness" 
"Cognitive Function" -> "Individual Readiness" 
"Compartment Isolation" -> "Individual Readiness" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Environmental Monitoring Capability" 
"Crew Health and Performance System" -> 
"Medical (Risk)" 
"DCS, Immune, SANS, Sleep (Risks)" -> "Cognitive 
Function" 
"DCS, Immune, SANS, Sleep (Risks)" -> "Medical 
(Risk)" 
"Detect Atmospheric Changes" -> "Breathing 
Masks" 
"Detect Atmospheric Changes" -> "Compartment 
Isolation" 
"Detect Atmospheric Changes" -> "Pressure Suits" 
"Distance from Earth" -> "Vehicle Design" 
"EVA Operations" -> "Suit Failure" 
"Effective Exposure Duration" -> "Mild Hypoxia" 
"Environmental Monitoring Capability" -> "Detect 
Atmospheric Changes" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Atmospheric 
Conditions" 
"Hostile Closed Environment" -> "Vehicle Failure" 
"Individual Factors" -> "Cognitive Function" 
"Individual Readiness" -> "Crew Capability" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Loss of Vehicle" -> "Loss of Crew Life" 
"Loss of Vehicle" -> "Loss of Mission Objectives" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Mild Hypoxia" -> "Cognitive Function" 
"Mild Hypoxia" -> "DCS, Immune, SANS, Sleep 
(Risks)" 
"Mild Hypoxia" -> "Medical (Risk)" 
"Pressure Suits" -> "Individual Readiness" 
"Staged Denitrogenation" -> "Mild Hypoxia" 
"Suit Design" -> "Staged Denitrogenation" 
"Suit Design" -> "Suit Failure" 
"Suit Failure" -> "Mild Hypoxia" 
"Suit Failure" -> Hypoxia 
"Task Performance" -> "Loss of Crew Life" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Task Performance" -> "Loss of Vehicle" 
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"Toxic Exposure" -> "Detect Atmospheric 
Changes" 
"Toxic Exposure" -> Hypoxia 
"Vehicle Design" -> "Atmospheric Conditions" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Vehicle Failure" 
"Vehicle Failure" -> "Toxic Exposure" 

"Vehicle Failure" -> Depressurization 
Depressurization -> "Detect Atmospheric 
Changes" 
Depressurization -> Hypoxia 
Hypoxia -> "Individual Readiness" 
Hypoxia -> "Loss of Crew Life" 
Hypoxia -> "Medical (Risk)" 
} 
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Immune Risk  
dag { 
bb="0,0,1,1" 
"Altered Gravity" [exposure,pos="0.204,0.047"] 
"Astronaut Selection" [pos="0.415,0.024"] 
"Atmospheric Conditions" [pos="0.236,0.477"] 
"Behavioral (Risk)" [latent,pos="0.631,0.131"] 
"Circadian Misalignment" [pos="0.267,0.566"] 
"Clinically Significant Immune Dysregulation" 
[pos="0.556,0.453"] 
"Crew Capability" [pos="0.740,0.195"] 
"Crew Health and Performance System" 
[pos="0.413,0.889"] 
"Detect Immune Changes" [pos="0.522,0.577"] 
"Detect Long Term Health Outcomes" 
[pos="0.890,0.861"] 
"Distance from Earth" 
[exposure,pos="0.058,0.718"] 
"Dust (Risk)" [latent,pos="0.076,0.479"] 
"Flight Recertification" 
[outcome,pos="0.923,0.489"] 
"Food and Nutrition (Risk)" 
[latent,pos="0.102,0.151"] 
"HSIA (Risk)" [latent,pos="0.065,0.895"] 
"Hostile Closed Environment" 
[exposure,pos="0.071,0.381"] 
"Hypoxia, CO2 (Risks)" [latent,pos="0.086,0.255"] 
"Individual Factors" [pos="0.417,0.191"] 
"Individual Readiness" [pos="0.713,0.284"] 
"Isolation and Confinement" 
[exposure,pos="0.073,0.578"] 
"Lab Blood Monitoring" [pos="0.570,0.727"] 
"Long Term Health Outcomes" 
[outcome,pos="0.917,0.597"] 
"Loss of Crew Life" [outcome,pos="0.930,0.358"] 
"Loss of Mission Objectives" 
[outcome,pos="0.822,0.041"] 
"Loss of Mission" [outcome,pos="0.944,0.042"] 
"Medical Illness" [pos="0.644,0.397"] 
"Medical Prevention Capability" 
[pos="0.698,0.573"] 
"Medical Treatment Capability" 
[pos="0.752,0.728"] 
"Microbial Virulence Factors" [pos="0.494,0.082"] 
"Microhost (Risk)" [latent,pos="0.352,0.106"] 
"Oxidative Stress" [pos="0.232,0.166"] 
"Persistent Subclinical Immune Dysregulation" 
[pos="0.417,0.329"] 
"Pharm (Risk)" [latent,pos="0.588,0.887"] 
"Sleep (Risk)" [latent,pos="0.150,0.673"] 
"Stress Relieving VR" [pos="0.279,0.770"] 

"Task Performance" [outcome,pos="0.780,0.116"] 
"Team (Risk)" [latent,pos="0.695,0.050"] 
"Vehicle Design" [pos="0.153,0.797"] 
Evacuation [outcome,pos="0.832,0.284"] 
Exercise [pos="0.417,0.520"] 
Inflammation [pos="0.545,0.290"] 
Microbiome [pos="0.269,0.359"] 
Nutrients [pos="0.168,0.288"] 
Probiotics [pos="0.355,0.524"] 
Radiation [exposure,pos="0.055,0.073"] 
Stress [pos="0.281,0.667"] 
Supplements [pos="0.355,0.690"] 
Surveillance [pos="0.731,0.880"] 
"Altered Gravity" -> "Microbial Virulence Factors" 
"Altered Gravity" -> "Persistent Subclinical 
Immune Dysregulation" 
"Astronaut Selection" -> "Individual Factors" 
"Atmospheric Conditions" -> "Persistent 
Subclinical Immune Dysregulation" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"Circadian Misalignment" -> "Persistent 
Subclinical Immune Dysregulation" 
"Clinically Significant Immune Dysregulation" -> 
"Detect Immune Changes" 
"Clinically Significant Immune Dysregulation" -> 
"Medical Illness" 
"Clinically Significant Immune Dysregulation" -> 
Inflammation 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> "Lab 
Blood Monitoring" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> "Stress 
Relieving VR" 
"Crew Health and Performance System" -> 
Exercise 
"Crew Health and Performance System" -> 
Probiotics 
"Crew Health and Performance System" -> 
Supplements 
"Detect Immune Changes" -> "Medical Prevention 
Capability" 
"Detect Immune Changes" -> "Medical Treatment 
Capability" 
"Distance from Earth" -> "Circadian Misalignment" 
"Distance from Earth" -> "Vehicle Design" 



Appendix C – Risk Formatting Instructions 

184 

"Distance from Earth" -> Nutrients 
"Dust (Risk)" -> "Atmospheric Conditions" 
"Food and Nutrition (Risk)" -> Nutrients 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Atmospheric 
Conditions" 
"Hostile Closed Environment" -> "Circadian 
Misalignment" 
"Hostile Closed Environment" -> "Microbial 
Virulence Factors" 
"Hostile Closed Environment" -> Microbiome 
"Hostile Closed Environment" -> Nutrients 
"Hostile Closed Environment" -> Stress 
"Hypoxia, CO2 (Risks)" -> "Atmospheric 
Conditions" 
"Hypoxia, CO2 (Risks)" -> "Oxidative Stress" 
"Individual Factors" -> "Clinically Significant 
Immune Dysregulation" 
"Individual Factors" -> "Persistent Subclinical 
Immune Dysregulation" 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> Microbiome 
"Isolation and Confinement" -> Stress 
"Lab Blood Monitoring" -> "Detect Immune 
Changes" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Illness" -> "Behavioral (Risk)" 
"Medical Illness" -> "Flight Recertification" 
"Medical Illness" -> "Individual Readiness" 
"Medical Illness" -> "Long Term Health Outcomes" 
"Medical Illness" -> "Loss of Crew Life" 
"Medical Illness" -> Evacuation 
"Medical Prevention Capability" -> "Medical 
Illness" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Medical Treatment Capability" -> Evacuation 
"Microbial Virulence Factors" -> "Medical Illness" 

"Microhost (Risk)" -> "Microbial Virulence 
Factors" 
"Microhost (Risk)" -> Microbiome 
"Oxidative Stress" -> "Persistent Subclinical 
Immune Dysregulation" 
"Oxidative Stress" -> Inflammation 
"Persistent Subclinical Immune Dysregulation" -> 
"Clinically Significant Immune Dysregulation" 
"Persistent Subclinical Immune Dysregulation" -> 
"Detect Immune Changes" 
"Persistent Subclinical Immune Dysregulation" -> 
Inflammation 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Pharm (Risk)" -> Probiotics 
"Pharm (Risk)" -> Supplements 
"Sleep (Risk)" -> "Circadian Misalignment" 
"Sleep (Risk)" -> Stress 
"Stress Relieving VR" -> Stress 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Crew Capability" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Exercise -> "Persistent Subclinical Immune 
Dysregulation" 
Inflammation -> "Medical Illness" 
Microbiome -> "Oxidative Stress" 
Microbiome -> "Persistent Subclinical Immune 
Dysregulation" 
Nutrients -> "Oxidative Stress" 
Nutrients -> "Persistent Subclinical Immune 
Dysregulation" 
Probiotics -> Nutrients 
Radiation -> "Oxidative Stress" 
Stress -> "Persistent Subclinical Immune 
Dysregulation" 
Supplements -> Nutrients 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Medical Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.447,-0.142"] 
"Astronaut Selection" [pos="-0.440,-0.041"] 
"Behavioral, Team, Crew Egress, Aerobic, Muscle 
(Risks)" [latent,pos="0.158,-0.475"] 
"Communication Factors" [pos="-0.265,0.337"] 
"Crew Capability" [pos="0.224,-0.331"] 
"Crew Health and Performance System" [pos="-
0.254,0.236"] 
"Data Accessibility" [pos="0.060,-0.144"] 
"Data Architecture" [pos="-0.078,0.268"] 
"Detect Diagnosis" [pos="0.128,-0.221"] 
"Detect Environmental Conditions" [pos="-0.007,-
0.336"] 
"Detect Long Term Health Outcomes" 
[pos="0.293,0.331"] 
"Detect Physiologic Changes" [pos="0.009,-
0.059"] 
"Distance from Earth" [exposure,pos="-
0.428,0.183"] 
"EVA (Risk)" [latent,pos="-0.276,-0.285"] 
"Environmental Conditions" [pos="-0.315,-0.470"] 
"Environmental Injury" [pos="-0.136,-0.295"] 
"Environmental Monitoring Capability" [pos="-
0.074,-0.441"] 
"Environmental Risks" [latent,pos="-0.233,-
0.371"] 
"Flight Recertification" 
[outcome,pos="0.437,0.189"] 
"Ground Support" [pos="0.046,0.347"] 
"HSIA (Risk)" [latent,pos="-0.443,0.359"] 
"Hostile Closed Environment" [exposure,pos="-
0.418,-0.305"] 
"Individual Factors" [pos="-0.312,-0.042"] 
"Individual Readiness" [pos="0.162,-0.289"] 
"Isolation and Confinement" [exposure,pos="-
0.422,0.077"] 
"Long Term Health Outcomes" 
[outcome,pos="0.423,0.400"] 
"Loss of Crew Life" [outcome,pos="0.434,-0.062"] 
"Loss of Mission Objectives" 
[outcome,pos="0.384,-0.426"] 
"Loss of Mission" [outcome,pos="0.445,-0.468"] 
"Medical Diagnostic Capability" 
[pos="0.098,0.025"] 
"Medical Illness" [pos="-0.143,-0.033"] 
"Medical Prevention Capability" [pos="-
0.157,0.128"] 

"Medical Treatment Capability" [pos="0.314,-
0.143"] 
"On-Board Expertise" [pos="0.315,0.026"] 
"Other Risks" [latent,pos="-0.316,-0.188"] 
"Pharm (Risk)" [latent,pos="0.135,0.227"] 
"Physiologic Monitoring Capability" [pos="-
0.053,0.063"] 
"Resource Availability" [pos="0.107,0.410"] 
"Suit Design" [pos="-0.217,0.065"] 
"Task Performance" [pos="0.294,-0.379"] 
"Traumatic Injury" [pos="-0.124,-0.171"] 
"Treatment Decision" [pos="0.208,-0.170"] 
"Vehicle Design" [pos="-0.300,0.075"] 
Evacuation [pos="0.406,-0.202"] 
Radiation [exposure,pos="-0.450,-0.453"] 
Resupply [pos="-0.334,0.405"] 
Surveillance [pos="0.213,0.411"] 
Training [pos="0.156,0.102"] 
"Altered Gravity" -> "Environmental Conditions" 
"Altered Gravity" -> "Traumatic Injury" 
"Astronaut Selection" -> "Individual Factors" 
"Behavioral, Team, Crew Egress, Aerobic, Muscle 
(Risks)" -> "Individual Readiness" 
"Communication Factors" -> "Ground Support" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> "Data 
Architecture" 
"Crew Health and Performance System" -> 
"Medical Diagnostic Capability" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
Training 
"Data Accessibility" -> "Medical Diagnostic 
Capability" 
"Data Architecture" -> "Environmental Monitoring 
Capability" 
"Data Architecture" -> "Ground Support" 
"Data Architecture" -> "Physiologic Monitoring 
Capability" 
"Data Architecture" -> Training 
"Detect Diagnosis" -> "Treatment Decision" 
"Detect Environmental Conditions" -> "Data 
Accessibility" 
"Detect Environmental Conditions" -> "Detect 
Long Term Health Outcomes" 
"Detect Environmental Conditions" -> "Long Term 
Health Outcomes" 



Appendix C – Risk Formatting Instructions 

186 

"Detect Physiologic Changes" -> "Data 
Accessibility" 
"Distance from Earth" -> "Communication 
Factors" 
"Distance from Earth" -> "Vehicle Design" 
"Distance from Earth" -> Resupply 
"EVA (Risk)" -> "Traumatic Injury" 
"Environmental Conditions" -> "Detect 
Environmental Conditions" 
"Environmental Conditions" -> "Environmental 
Risks" 
"Environmental Injury" -> "Behavioral, Team, 
Crew Egress, Aerobic, Muscle (Risks)" 
"Environmental Injury" -> "Flight Recertification" 
"Environmental Injury" -> "Individual Readiness" 
"Environmental Injury" -> "Long Term Health 
Outcomes" 
"Environmental Injury" -> "Loss of Crew Life" 
"Environmental Injury" -> Evacuation 
"Environmental Monitoring Capability" -> "Detect 
Environmental Conditions" 
"Environmental Risks" -> "Environmental Injury" 
"Ground Support" -> "Medical Diagnostic 
Capability" 
"Ground Support" -> "Treatment Decision" 
"Ground Support" -> Training 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Environmental 
Conditions" 
"Hostile Closed Environment" -> "Traumatic 
Injury" 
"Individual Factors" -> "Environmental Injury" 
"Individual Factors" -> "Medical Illness" 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> "Medical Illness" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Diagnostic Capability" -> "Detect 
Diagnosis" 
"Medical Illness" -> "Behavioral, Team, Crew 
Egress, Aerobic, Muscle (Risks)" 
"Medical Illness" -> "Flight Recertification" 
"Medical Illness" -> "Individual Readiness" 
"Medical Illness" -> "Long Term Health Outcomes" 
"Medical Illness" -> "Loss of Crew Life" 
"Medical Illness" -> Evacuation 

"Medical Prevention Capability" -> "Medical 
Illness" 
"Medical Treatment Capability" -> "Behavioral, 
Team, Crew Egress, Aerobic, Muscle (Risks)" 
"Medical Treatment Capability" -> "Flight 
Recertification" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Long Term 
Health Outcomes" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Medical Treatment Capability" -> "Treatment 
Decision" 
"Medical Treatment Capability" -> Evacuation 
"On-Board Expertise" -> "Medical Diagnostic 
Capability" 
"On-Board Expertise" -> "Medical Treatment 
Capability" 
"Other Risks" -> "Environmental Injury" 
"Other Risks" -> "Medical Illness" 
"Other Risks" -> "Traumatic Injury" 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Physiologic Monitoring Capability" -> "Detect 
Physiologic Changes" 
"Resource Availability" -> "Medical Treatment 
Capability" 
"Resource Availability" -> "Pharm (Risk)" 
"Suit Design" -> "Environmental Injury" 
"Suit Design" -> "Traumatic Injury" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Traumatic Injury" -> "Behavioral, Team, Crew 
Egress, Aerobic, Muscle (Risks)" 
"Traumatic Injury" -> "Detect Diagnosis" 
"Traumatic Injury" -> "Detect Physiologic 
Changes" 
"Traumatic Injury" -> "Flight Recertification" 
"Traumatic Injury" -> "Individual Readiness" 
"Traumatic Injury" -> "Long Term Health 
Outcomes" 
"Traumatic Injury" -> "Loss of Crew Life" 
"Traumatic Injury" -> "Medical Treatment 
Capability" 
"Traumatic Injury" -> Evacuation 
"Treatment Decision" -> "Individual Readiness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Traumatic Injury" 
Evacuation -> "Loss of Crew Life" 
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Evacuation -> "Loss of Mission Objectives" 
Radiation -> "Environmental Conditions" 
Resupply -> "Resource Availability" 
Surveillance -> "Detect Long Term Health 
Outcomes" 

Training -> "Medical Diagnostic Capability" 
Training -> "Medical Treatment Capability" 
} 
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Microhost Risk  
dag { 
bb="0,0,1,1" 
"Air Contamination" [pos="0.292,0.513"] 
"Altered Gravity" [exposure,pos="0.096,0.234"] 
"Astronaut Selection" [pos="0.470,0.038"] 
"Behavioral (Risk)" [latent,pos="0.648,0.152"] 
"Crew Capability" [pos="0.772,0.204"] 
"Crew Health and Performance System" 
[pos="0.450,0.910"] 
"Detect Contamination" [pos="0.628,0.598"] 
"Detect Long Term Health Outcomes" 
[pos="0.833,0.902"] 
"Distance from Earth" 
[exposure,pos="0.077,0.682"] 
"Environmental Monitoring Capability" 
[pos="0.624,0.702"] 
"Food Contamination" [pos="0.295,0.693"] 
"Food and Nutrition (Risk)" 
[latent,pos="0.171,0.640"] 
"HSIA (Risk)" [latent,pos="0.229,0.913"] 
"Hostile Closed Environment" 
[exposure,pos="0.092,0.484"] 
"Immune (Risk)" [latent,pos="0.479,0.224"] 
"Individual Factors" [pos="0.470,0.135"] 
"Individual Readiness" [pos="0.698,0.263"] 
"Intervention Source Control" [pos="0.629,0.497"] 
"Isolation and Confinement" 
[exposure,pos="0.097,0.105"] 
"Long Term Health Outcomes" 
[outcome,pos="0.915,0.713"] 
"Loss of Crew Life" [outcome,pos="0.919,0.445"] 
"Loss of Mission Objectives" 
[outcome,pos="0.865,0.060"] 
"Loss of Mission" [outcome,pos="0.943,0.025"] 
"Medical Prevention Capability" 
[pos="0.459,0.815"] 
"Medical Treatment Capability" 
[pos="0.743,0.796"] 
"Microbial Resistance Factors" 
[pos="0.327,0.121"] 
"Microbial Virulence Factors" [pos="0.289,0.334"] 
"Pharm (Risk)" [latent,pos="0.197,0.748"] 
"Pharmaceutical Contamination" 
[pos="0.299,0.783"] 
"Preventive Source Control" [pos="0.438,0.708"] 
"Surface Contamination" [pos="0.289,0.424"] 
"Task Performance" [outcome,pos="0.807,0.142"] 
"Team (Risk)" [latent,pos="0.722,0.096"] 
"Vehicle Design" [pos="0.130,0.817"] 
"Water Contamination" [pos="0.292,0.602"] 

Evacuation [outcome,pos="0.835,0.330"] 
Hygiene [pos="0.492,0.643"] 
Infection [pos="0.629,0.389"] 
Microbiome [pos="0.400,0.255"] 
Sepsis [pos="0.748,0.389"] 
Surveillance [pos="0.691,0.906"] 
"Air Contamination" -> "Detect Contamination" 
"Air Contamination" -> Infection 
"Altered Gravity" -> "Microbial Virulence Factors" 
"Astronaut Selection" -> "Individual Factors" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Environmental Monitoring Capability" 
"Crew Health and Performance System" -> 
"Intervention Source Control" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Detect Contamination" -> "Intervention Source 
Control" 
"Distance from Earth" -> "Vehicle Design" 
"Environmental Monitoring Capability" -> "Detect 
Contamination" 
"Food Contamination" -> Infection 
"Food and Nutrition (Risk)" -> "Food 
Contamination" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Air 
Contamination" 
"Hostile Closed Environment" -> "Food 
Contamination" 
"Hostile Closed Environment" -> "Microbial 
Virulence Factors" 
"Hostile Closed Environment" -> "Pharmaceutical 
Contamination" 
"Hostile Closed Environment" -> "Surface 
Contamination" 
"Hostile Closed Environment" -> "Water 
Contamination" 
"Immune (Risk)" -> Infection 
"Individual Factors" -> Infection 
"Individual Factors" -> Microbiome 
"Individual Readiness" -> "Crew Capability" 
"Intervention Source Control" -> Infection 
"Isolation and Confinement" -> Microbiome 
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"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Prevention Capability" -> "Preventive 
Source Control" 
"Medical Prevention Capability" -> Hygiene 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Long Term 
Health Outcomes" 
"Medical Treatment Capability" -> "Loss of Crew 
Life" 
"Medical Treatment Capability" -> Evacuation 
"Medical Treatment Capability" -> Sepsis 
"Microbial Resistance Factors" -> Microbiome 
"Microbial Virulence Factors" -> Infection 
"Microbial Virulence Factors" -> Microbiome 
"Pharm (Risk)" -> "Pharmaceutical Contamination" 
"Pharmaceutical Contamination" -> Infection 
"Preventive Source Control" -> "Air 
Contamination" 
"Preventive Source Control" -> "Food 
Contamination" 
"Preventive Source Control" -> "Surface 
Contamination" 
"Preventive Source Control" -> "Water 
Contamination" 

"Surface Contamination" -> "Detect 
Contamination" 
"Surface Contamination" -> Infection 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Crew Capability" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Water Contamination" -> "Detect 
Contamination" 
"Water Contamination" -> Infection 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Hygiene -> Infection 
Infection -> "Behavioral (Risk)" 
Infection -> "Individual Readiness" 
Infection -> "Long Term Health Outcomes" 
Infection -> Sepsis 
Microbiome -> "Immune (Risk)" 
Microbiome -> Infection 
Sepsis -> "Individual Readiness" 
Sepsis -> "Long Term Health Outcomes" 
Sepsis -> "Loss of Crew Life" 
Sepsis -> Evacuation 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Muscle and Aerobic Risks 
dag { 
"Aerobic Exercise" [pos="-1.294,-1.238"] 
"Aerobic Fitness" [pos="-0.971,-1.286"] 
"Altered Gravity" [exposure,pos="-1.668,-1.069"] 
"Ambient CO2 Level" [pos="-1.492,-1.434"] 
"Astronaut Selection" [pos="-1.085,-0.785"] 
"Cardiovascular (Risk)" [latent,pos="-1.114,-
1.243"] 
"Crew Capability" [pos="-0.841,-1.297"] 
"Crew Health and Performance System" [pos="-
1.093,-1.591"] 
"Distance from Earth" [exposure,pos="-1.669,-
1.586"] 
"ECLS System" [pos="-1.678,-1.350"] 
"Effective Gravity Level" [pos="-1.593,-1.010"] 
"Effective Mission Duration" [pos="-1.603,-1.132"] 
"Endocrine Factors" [pos="-1.283,-0.811"] 
"Exercise Hardware" [pos="-1.174,-1.421"] 
"Exercise Prescription" [pos="-1.342,-1.360"] 
"Food and Nutrition (Risk)" [latent,pos="-1.489,-
1.183"] 
"HSIA (Risk)" [latent,pos="-1.576,-1.683"] 
"Individual Factors" [pos="-1.162,-0.861"] 
"Individual Readiness" [pos="-0.875,-1.121"] 
"Isolation and Confinement" [exposure,pos="-
1.656,-0.874"] 
"Loss of Crew Life" [outcome,pos="-0.676,-1.204"] 
"Loss of Mission Objectives" [outcome,pos="-
0.707,-1.515"] 
"Loss of Mission" [outcome,pos="-0.668,-1.650"] 
"Muscle Performance" [pos="-0.965,-0.980"] 
"Muscle Physiologic Changes" [pos="-1.120,-
1.015"] 
"Musculoskeletal Loads" [pos="-1.372,-0.907"] 
"Pharm (Risk)" [latent,pos="-1.014,-0.882"] 
"Resistive Exercise" [pos="-1.267,-1.022"] 
"Sensorimotor (Risk)" [latent,pos="-0.904,-0.876"] 
"Sleep (Risk)" [latent,pos="-1.564,-0.773"] 
"Task Performance" [outcome,pos="-0.773,-
1.414"] 
"Vehicle Design" [pos="-1.500,-1.583"] 
"Vibration Isolation System" [pos="-1.300,-1.539"] 
Fatigue [pos="-1.462,-0.773"] 
Humidity [pos="-1.528,-1.350"] 
Motivation [pos="-1.413,-1.036"] 
Scheduling [pos="-1.425,-1.517"] 
Temperature [pos="-1.547,-1.259"] 
"Aerobic Exercise" -> "Cardiovascular (Risk)" 
"Aerobic Exercise" -> "Endocrine Factors" 

"Aerobic Exercise" -> "Muscle Physiologic 
Changes" 
"Aerobic Fitness" -> "Individual Readiness" 
"Altered Gravity" -> "Effective Gravity Level" 
"Ambient CO2 Level" -> "Exercise Prescription" 
"Astronaut Selection" -> "Individual Factors" 
"Cardiovascular (Risk)" -> "Aerobic Fitness" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Exercise Hardware" 
"Distance from Earth" -> "Effective Mission 
Duration" 
"Distance from Earth" -> "Vehicle Design" 
"ECLS System" -> "Ambient CO2 Level" 
"ECLS System" -> Humidity 
"ECLS System" -> Temperature 
"Effective Gravity Level" -> "Musculoskeletal 
Loads" 
"Effective Mission Duration" -> "Muscle 
Physiologic Changes" 
"Effective Mission Duration" -> Motivation 
"Endocrine Factors" -> "Muscle Physiologic 
Changes" 
"Exercise Hardware" -> "Aerobic Exercise" 
"Exercise Hardware" -> "Exercise Prescription" 
"Exercise Hardware" -> "Resistive Exercise" 
"Exercise Hardware" -> "Vibration Isolation 
System" 
"Exercise Prescription" -> "Aerobic Exercise" 
"Exercise Prescription" -> "Resistive Exercise" 
"Exercise Prescription" -> Motivation 
"Food and Nutrition (Risk)" -> "Aerobic Exercise" 
"Food and Nutrition (Risk)" -> "Muscle Physiologic 
Changes" 
"Food and Nutrition (Risk)" -> "Resistive Exercise" 
"Food and Nutrition (Risk)" -> Fatigue 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "ECLS System" 
"HSIA (Risk)" -> "Vehicle Design" 
"HSIA (Risk)" -> "Vibration Isolation System" 
"HSIA (Risk)" -> Motivation 
"Individual Factors" -> "Endocrine Factors" 
"Individual Factors" -> "Muscle Physiologic 
Changes" 
"Individual Factors" -> Motivation 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> "Endocrine 
Factors" 
"Isolation and Confinement" -> Motivation 
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"Loss of Mission Objectives" -> "Loss of Mission" 
"Muscle Performance" -> "Individual Readiness" 
"Muscle Physiologic Changes" -> "Aerobic Fitness" 
"Muscle Physiologic Changes" -> "Cardiovascular 
(Risk)" 
"Muscle Physiologic Changes" -> "Muscle 
Performance" 
"Musculoskeletal Loads" -> "Muscle Physiologic 
Changes" 
"Pharm (Risk)" -> "Muscle Physiologic Changes" 
"Resistive Exercise" -> "Cardiovascular (Risk)" 
"Resistive Exercise" -> "Endocrine Factors" 
"Resistive Exercise" -> "Muscle Physiologic 
Changes" 
"Sensorimotor (Risk)" -> "Muscle Performance" 
"Sleep (Risk)" -> Fatigue 
"Task Performance" -> "Loss of Crew Life" 

"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "ECLS System" 
"Vehicle Design" -> "Vibration Isolation System" 
"Vibration Isolation System" -> "Exercise 
Prescription" 
Fatigue -> "Endocrine Factors" 
Fatigue -> Motivation 
Humidity -> "Exercise Prescription" 
Motivation -> "Aerobic Exercise" 
Motivation -> "Resistive Exercise" 
Scheduling -> "Exercise Prescription" 
Temperature -> "Exercise Prescription" 
} 
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Non-Ionizing Radiation Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Crew Capability" [pos="0.110,-0.365"] 
"Crew Health and Performance System" [pos="-
0.061,0.335"] 
"Detect Long Term Health Outcomes" 
[pos="0.356,0.406"] 
"Distance from Earth" [exposure,pos="-
0.436,0.285"] 
"Eye Injury" [pos="-0.147,-0.340"] 
"Flight Recertification" 
[outcome,pos="0.410,0.130"] 
"HSIA (Risk)" [latent,pos="-0.256,0.398"] 
"Helmet/Protective Visors" [pos="-0.227,0.080"] 
"Individual Readiness" [pos="0.012,-0.332"] 
"Long Term Health Outcomes" 
[outcome,pos="0.411,0.274"] 
"Loss of Mission Objectives" 
[outcome,pos="0.330,-0.427"] 
"Loss of Mission" [outcome,pos="0.449,-0.465"] 
"Medical Prevention Capability" 
[pos="0.008,0.195"] 
"Medical Treatment Capability" 
[pos="0.193,0.252"] 
"Protective Glasses" [pos="-0.026,-0.002"] 
"Protective Windows and Filters" [pos="-0.350,-
0.026"] 
"Skin Injury" [pos="-0.146,-0.175"] 
"Suit Design" [pos="-0.226,0.226"] 
"Task Performance" [outcome,pos="0.202,-
0.389"] 
"Vehicle Design" [pos="-0.310,0.285"] 
Laser [pos="-0.353,-0.340"] 
Radiation [exposure,pos="-0.438,-0.270"] 
Sunlight [pos="-0.353,-0.174"] 
Surveillance [pos="0.212,0.411"] 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 

"Distance from Earth" -> "Vehicle Design" 
"Eye Injury" -> "Flight Recertification" 
"Eye Injury" -> "Individual Readiness" 
"Eye Injury" -> "Long Term Health Outcomes" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Helmet/Protective Visors" -> "Eye Injury" 
"Helmet/Protective Visors" -> "Skin Injury" 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Prevention Capability" -> "Protective 
Glasses" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Protective Glasses" -> "Eye Injury" 
"Protective Windows and Filters" -> "Eye Injury" 
"Protective Windows and Filters" -> "Skin Injury" 
"Skin Injury" -> "Individual Readiness" 
"Skin Injury" -> "Long Term Health Outcomes" 
"Suit Design" -> "Helmet/Protective Visors" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Protective Windows and 
Filters" 
Laser -> "Eye Injury" 
Laser -> "Skin Injury" 
Radiation -> Laser 
Radiation -> Sunlight 
Sunlight -> "Eye Injury" 
Sunlight -> "Skin Injury" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Pharm Risk  
dag { 
"Altered Gravity" [exposure,pos="-1.648,-0.760"] 
"Antimicrobial Resistance" [pos="-1.347,-0.871"] 
"Behavioral (Risk)" [latent,pos="-1.130,-1.660"] 
"Bone Fracture (Risk)" [latent,pos="-1.135,-
1.154"] 
"Cardiovascular (Risk)" [latent,pos="-0.948,-
0.970"] 
"Crew Capability" [pos="-0.840,-1.599"] 
"Crew Health and Performance System" [pos="-
1.444,-1.596"] 
"DCS (Risk)" [latent,pos="-0.900,-1.070"] 
"Detect Long Term Health Outcomes" [pos="-
0.728,-0.812"] 
"Distance from Earth" [exposure,pos="-1.646,-
1.900"] 
"EVA (Risk)" [latent,pos="-0.831,-1.128"] 
"Effective Mission Duration" [pos="-1.630,-1.359"] 
"Electric Shock (Risk)" [latent,pos="-0.846,-1.017"] 
"Fluid Shifts" [pos="-1.573,-0.842"] 
"Food and Nutrition (Risk)" [latent,pos="-1.041,-
0.846"] 
"HSIA (Risk)" [latent,pos="-1.484,-1.783"] 
"Hostile Closed Environment" [exposure,pos="-
1.624,-1.212"] 
"Immune (Risk)" [latent,pos="-1.135,-1.055"] 
"In-Mission Shelf Life" [pos="-1.486,-1.129"] 
"Individual Factors" [pos="-1.407,-0.757"] 
"Individual Readiness" [pos="-0.868,-1.452"] 
"Long Term Health Outcomes" [outcome,pos="-
0.716,-0.995"] 
"Loss of Crew Life" [outcome,pos="-0.700,-1.265"] 
"Loss of Mission Objectives" [outcome,pos="-
0.753,-1.838"] 
"Loss of Mission" [outcome,pos="-0.708,-1.936"] 
"Manufacturer Shelf Life" [pos="-1.536,-1.479"] 
"Medical (Risk)" [latent,pos="-0.893,-1.290"] 
"Medical Diagnostic Capability" [pos="-1.308,-
0.760"] 
"Medical Prevention Capability" [pos="-1.298,-
0.986"] 
"Medical Treatment Capability" [pos="-1.116,-
1.802"] 
"Medication Compatibility" [pos="-1.301,-1.685"] 
"Microhost (Risk)" [latent,pos="-1.137,-0.950"] 
"Pharmaceutical Effectiveness" [pos="-1.344,-
1.197"] 
"Pharmaceutical Storage Conditions" [pos="-
1.444,-1.376"] 
"Pharmaceutical Toxicity" [pos="-1.306,-1.441"] 

"Radiation Carcinogenesis (Risk)" [latent,pos="-
1.015,-0.719"] 
"Renal Stone (Risk)" [latent,pos="-1.132,-1.352"] 
"Resource Availability" [pos="-1.401,-1.893"] 
"SANS (Risk)" [latent,pos="-1.179,-0.715"] 
"Side Effects" [pos="-0.992,-1.743"] 
"Sleep (Risk)" [latent,pos="-1.130,-1.558"] 
"Suit Damage" [pos="-1.037,-1.874"] 
"Suit Design" [pos="-1.268,-1.860"] 
"Task Performance" [outcome,pos="-0.814,-
1.732"] 
"Urinary Retention (Risk)" [latent,pos="-1.135,-
1.250"] 
"VTE (Concern)" [latent,pos="-1.133,-1.456"] 
"Vehicle Design" [pos="-1.566,-1.683"] 
Absorption [pos="-1.511,-1.027"] 
Distribution [pos="-1.489,-0.871"] 
Elimination [pos="-1.504,-0.963"] 
Evacuation [outcome,pos="-0.736,-1.513"] 
Exercise [pos="-1.538,-0.741"] 
Hydration [pos="-1.588,-1.004"] 
Metabolism [pos="-1.468,-0.798"] 
Pharmacodynamics [pos="-1.391,-1.067"] 
Pharmacogenomics [pos="-1.400,-0.939"] 
Pharmacokinetics [pos="-1.452,-1.024"] 
Radiation [exposure,pos="-1.667,-1.072"] 
Resupply [pos="-1.524,-1.889"] 
Surveillance [pos="-0.860,-0.715"] 
"Altered Gravity" -> "Fluid Shifts" 
"Antimicrobial Resistance" -> "Pharmaceutical 
Effectiveness" 
"Behavioral (Risk)" -> "Medical (Risk)" 
"Bone Fracture (Risk)" -> "Medical (Risk)" 
"Cardiovascular (Risk)" -> "Medical (Risk)" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medication Compatibility" 
"Crew Health and Performance System" -> 
"Pharmaceutical Storage Conditions" 
"Crew Health and Performance System" -> "Suit 
Design" 
"DCS (Risk)" -> "Medical (Risk)" 
"Distance from Earth" -> "Effective Mission 
Duration" 
"Distance from Earth" -> "Vehicle Design" 
"Distance from Earth" -> Resupply 
"EVA (Risk)" -> "Medical (Risk)" 
"Effective Mission Duration" -> "In-Mission Shelf 
Life" 
"Effective Mission Duration" -> Absorption 
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"Electric Shock (Risk)" -> "Medical (Risk)" 
"Fluid Shifts" -> Absorption 
"Fluid Shifts" -> Distribution 
"Fluid Shifts" -> Elimination 
"Fluid Shifts" -> Metabolism 
"Food and Nutrition (Risk)" -> "Medical (Risk)" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Medication Compatibility" 
"HSIA (Risk)" -> "Suit Design" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Pharmaceutical 
Storage Conditions" 
"Immune (Risk)" -> "Medical (Risk)" 
"In-Mission Shelf Life" -> "Pharmaceutical 
Effectiveness" 
"In-Mission Shelf Life" -> "Pharmaceutical 
Toxicity" 
"Individual Factors" -> Absorption 
"Individual Factors" -> Distribution 
"Individual Factors" -> Elimination 
"Individual Factors" -> Metabolism 
"Individual Factors" -> Pharmacogenomics 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Manufacturer Shelf Life" -> "In-Mission Shelf 
Life" 
"Manufacturer Shelf Life" -> "Pharmaceutical 
Storage Conditions" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Long Term Health Outcomes" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Medical (Risk)" -> Evacuation 
"Medical Diagnostic Capability" -> "SANS (Risk)" 
"Medical Prevention Capability" -> "Behavioral 
(Risk)" 
"Medical Prevention Capability" -> "Bone Fracture 
(Risk)" 
"Medical Prevention Capability" -> "Food and 
Nutrition (Risk)" 
"Medical Prevention Capability" -> "Immune 
(Risk)" 
"Medical Prevention Capability" -> "Microhost 
(Risk)" 
"Medical Prevention Capability" -> "Radiation 
Carcinogenesis (Risk)" 
"Medical Prevention Capability" -> "Renal Stone 
(Risk)" 
"Medical Prevention Capability" -> "SANS (Risk)" 

"Medical Prevention Capability" -> "Side Effects" 
"Medical Prevention Capability" -> "Sleep (Risk)" 
"Medical Prevention Capability" -> "Urinary 
Retention (Risk)" 
"Medical Prevention Capability" -> "VTE 
(Concern)" 
"Medical Treatment Capability" -> "Food and 
Nutrition (Risk)" 
"Medical Treatment Capability" -> "Medical (Risk)" 
"Medical Treatment Capability" -> "Side Effects" 
"Medication Compatibility" -> "Medical Treatment 
Capability" 
"Medication Compatibility" -> "Suit Design" 
"Microhost (Risk)" -> "Medical (Risk)" 
"Pharmaceutical Effectiveness" -> "Medical 
Diagnostic Capability" 
"Pharmaceutical Effectiveness" -> "Medical 
Prevention Capability" 
"Pharmaceutical Effectiveness" -> "Medical 
Treatment Capability" 
"Pharmaceutical Effectiveness" -> 
"Pharmaceutical Toxicity" 
"Pharmaceutical Storage Conditions" -> "In-
Mission Shelf Life" 
"Pharmaceutical Toxicity" -> "Medical (Risk)" 
"Radiation Carcinogenesis (Risk)" -> "Long Term 
Health Outcomes" 
"Renal Stone (Risk)" -> "Medical (Risk)" 
"Resource Availability" -> "Crew Health and 
Performance System" 
"SANS (Risk)" -> "Medical (Risk)" 
"Side Effects" -> "Individual Readiness" 
"Side Effects" -> "Medical (Risk)" 
"Sleep (Risk)" -> "Medical (Risk)" 
"Suit Damage" -> "Loss of Mission Objectives" 
"Suit Design" -> "Medical Treatment Capability" 
"Suit Design" -> "Suit Damage" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Urinary Retention (Risk)" -> "Medical (Risk)" 
"VTE (Concern)" -> "Medical (Risk)" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
Absorption -> "Pharmaceutical Effectiveness" 
Absorption -> Pharmacokinetics 
Distribution -> Pharmacokinetics 
Elimination -> Pharmacokinetics 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Exercise -> Metabolism 
Hydration -> Absorption 
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Hydration -> Distribution 
Metabolism -> Pharmacokinetics 
Pharmacodynamics -> "Pharmaceutical 
Effectiveness" 
Pharmacogenomics -> Metabolism 
Pharmacogenomics -> Pharmacodynamics 

Pharmacokinetics -> Pharmacodynamics 
Radiation -> "In-Mission Shelf Life" 
Resupply -> "Resource Availability" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Carcinogenesis Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Astronaut Selection" [pos="0.179,-0.433"] 
"Biologic Response" [pos="0.161,-0.201"] 
"Biomedical Exposures" [pos="0.101,-0.394"] 
"Cancer Model" [pos="-0.088,-0.163"] 
"Cancer Treatment" [pos="0.438,-0.228"] 
"Charged Particles" [pos="-0.268,-0.325"] 
"Crew Health and Performance System" [pos="-
0.124,0.284"] 
"Detect Long Term Health Outcomes" 
[pos="0.373,-0.097"] 
"Detect Radiation" [pos="-0.206,-0.160"] 
"Distance from Earth" [exposure,pos="-
0.418,0.288"] 
"Effective Mission Duration" [pos="-0.112,0.177"] 
"Estimated Career Dose" [pos="0.219,0.178"] 
"Estimated Dose Rate" [pos="-0.006,-0.337"] 
"Estimated Mission Radiation Dose" [pos="-
0.007,-0.005"] 
"Extraterrestrial Surface" [pos="-0.417,0.008"] 
"Flight Recertification" 
[outcome,pos="0.413,0.319"] 
"Galactic Cosmic Radiation" [pos="-0.372,-0.286"] 
"Gamma Rays" [pos="-0.344,-0.198"] 
"HSIA (Risk)" [latent,pos="-0.203,0.396"] 
"Intervention Measures" [pos="-0.106,-0.437"] 
"Long Term Health Outcomes" 
[outcome,pos="0.413,-0.416"] 
"Medical Prevention Capability" 
[pos="0.119,0.288"] 
"Modifiable Individual Factors" [pos="0.227,-
0.342"] 
"Non-Modifiable Individual Factors" [pos="0.240,-
0.031"] 
"Nuclear Technology" [pos="-0.413,0.185"] 
"Pharm (Risk)" [latent,pos="0.039,0.395"] 
"Prior Mission Exposures" [pos="0.048,0.177"] 
"Radiation Monitors" [pos="-0.207,0.081"] 
"Solar Cycle" [pos="-0.447,-0.435"] 
"Solar Particle Event" [pos="-0.348,-0.450"] 
"Trapped Radiation" [pos="-0.366,-0.368"] 
"Vehicle Design" [pos="-0.289,0.287"] 
Cancer [outcome,pos="0.298,-0.199"] 
Neutrons [pos="-0.268,0.005"] 
Radiation [exposure,pos="-0.430,-0.163"] 
Shielding [pos="-0.316,0.121"] 
Surveillance [pos="0.374,0.053"] 
"Astronaut Selection" -> "Modifiable Individual 
Factors" 

"Astronaut Selection" -> "Non-Modifiable 
Individual Factors" 
"Biologic Response" -> Cancer 
"Biomedical Exposures" -> "Biologic Response" 
"Cancer Model" -> "Estimated Mission Radiation 
Dose" 
"Cancer Treatment" -> "Long Term Health 
Outcomes" 
"Charged Particles" -> "Biologic Response" 
"Charged Particles" -> "Detect Radiation" 
"Charged Particles" -> Neutrons 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Radiation Monitors" 
"Detect Long Term Health Outcomes" -> "Cancer 
Treatment" 
"Detect Radiation" -> "Cancer Model" 
"Detect Radiation" -> "Estimated Dose Rate" 
"Detect Radiation" -> "Estimated Mission 
Radiation Dose" 
"Detect Radiation" -> "Intervention Measures" 
"Distance from Earth" -> "Vehicle Design" 
"Effective Mission Duration" -> "Estimated 
Mission Radiation Dose" 
"Estimated Career Dose" -> "Flight Recertification" 
"Estimated Dose Rate" -> "Biologic Response" 
"Estimated Mission Radiation Dose" -> "Estimated 
Career Dose" 
"Extraterrestrial Surface" -> Neutrons 
"Galactic Cosmic Radiation" -> "Charged Particles" 
"Gamma Rays" -> "Biologic Response" 
"Gamma Rays" -> "Detect Radiation" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Intervention Measures" -> "Estimated Dose Rate" 
"Intervention Measures" -> "Estimated Mission 
Radiation Dose" 
"Medical Prevention Capability" -> "Biologic 
Response" 
"Modifiable Individual Factors" -> "Biologic 
Response" 
"Modifiable Individual Factors" -> Cancer 
"Non-Modifiable Individual Factors" -> "Biologic 
Response" 
"Non-Modifiable Individual Factors" -> Cancer 
"Non-Modifiable Individual Factors" -> 
Surveillance 
"Nuclear Technology" -> "Charged Particles" 
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"Nuclear Technology" -> "Effective Mission 
Duration" 
"Nuclear Technology" -> "Gamma Rays" 
"Nuclear Technology" -> Neutrons 
"Nuclear Technology" -> Shielding 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Prior Mission Exposures" -> "Estimated Career 
Dose" 
"Radiation Monitors" -> "Detect Radiation" 
"Solar Cycle" -> "Galactic Cosmic Radiation" 
"Solar Cycle" -> "Solar Particle Event" 
"Solar Cycle" -> "Trapped Radiation" 
"Solar Particle Event" -> "Charged Particles" 
"Trapped Radiation" -> "Charged Particles" 

"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> Shielding 
Cancer -> "Detect Long Term Health Outcomes" 
Cancer -> "Long Term Health Outcomes" 
Neutrons -> "Biologic Response" 
Neutrons -> "Detect Radiation" 
Radiation -> "Charged Particles" 
Radiation -> Neutrons 
Shielding -> Neutrons 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Renal Stone Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.451,-0.281"] 
"Astronaut Selection" [pos="-0.031,-0.457"] 
"Bone Fracture (Risk)" [latent,pos="-0.395,-
0.367"] 
"Bone Remodeling" [pos="-0.296,-0.302"] 
"CO2 (Risk)" [latent,pos="-0.384,-0.182"] 
"Crew Capability" [pos="0.214,-0.369"] 
"Crew Health and Performance System" [pos="-
0.174,0.363"] 
"Detect Long Term Health Outcomes" 
[pos="0.402,0.131"] 
"Detect MRM/Stone" [pos="-0.048,0.017"] 
"Distance from Earth" [exposure,pos="-
0.434,0.381"] 
"Flight Recertification" 
[outcome,pos="0.384,0.387"] 
"Food and Nutrition (Risk)" [latent,pos="-0.405,-
0.447"] 
"HSIA (Risk)" [latent,pos="-0.308,0.403"] 
"Hostile Closed Environment" [exposure,pos="-
0.411,-0.040"] 
"Individual Factors" [pos="-0.031,-0.282"] 
"Individual Readiness" [pos="0.232,-0.256"] 
"K+ Citrate" [pos="-0.122,0.124"] 
"Long Term Health Outcomes" 
[outcome,pos="0.407,-0.012"] 
"Loss of Crew Life" [outcome,pos="0.416,-0.162"] 
"Loss of Mission Objectives" 
[outcome,pos="0.381,-0.442"] 
"Loss of Mission" [outcome,pos="0.452,-0.470"] 
"Medical Illness" [pos="0.207,-0.138"] 
"Medical Monitoring Capability" 
[pos="0.027,0.360"] 
"Medical Prevention Capability" [pos="-
0.146,0.271"] 
"Medical Treatment Capability" 
[pos="0.251,0.305"] 
"Microhost (Risk)" [latent,pos="-0.175,-0.453"] 
"Mineralized Renal Material" [pos="-0.179,-
0.106"] 
"Percutaneous Nephrostomy" 
[pos="0.125,0.169"] 
"Pharm (Risk)" [latent,pos="0.187,0.401"] 
"Resistive Exercise" [pos="-0.222,-0.352"] 
"Task Performance" [outcome,pos="0.292,-
0.416"] 
"Ultrasound Manipulation" [pos="0.086,-0.019"] 

"Urinary Retention (Risk)" [latent,pos="0.109,-
0.307"] 
"Urine Chemistry" [pos="-0.298,-0.142"] 
"Urine Concentration" [pos="-0.283,-0.008"] 
"Urine Flow" [pos="0.110,-0.142"] 
"Vehicle Design" [pos="-0.316,0.294"] 
"Water Intake" [pos="-0.274,0.173"] 
Bisphosphonates [pos="-0.138,-0.267"] 
Evacuation [outcome,pos="0.346,-0.310"] 
Humidity [pos="-0.405,0.212"] 
Hydration [pos="-0.347,0.090"] 
Medications [pos="0.268,0.005"] 
Microbiome [pos="-0.119,-0.365"] 
Nephrolithiasis [pos="-0.085,-0.137"] 
Nutrients [pos="-0.298,-0.435"] 
Surveillance [pos="0.337,0.237"] 
Tamsulosin [pos="0.200,0.086"] 
Thiazides [pos="-0.067,0.133"] 
Ultrasound [pos="0.031,0.121"] 
Ureterolithiasis [pos="0.020,-0.138"] 
"Altered Gravity" -> "Bone Remodeling" 
"Astronaut Selection" -> "Individual Factors" 
"Bone Fracture (Risk)" -> "Bone Remodeling" 
"Bone Remodeling" -> "Urine Chemistry" 
"CO2 (Risk)" -> "Urine Chemistry" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Monitoring Capability" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
"Resistive Exercise" 
"Detect MRM/Stone" -> "Ultrasound 
Manipulation" 
"Distance from Earth" -> "Vehicle Design" 
"Food and Nutrition (Risk)" -> Nutrients 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> Hydration 
"Individual Factors" -> Nephrolithiasis 
"Individual Readiness" -> "Crew Capability" 
"K+ Citrate" -> "Urine Chemistry" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Illness" -> "Individual Readiness" 
"Medical Illness" -> "Long Term Health Outcomes" 
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"Medical Illness" -> "Loss of Crew Life" 
"Medical Illness" -> Evacuation 
"Medical Monitoring Capability" -> Ultrasound 
"Medical Prevention Capability" -> "Bone 
Remodeling" 
"Medical Prevention Capability" -> "K+ Citrate" 
"Medical Prevention Capability" -> "Urine 
Chemistry" 
"Medical Prevention Capability" -> "Water Intake" 
"Medical Prevention Capability" -> 
Bisphosphonates 
"Medical Prevention Capability" -> Thiazides 
"Medical Treatment Capability" -> "Percutaneous 
Nephrostomy" 
"Medical Treatment Capability" -> "Ultrasound 
Manipulation" 
"Medical Treatment Capability" -> "Water Intake" 
"Medical Treatment Capability" -> Medications 
"Medical Treatment Capability" -> Tamsulosin 
"Microhost (Risk)" -> Microbiome 
"Mineralized Renal Material" -> "Detect 
MRM/Stone" 
"Mineralized Renal Material" -> Nephrolithiasis 
"Percutaneous Nephrostomy" -> "Medical Illness" 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Resistive Exercise" -> "Bone Remodeling" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Ultrasound Manipulation" -> Ureterolithiasis 
"Urinary Retention (Risk)" -> "Urine Flow" 

"Urine Chemistry" -> "Mineralized Renal Material" 
"Urine Concentration" -> "Urine Chemistry" 
"Urine Flow" -> "Medical Illness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> Humidity 
"Water Intake" -> "Urine Flow" 
"Water Intake" -> Hydration 
Bisphosphonates -> "Bone Remodeling" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Humidity -> Hydration 
Hydration -> "Urine Concentration" 
Medications -> "Individual Readiness" 
Medications -> "Long Term Health Outcomes" 
Medications -> "Loss of Crew Life" 
Medications -> "Medical Illness" 
Medications -> Evacuation 
Microbiome -> "Urine Chemistry" 
Nephrolithiasis -> "Detect MRM/Stone" 
Nephrolithiasis -> "Flight Recertification" 
Nephrolithiasis -> Ureterolithiasis 
Nutrients -> "Bone Remodeling" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Tamsulosin -> "Urine Flow" 
Thiazides -> "Urine Chemistry" 
Ultrasound -> "Detect MRM/Stone" 
Ultrasound -> "Percutaneous Nephrostomy" 
Ureterolithiasis -> "Urine Flow" 
} 
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SANS Risk  
dag { 
"Altered Gravity" [exposure,pos="-1.879,0.350"] 
"Astronaut Selection" [pos="-1.840,1.350"] 
"Brain Structural Changes" [pos="-1.430,0.948"] 
"CO2 (Risk)" [latent,pos="-1.430,-0.438"] 
"Cardiovascular (Risk)" [latent,pos="-0.721,-
0.664"] 
"Chorioretinal Folds" [pos="-0.226,-0.496"] 
"Crew Capability" [pos="0.705,-1.715"] 
"Crew Health and Performance System" [pos="-
0.831,-2.948"] 
"Detect Brain Structural Changes" [pos="-
0.015,1.193"] 
"Detect Intracranial Pressure Changes" [pos="-
1.042,0.539"] 
"Detect Long Term Health Outcomes" 
[pos="0.600,0.801"] 
"Detect Ocular Structural Changes" [pos="-0.039,-
1.701"] 
"Detect Visual Changes" [pos="0.133,-2.151"] 
"Distance from Earth" [exposure,pos="-1.845,-
2.961"] 
"Flight Recertification" [outcome,pos="0.698,-
0.710"] 
"Fluid Shifts" [pos="-1.590,0.356"] 
"Food and Nutrition (Risk)" [latent,pos="-1.636,-
2.233"] 
"Globe Flattening" [pos="-0.555,-1.068"] 
"HSIA (Risk)" [latent,pos="-1.239,-2.553"] 
"Individual Factors" [pos="-0.523,1.350"] 
"Individual Readiness" [pos="0.456,-1.443"] 
"Intracranial Pressure Changes" [pos="-1.146,-
0.053"] 
"Intracranial Pressure Monitoring" [pos="-0.749,-
1.552"] 
"Long Term Health Outcomes" 
[outcome,pos="0.649,0.033"] 
"Loss of Mission Objectives" 
[outcome,pos="0.657,-2.973"] 
"Loss of Mission" [outcome,pos="0.761,-3.490"] 
"Lower Body Negative Pressure" [pos="-1.767,-
0.679"] 
"Medical Prevention Capability" [pos="-1.710,-
1.538"] 
"Medical Treatment Capability" [pos="0.204,-
2.941"] 
"Optic Disc Edema" [pos="-0.597,-0.217"] 
"Optical Coherence Tomography" [pos="-0.492,-
2.021"] 
"Pharm (Risk)" [latent,pos="-1.901,-1.804"] 

"Physiologic Monitoring Capability" [pos="-0.805,-
2.464"] 
"Refractive Error Shift" [pos="0.009,-1.000"] 
"Retinal Nerve Fiber Layer Atrophy" [pos="-
0.171,0.335"] 
"Sleep (Risk)" [latent,pos="-1.606,-0.149"] 
"Task Performance" [outcome,pos="0.716,-
2.226"] 
"Thigh Cuffs" [pos="-1.617,-0.918"] 
"Vascular Congestion" [pos="-1.141,-0.891"] 
"Vehicle Design" [pos="-1.441,-2.948"] 
"Visual Acuity Test" [pos="-0.262,-2.758"] 
"Visual Field Defect" [pos="0.154,0.216"] 
"Visual Fields Test" [pos="-0.299,-2.222"] 
Fundoscopy [pos="-0.922,-1.804"] 
Lenses [pos="0.380,-2.273"] 
MRI [pos="-0.653,0.492"] 
Medications [pos="-1.450,-1.102"] 
Supplements [pos="-1.404,-1.708"] 
Surveillance [pos="0.361,1.351"] 
Ultrasound [pos="-1.104,-2.056"] 
"Altered Gravity" -> "Fluid Shifts" 
"Astronaut Selection" -> "Individual Factors" 
"Brain Structural Changes" -> "Detect Brain 
Structural Changes" 
"Brain Structural Changes" -> "Long Term Health 
Outcomes" 
"CO2 (Risk)" -> "Intracranial Pressure Changes" 
"Cardiovascular (Risk)" -> "Optic Disc Edema" 
"Chorioretinal Folds" -> "Detect Ocular Structural 
Changes" 
"Chorioretinal Folds" -> "Flight Recertification" 
"Chorioretinal Folds" -> "Visual Field Defect" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
"Physiologic Monitoring Capability" 
"Detect Brain Structural Changes" -> "Detect Long 
Term Health Outcomes" 
"Detect Intracranial Pressure Changes" -> "Detect 
Long Term Health Outcomes" 
"Detect Intracranial Pressure Changes" -> "Flight 
Recertification" 
"Detect Intracranial Pressure Changes" -> 
"Medical Treatment Capability" 
"Detect Ocular Structural Changes" -> "Detect 
Long Term Health Outcomes" 
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"Detect Ocular Structural Changes" -> "Flight 
Recertification" 
"Detect Visual Changes" -> "Medical Treatment 
Capability" 
"Distance from Earth" -> "Vehicle Design" 
"Fluid Shifts" -> "Brain Structural Changes" 
"Fluid Shifts" -> "Intracranial Pressure Changes" 
"Fluid Shifts" -> "Vascular Congestion" 
"Food and Nutrition (Risk)" -> Supplements 
"Globe Flattening" -> "Chorioretinal Folds" 
"Globe Flattening" -> "Detect Ocular Structural 
Changes" 
"Globe Flattening" -> "Refractive Error Shift" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Individual Factors" -> "Brain Structural Changes" 
"Individual Factors" -> "Chorioretinal Folds" 
"Individual Factors" -> "Globe Flattening" 
"Individual Factors" -> "Intracranial Pressure 
Changes" 
"Individual Factors" -> "Optic Disc Edema" 
"Individual Factors" -> "Refractive Error Shift" 
"Individual Factors" -> "Retinal Nerve Fiber Layer 
Atrophy" 
"Individual Factors" -> "Vascular Congestion" 
"Individual Factors" -> "Visual Field Defect" 
"Individual Readiness" -> "Crew Capability" 
"Intracranial Pressure Changes" -> "Brain 
Structural Changes" 
"Intracranial Pressure Changes" -> "Detect 
Intracranial Pressure Changes" 
"Intracranial Pressure Changes" -> "Globe 
Flattening" 
"Intracranial Pressure Changes" -> "Long Term 
Health Outcomes" 
"Intracranial Pressure Changes" -> "Optic Disc 
Edema" 
"Intracranial Pressure Monitoring" -> "Detect 
Intracranial Pressure Changes" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Lower Body Negative Pressure" -> "Vascular 
Congestion" 
"Medical Prevention Capability" -> "Lower Body 
Negative Pressure" 
"Medical Prevention Capability" -> "Thigh Cuffs" 
"Medical Prevention Capability" -> Medications 
"Medical Prevention Capability" -> Supplements 
"Medical Treatment Capability" -> Lenses 

"Optic Disc Edema" -> "Chorioretinal Folds" 
"Optic Disc Edema" -> "Detect Ocular Structural 
Changes" 
"Optic Disc Edema" -> "Retinal Nerve Fiber Layer 
Atrophy" 
"Optic Disc Edema" -> "Visual Field Defect" 
"Optical Coherence Tomography" -> "Detect 
Ocular Structural Changes" 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Physiologic Monitoring Capability" -> 
"Intracranial Pressure Monitoring" 
"Physiologic Monitoring Capability" -> "Optical 
Coherence Tomography" 
"Physiologic Monitoring Capability" -> "Visual 
Acuity Test" 
"Physiologic Monitoring Capability" -> "Visual 
Fields Test" 
"Physiologic Monitoring Capability" -> Fundoscopy 
"Physiologic Monitoring Capability" -> Ultrasound 
"Refractive Error Shift" -> "Detect Visual Changes" 
"Refractive Error Shift" -> "Individual Readiness" 
"Retinal Nerve Fiber Layer Atrophy" -> "Visual 
Field Defect" 
"Sleep (Risk)" -> "Intracranial Pressure Changes" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Thigh Cuffs" -> "Vascular Congestion" 
"Vascular Congestion" -> "Globe Flattening" 
"Vascular Congestion" -> "Intracranial Pressure 
Changes" 
"Vascular Congestion" -> "Optic Disc Edema" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Visual Acuity Test" -> "Detect Visual Changes" 
"Visual Field Defect" -> "Detect Visual Changes" 
"Visual Field Defect" -> "Individual Readiness" 
"Visual Field Defect" -> "Long Term Health 
Outcomes" 
"Visual Fields Test" -> "Detect Visual Changes" 
Fundoscopy -> "Detect Ocular Structural Changes" 
Lenses -> "Individual Readiness" 
MRI -> "Detect Brain Structural Changes" 
MRI -> "Detect Ocular Structural Changes" 
Medications -> "Intracranial Pressure Changes" 
Medications -> "Vascular Congestion" 
Supplements -> "Intracranial Pressure Changes" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Ultrasound -> "Detect Ocular Structural Changes" 
} 
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Sensorimotor Risk  
dag { 
"Altered Gravity" [exposure,pos="-1.687,-1.418"] 
"Artificial Gravity" [pos="-1.717,-0.920"] 
"Astronaut Selection" [pos="-0.694,-2.494"] 
"Balance Training" [pos="0.371,0.343"] 
"Crew Capability" [pos="0.668,-1.296"] 
"Crew Health and Performance System" [pos="-
0.940,1.204"] 
"Distance from Earth" [exposure,pos="-
1.684,0.867"] 
"Exercise Hardware" [pos="-0.734,0.764"] 
"Fine Motor Control" [pos="0.034,-1.055"] 
"Fluid Shifts" [pos="-1.406,-2.461"] 
"HSIA (Risk)" [latent,pos="-1.442,1.241"] 
"Hostile Closed Environment" [exposure,pos="-
1.615,-2.058"] 
"Individual Factors" [pos="-0.588,-1.188"] 
"Individual Readiness" [pos="0.499,-1.045"] 
"Loss of Crew Life" [outcome,pos="0.724,-0.434"] 
"Loss of Mission Objectives" 
[outcome,pos="0.689,-2.314"] 
"Loss of Mission" [outcome,pos="0.735,-2.826"] 
"Medical Prevention Capability" [pos="-
0.197,0.807"] 
"Medical Treatment Capability" 
[pos="0.646,0.867"] 
"Morphological G-Receptor Changes" [pos="-
1.578,-0.356"] 
"Motion Sickness" [pos="-0.071,-2.551"] 
"Multi-Sensory Integration Alterations" [pos="-
0.549,-0.453"] 
"Muscle (Risk)" [latent,pos="-0.550,-0.002"] 
"Muscle Physiologic Changes" [pos="-
1.102,0.385"] 
"Musculoskeletal Loads" [pos="-1.638,0.424"] 
"Pharm (Risk)" [latent,pos="0.237,1.213"] 
"Postural Control and Locomotion" [pos="-
0.042,0.159"] 
"Proprioception Change" [pos="-0.885,-0.114"] 
"SANS (Risk)" [latent,pos="-1.027,-2.537"] 
"Self-Administered Rehab" [pos="0.477,-0.024"] 
"Sensory Augmentation" [pos="0.218,0.657"] 
"Spatial Orientation" [pos="-0.328,-1.358"] 
"Strobe Goggles" [pos="0.499,-0.385"] 
"Task Performance" [outcome,pos="0.720,-
1.867"] 
"Traumatic Injury" [pos="0.408,-2.616"] 
"Vehicle Design" [pos="-1.445,0.824"] 
"Vehicle Dynamics" [pos="-0.338,-2.142"] 
"Vestibular Gain Change" [pos="-1.288,-1.195"] 

"Vestibular Motor Neuron Change" [pos="-0.930,-
0.965"] 
"Vison and Gaze Control" [pos="-0.944,-1.616"] 
Exercise [pos="-0.616,0.411"] 
Radiation [exposure,pos="-1.694,-2.764"] 
"Altered Gravity" -> "Fluid Shifts" 
"Altered Gravity" -> "Morphological G-Receptor 
Changes" 
"Altered Gravity" -> "Multi-Sensory Integration 
Alterations" 
"Altered Gravity" -> "Musculoskeletal Loads" 
"Altered Gravity" -> "Vestibular Gain Change" 
"Artificial Gravity" -> "Altered Gravity" 
"Astronaut Selection" -> "Individual Factors" 
"Balance Training" -> "Motion Sickness" 
"Balance Training" -> "Postural Control and 
Locomotion" 
"Balance Training" -> "Spatial Orientation" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Exercise Hardware" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Distance from Earth" -> "Vehicle Design" 
"Exercise Hardware" -> Exercise 
"Fine Motor Control" -> "Individual Readiness" 
"Fine Motor Control" -> "Postural Control and 
Locomotion" 
"Fluid Shifts" -> "SANS (Risk)" 
"Fluid Shifts" -> "Vison and Gaze Control" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> "Multi-Sensory 
Integration Alterations" 
"Hostile Closed Environment" -> "Vison and Gaze 
Control" 
"Individual Factors" -> "Fine Motor Control" 
"Individual Factors" -> "Motion Sickness" 
"Individual Factors" -> "Multi-Sensory Integration 
Alterations" 
"Individual Factors" -> "Postural Control and 
Locomotion" 
"Individual Factors" -> "Proprioception Change" 
"Individual Factors" -> "Spatial Orientation" 
"Individual Factors" -> "Vestibular Motor Neuron 
Change" 
"Individual Factors" -> "Vison and Gaze Control" 



Appendix C – Risk Formatting Instructions 

203 

"Individual Readiness" -> "Crew Capability" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical Prevention Capability" -> "Balance 
Training" 
"Medical Prevention Capability" -> "Self-
Administered Rehab" 
"Medical Prevention Capability" -> "Sensory 
Augmentation" 
"Medical Prevention Capability" -> "Strobe 
Goggles" 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Morphological G-Receptor Changes" -> 
"Vestibular Gain Change" 
"Motion Sickness" -> "Fine Motor Control" 
"Motion Sickness" -> "Individual Readiness" 
"Motion Sickness" -> "Postural Control and 
Locomotion" 
"Multi-Sensory Integration Alterations" -> "Fine 
Motor Control" 
"Multi-Sensory Integration Alterations" -> 
"Motion Sickness" 
"Multi-Sensory Integration Alterations" -> 
"Postural Control and Locomotion" 
"Multi-Sensory Integration Alterations" -> "Spatial 
Orientation" 
"Muscle (Risk)" -> "Individual Readiness" 
"Muscle Physiologic Changes" -> "Multi-Sensory 
Integration Alterations" 
"Muscle Physiologic Changes" -> "Muscle (Risk)" 
"Muscle Physiologic Changes" <-> Exercise 
"Musculoskeletal Loads" -> "Muscle Physiologic 
Changes" 
"Musculoskeletal Loads" -> "Proprioception 
Change" 
"Musculoskeletal Loads" -> "Vestibular Gain 
Change" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Postural Control and Locomotion" -> "Individual 
Readiness" 
"Postural Control and Locomotion" -> "Traumatic 
Injury" 
"Proprioception Change" -> "Multi-Sensory 
Integration Alterations" 

"SANS (Risk)" -> "Individual Readiness" 
"Self-Administered Rehab" -> "Fine Motor 
Control" 
"Self-Administered Rehab" -> "Motion Sickness" 
"Self-Administered Rehab" -> "Postural Control 
and Locomotion" 
"Self-Administered Rehab" -> "Spatial 
Orientation" 
"Sensory Augmentation" -> "Fine Motor Control" 
"Sensory Augmentation" -> "Spatial Orientation" 
"Spatial Orientation" -> "Fine Motor Control" 
"Spatial Orientation" -> "Motion Sickness" 
"Strobe Goggles" -> "Motion Sickness" 
"Task Performance" -> "Loss of Crew Life" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Traumatic Injury" -> "Individual Readiness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Vehicle Dynamics" 
"Vehicle Dynamics" -> "Motion Sickness" 
"Vestibular Gain Change" -> "Multi-Sensory 
Integration Alterations" 
"Vestibular Gain Change" -> "Muscle Physiologic 
Changes" 
"Vestibular Gain Change" -> "Proprioception 
Change" 
"Vestibular Gain Change" -> "Spatial Orientation" 
"Vestibular Gain Change" -> "Vestibular Motor 
Neuron Change" 
"Vestibular Gain Change" -> "Vison and Gaze 
Control" 
"Vestibular Motor Neuron Change" -> "Multi-
Sensory Integration Alterations" 
"Vison and Gaze Control" -> "Multi-Sensory 
Integration Alterations" 
Exercise -> "Postural Control and Locomotion" 
Radiation -> "Multi-Sensory Integration 
Alterations" 
Radiation -> "Vestibular Motor Neuron Change" 
Radiation -> "Vison and Gaze Control" 
} 
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Sleep Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.393,-0.177"] 
"Astronaut Selection" [pos="-0.153,-0.447"] 
"Behavioral (Risk)" [latent,pos="0.072,-0.460"] 
"CO2, Hypoxia, Acoustic (Risks)" [latent,pos="-
0.398,0.178"] 
"Circadian Misalignment" [pos="0.031,-0.267"] 
"Crew Capability" [pos="0.270,-0.317"] 
"Crew Health and Performance System" [pos="-
0.173,0.306"] 
"Detect Environmental Conditions" [pos="-
0.125,0.122"] 
"Detect Long Term Health Outcomes" 
[pos="0.376,0.176"] 
"Distance from Earth" [exposure,pos="-
0.428,0.290"] 
"ECLS System" [pos="-0.016,0.402"] 
"EVA (Risk)" [latent,pos="-0.317,-0.454"] 
"Environmental Conditions" [pos="-0.289,0.063"] 
"Environmental Control" [pos="-0.112,0.003"] 
"Environmental Monitoring Capability" [pos="-
0.145,0.206"] 
"Food and Nutrition (Risk)" [latent,pos="-0.399,-
0.046"] 
"HSIA (Risk)" [latent,pos="-0.381,0.402"] 
"Hostile Closed Environment" [exposure,pos="-
0.403,-0.283"] 
"Immune (Risk)" [latent,pos="0.010,0.021"] 
"Individual Factors" [pos="-0.111,-0.245"] 
"Individual Readiness" [pos="0.193,-0.274"] 
"Isolation and Confinement" [exposure,pos="-
0.413,-0.390"] 
"Long Term Health Outcomes" 
[outcome,pos="0.402,0.047"] 
"Loss of Crew Life" [outcome,pos="0.434,-0.204"] 
"Loss of Mission Objectives" 
[outcome,pos="0.398,-0.434"] 
"Loss of Mission" [outcome,pos="0.458,-0.465"] 
"Medical (Risk)" [latent,pos="0.275,-0.021"] 
"Medical Prevention Capability" 
[pos="0.066,0.117"] 
"Medical Treatment Capability" 
[pos="0.184,0.186"] 
"Pharm (Risk)" [latent,pos="0.071,0.364"] 
"Schedule Shifting" [pos="-0.264,-0.115"] 
"Sleep Deficiencies" [pos="-0.040,-0.110"] 
"Sleep Inertia" [pos="0.141,-0.154"] 
"Task Performance" [outcome,pos="0.309,-
0.403"] 

"Team (Risk)" [latent,pos="0.166,-0.460"] 
"Vehicle Design" [pos="-0.309,0.287"] 
Fatigue [pos="-0.040,-0.400"] 
Insomnia [pos="0.058,-0.052"] 
Radiation [exposure,pos="-0.423,0.078"] 
Stress [pos="-0.234,-0.229"] 
Surveillance [pos="0.277,0.280"] 
Workload [pos="-0.261,-0.353"] 
"Altered Gravity" -> "Environmental Conditions" 
"Altered Gravity" -> Stress 
"Astronaut Selection" -> "Individual Factors" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"CO2, Hypoxia, Acoustic (Risks)" -> 
"Environmental Conditions" 
"Circadian Misalignment" -> "Behavioral (Risk)" 
"Circadian Misalignment" -> "Sleep Deficiencies" 
"Circadian Misalignment" -> "Sleep Inertia" 
"Circadian Misalignment" -> Fatigue 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Environmental Monitoring Capability" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Detect Environmental Conditions" -> 
"Environmental Control" 
"Detect Environmental Conditions" -> "Medical 
Prevention Capability" 
"Detect Environmental Conditions" -> "Schedule 
Shifting" 
"Detect Environmental Conditions" -> Stress 
"Distance from Earth" -> "Vehicle Design" 
"ECLS System" -> "Environmental Control" 
"ECLS System" -> "Environmental Monitoring 
Capability" 
"EVA (Risk)" -> Workload 
"Environmental Conditions" -> "Circadian 
Misalignment" 
"Environmental Conditions" -> "Detect 
Environmental Conditions" 
"Environmental Conditions" -> "Sleep 
Deficiencies" 
"Environmental Control" -> "Sleep Deficiencies" 
"Environmental Monitoring Capability" -> "Detect 
Environmental Conditions" 
"Food and Nutrition (Risk)" -> "Sleep Deficiencies" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
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"HSIA (Risk)" -> "ECLS System" 
"HSIA (Risk)" -> "Vehicle Design" 
"HSIA (Risk)" -> Workload 
"Hostile Closed Environment" -> Stress 
"Immune (Risk)" -> "Medical (Risk)" 
"Individual Factors" -> "Circadian Misalignment" 
"Individual Factors" -> "Sleep Deficiencies" 
"Individual Factors" -> "Sleep Inertia" 
"Individual Factors" -> Insomnia 
"Individual Factors" -> Stress 
"Individual Readiness" -> "Crew Capability" 
"Individual Readiness" -> "Loss of Crew Life" 
"Isolation and Confinement" -> Stress 
"Isolation and Confinement" -> Workload 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Long Term Health Outcomes" 
"Medical Prevention Capability" -> "Sleep Inertia" 
"Medical Prevention Capability" -> Insomnia 
"Medical Treatment Capability" -> "Individual 
Readiness" 
"Medical Treatment Capability" -> "Medical (Risk)" 
"Medical Treatment Capability" -> "Sleep Inertia" 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Schedule Shifting" -> "Circadian Misalignment" 

"Schedule Shifting" -> "Sleep Deficiencies" 
"Schedule Shifting" -> Stress 
"Sleep Deficiencies" -> "Immune (Risk)" 
"Sleep Deficiencies" -> "Sleep Inertia" 
"Sleep Deficiencies" -> Fatigue 
"Sleep Deficiencies" -> Insomnia 
"Sleep Inertia" -> "Individual Readiness" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Individual Readiness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "ECLS System" 
"Vehicle Design" -> "Environmental Conditions" 
Fatigue -> "Behavioral (Risk)" 
Fatigue -> "Individual Readiness" 
Insomnia -> "Medical (Risk)" 
Insomnia -> "Sleep Inertia" 
Radiation -> "Environmental Conditions" 
Radiation -> "Sleep Deficiencies" 
Stress -> "Sleep Deficiencies" 
Stress -> Fatigue 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Workload -> Fatigue 
Workload -> Stress 
} 
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Team Risk  
dag { 
"Acoustics, Medical, Sleep, CO2, Food and 
Nutrition (Risks)" [latent,pos="-1.418,-1.352"] 
"Astronaut Selection" [pos="-1.216,-2.101"] 
"BHP Countermeasures" [pos="0.640,0.287"] 
"Behavioral (Risk)" [latent,pos="-1.499,-1.770"] 
"Communications Delay" [pos="-0.316,1.562"] 
"Crew Capability" [pos="0.614,-0.968"] 
"Crew Health and Performance System" [pos="-
0.889,1.287"] 
"Crew Size" [pos="-0.419,-1.933"] 
"Detect Team Performance and Cohesion" 
[pos="0.622,0.800"] 
"Distance from Earth" [exposure,pos="-
1.752,1.378"] 
"Effective Mission Duration" [pos="-1.651,0.194"] 
"Family Effects" [pos="0.010,0.724"] 
"Ground Support" [pos="0.159,1.555"] 
"HSIA (Risk)" [latent,pos="-1.443,1.683"] 
"Individual Factors" [pos="-1.033,-1.713"] 
"Individual Readiness" [pos="-0.537,-1.311"] 
"Interpersonal Relationships" [pos="-
0.498,0.205"] 
"Isolation and Confinement" [exposure,pos="-
1.706,-0.467"] 
"Loss of Crew Life" [outcome,pos="1.162,0.225"] 
"Loss of Mission Objectives" 
[outcome,pos="1.069,-1.595"] 
"Loss of Mission" [outcome,pos="1.171,-2.025"] 
"Loss of Vehicle" [pos="0.890,-0.289"] 
"Net Habitable Volume" [pos="-0.934,0.675"] 
"Privacy/Team Space" [pos="-0.493,0.953"] 
"Private Astronaut Missions" [pos="0.152,-1.950"] 
"Social Support" [pos="0.057,0.265"] 
"Task Performance" [outcome,pos="0.856,-
1.126"] 
"Team Cognition" [pos="-0.498,-0.615"] 
"Team Cohesion" [pos="0.073,-0.397"] 
"Team Composition" [pos="-0.159,-1.528"] 
"Team Functionality" [pos="0.259,-0.815"] 
"Team Monitoring" [pos="0.411,1.276"] 
"Team Skills" [pos="-1.006,-0.972"] 
"Team Training" [pos="-1.394,-0.622"] 
"Technical Training" [pos="-1.294,0.478"] 
"Vehicle Design" [pos="-1.476,1.016"] 
Evacuation [outcome,pos="1.203,-0.892"] 
"Acoustics, Medical, Sleep, CO2, Food and 
Nutrition (Risks)" -> "Behavioral (Risk)" 
"Acoustics, Medical, Sleep, CO2, Food and 
Nutrition (Risks)" -> "Individual Readiness" 

"Astronaut Selection" -> "Individual Factors" 
"Astronaut Selection" -> "Team Composition" 
"BHP Countermeasures" -> "Social Support" 
"BHP Countermeasures" -> "Team Cognition" 
"BHP Countermeasures" -> "Team Cohesion" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Interpersonal 
Relationships" 
"Communications Delay" -> "Family Effects" 
"Communications Delay" -> "Ground Support" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Communications Delay" 
"Crew Health and Performance System" -> 
"Privacy/Team Space" 
"Crew Health and Performance System" -> "Team 
Monitoring" 
"Crew Health and Performance System" -> 
"Technical Training" 
"Crew Size" -> "Crew Capability" 
"Crew Size" -> "Team Composition" 
"Detect Team Performance and Cohesion" -> "BHP 
Countermeasures" 
"Distance from Earth" -> "Communications Delay" 
"Distance from Earth" -> "Crew Size" 
"Distance from Earth" -> "Effective Mission 
Duration" 
"Distance from Earth" -> "Vehicle Design" 
"Effective Mission Duration" -> "Interpersonal 
Relationships" 
"Family Effects" -> "Individual Readiness" 
"Family Effects" -> "Social Support" 
"Ground Support" -> "Crew Capability" 
"Ground Support" -> "Social Support" 
"Ground Support" -> "Team Cognition" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Individual Factors" -> "Individual Readiness" 
"Individual Factors" -> "Team Composition" 
"Individual Readiness" -> "Crew Capability" 
"Individual Readiness" -> "Detect Team 
Performance and Cohesion" 
"Individual Readiness" -> "Team Cognition" 
"Individual Readiness" -> "Team Composition" 
"Interpersonal Relationships" -> "Detect Team 
Performance and Cohesion" 
"Interpersonal Relationships" -> "Social Support" 
"Interpersonal Relationships" -> "Team Cognition" 
"Interpersonal Relationships" -> "Team Cohesion" 
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"Isolation and Confinement" -> "Interpersonal 
Relationships" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Loss of Vehicle" -> "Loss of Crew Life" 
"Loss of Vehicle" -> Evacuation 
"Net Habitable Volume" -> "Privacy/Team Space" 
"Privacy/Team Space" -> "Interpersonal 
Relationships" 
"Private Astronaut Missions" -> "Team 
Composition" 
"Social Support" -> "Team Cognition" 
"Social Support" -> "Team Cohesion" 
"Task Performance" -> "Loss of Crew Life" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Task Performance" -> "Loss of Vehicle" 
"Team Cognition" -> "Team Functionality" 
"Team Cohesion" -> "Team Functionality" 
"Team Composition" -> "Interpersonal 
Relationships" 
"Team Composition" -> "Team Cognition" 
"Team Composition" -> "Team Cohesion" 

"Team Functionality" -> "Crew Capability" 
"Team Monitoring" -> "Detect Team Performance 
and Cohesion" 
"Team Skills" -> "Individual Readiness" 
"Team Skills" -> "Interpersonal Relationships" 
"Team Skills" -> "Social Support" 
"Team Skills" -> "Team Cognition" 
"Team Skills" -> "Team Functionality" 
"Team Training" -> "Ground Support" 
"Team Training" -> "Interpersonal Relationships" 
"Team Training" -> "Team Cognition" 
"Team Training" -> "Team Skills" 
"Technical Training" -> "Individual Readiness" 
"Technical Training" -> "Team Cognition" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "Net Habitable Volume" 
"Vehicle Design" -> "Privacy/Team Space" 
"Vehicle Design" -> "Technical Training" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
} 
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Tox Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Acoustics, Cardiovascular (Risks)" 
[latent,pos="0.166,0.115"] 
"Altered Gravity" [exposure,pos="-0.438,-0.042"] 
"Atmospheric Scrubbers" [pos="0.175,-0.166"] 
"Behavioral (Risk)" [latent,pos="0.138,-0.466"] 
"CO2 (Risk)" [latent,pos="-0.047,-0.099"] 
"Combustion/Smoldering Events" [pos="-
0.138,0.039"] 
"Communication Factors" [pos="-0.270,-0.467"] 
"Crew Capability" [pos="0.266,-0.353"] 
"Crew Health and Performance System" [pos="-
0.190,-0.372"] 
"Crew Metabolism" [pos="-0.143,-0.148"] 
"Detect Diagnosis" [pos="0.181,-0.036"] 
"Detect Long Term Health Outcomes" 
[pos="0.369,0.349"] 
"Detect Toxic Exposure" [pos="0.073,-0.102"] 
"Distance from Earth" [exposure,pos="-0.434,-
0.396"] 
"Dust (Risk)" [latent,pos="-0.271,0.405"] 
"ECLS System" [pos="-0.151,-0.443"] 
"Electric Shock (Risk)" [latent,pos="-0.250,-0.217"] 
"External Contaminants" [pos="-0.138,0.405"] 
"Ground Support" [pos="-0.057,-0.467"] 
"HSIA (Risk)" [latent,pos="-0.337,-0.384"] 
"Hostile Closed Environment" [exposure,pos="-
0.393,0.235"] 
"Individual Factors" [pos="-0.158,-0.276"] 
"Individual Readiness" [pos="0.189,-0.383"] 
"Long Term Health Outcomes" 
[outcome,pos="0.419,0.230"] 
"Loss of Crew Life" [outcome,pos="0.447,0.007"] 
"Loss of Mission Objectives" 
[outcome,pos="0.406,-0.419"] 
"Loss of Mission" [outcome,pos="0.460,-0.457"] 
"Materials Offgassing" [pos="-0.139,0.315"] 
"Medical (Risk)" [latent,pos="0.267,0.075"] 
"Medical Prevention Capability" [pos="0.029,-
0.383"] 
"Payload Chemicals" [pos="-0.139,0.219"] 
"Pharm (Risk)" [latent,pos="0.168,0.214"] 
"Physiologic Monitoring Capability" [pos="0.046,-
0.248"] 
"Protective Equipment" [pos="0.135,-0.320"] 
"Standards/Requirements" [pos="-0.437,-0.225"] 
"Task Performance" [outcome,pos="0.349,-
0.332"] 
"Team (Risk)" [latent,pos="0.238,-0.468"] 

"Thermal Degradation" [pos="-0.140,0.124"] 
"Toxic Exposure" [pos="0.013,0.078"] 
"Toxic Substance Monitoring" [pos="-0.041,-
0.204"] 
"Vehicle Design" [pos="-0.344,-0.268"] 
"Waste Management System" [pos="-0.142,-
0.055"] 
Evacuation [outcome,pos="0.362,-0.190"] 
Surveillance [pos="0.254,0.406"] 
"Acoustics, Cardiovascular (Risks)" -> "Medical 
(Risk)" 
"Altered Gravity" -> "Combustion/Smoldering 
Events" 
"Altered Gravity" -> "Crew Metabolism" 
"Altered Gravity" -> "Payload Chemicals" 
"Altered Gravity" -> "Vehicle Design" 
"Atmospheric Scrubbers" -> "Individual 
Readiness" 
"Atmospheric Scrubbers" -> "Medical (Risk)" 
"Behavioral (Risk)" -> "Individual Readiness" 
"Behavioral (Risk)" -> "Team (Risk)" 
"CO2 (Risk)" -> "Toxic Exposure" 
"Combustion/Smoldering Events" -> "Toxic 
Exposure" 
"Communication Factors" -> "Ground Support" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Physiologic Monitoring Capability" 
"Crew Health and Performance System" -> "Toxic 
Substance Monitoring" 
"Crew Metabolism" -> "CO2 (Risk)" 
"Detect Diagnosis" -> "Medical (Risk)" 
"Detect Toxic Exposure" -> "Atmospheric 
Scrubbers" 
"Detect Toxic Exposure" -> "Detect Diagnosis" 
"Detect Toxic Exposure" -> "Protective 
Equipment" 
"Distance from Earth" -> "Communication 
Factors" 
"Distance from Earth" -> "Vehicle Design" 
"Dust (Risk)" -> "External Contaminants" 
"ECLS System" -> "Atmospheric Scrubbers" 
"ECLS System" -> "Toxic Substance Monitoring" 
"Electric Shock (Risk)" -> "Combustion/Smoldering 
Events" 
"External Contaminants" -> "Toxic Exposure" 
"Ground Support" -> "Individual Readiness" 
"Ground Support" -> "Toxic Exposure" 
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"Ground Support" -> "Toxic Substance 
Monitoring" 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Electric Shock (Risk)" 
"HSIA (Risk)" -> "External Contaminants" 
"HSIA (Risk)" -> "Materials Offgassing" 
"HSIA (Risk)" -> "Payload Chemicals" 
"HSIA (Risk)" -> "Thermal Degradation" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> 
"Combustion/Smoldering Events" 
"Hostile Closed Environment" -> "Crew 
Metabolism" 
"Hostile Closed Environment" -> "External 
Contaminants" 
"Hostile Closed Environment" -> "Materials 
Offgassing" 
"Hostile Closed Environment" -> "Payload 
Chemicals" 
"Hostile Closed Environment" -> "Thermal 
Degradation" 
"Hostile Closed Environment" -> "Vehicle Design" 
"Individual Factors" -> "Crew Metabolism" 
"Individual Readiness" -> "Crew Capability" 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Materials Offgassing" -> "Toxic Exposure" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Medical (Risk)" -> Evacuation 
"Medical Prevention Capability" -> "Protective 
Equipment" 
"Payload Chemicals" -> "Toxic Exposure" 
"Pharm (Risk)" -> "Medical (Risk)" 
"Physiologic Monitoring Capability" -> "Detect 
Diagnosis" 

"Protective Equipment" -> "Individual Readiness" 
"Protective Equipment" -> "Medical (Risk)" 
"Standards/Requirements" -> "Materials 
Offgassing" 
"Standards/Requirements" -> "Payload 
Chemicals" 
"Standards/Requirements" -> "Vehicle Design" 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Team (Risk)" -> "Individual Readiness" 
"Thermal Degradation" -> "Toxic Exposure" 
"Toxic Exposure" -> "Acoustics, Cardiovascular 
(Risks)" 
"Toxic Exposure" -> "Behavioral (Risk)" 
"Toxic Exposure" -> "Detect Toxic Exposure" 
"Toxic Exposure" -> "Individual Readiness" 
"Toxic Exposure" -> "Long Term Health Outcomes" 
"Toxic Exposure" -> "Medical (Risk)" 
"Toxic Substance Monitoring" -> "Detect Toxic 
Exposure" 
"Vehicle Design" -> "Combustion/Smoldering 
Events" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Vehicle Design" -> "ECLS System" 
"Vehicle Design" -> "External Contaminants" 
"Vehicle Design" -> "Materials Offgassing" 
"Vehicle Design" -> "Payload Chemicals" 
"Vehicle Design" -> "Thermal Degradation" 
"Vehicle Design" -> "Toxic Exposure" 
"Vehicle Design" -> "Waste Management System" 
"Waste Management System" -> "Toxic Exposure" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Surveillance -> "Detect Long Term Health 
Outcomes" 
} 
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Urinary Retention Risk  
dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.416,-0.052"] 
"Astronaut Selection" [pos="-0.060,-0.455"] 
"Crew Capability" [pos="0.288,-0.341"] 
"Crew Health and Performance System" [pos="-
0.146,0.285"] 
"Detect Long Term Health Outcomes" 
[pos="0.399,0.271"] 
"Detect Post-Void Residual" [pos="-0.058,-0.067"] 
"Distance from Earth" [exposure,pos="-
0.436,0.285"] 
"EVA (Risk)" [latent,pos="-0.408,0.107"] 
"HSIA (Risk)" [latent,pos="-0.309,0.409"] 
"Hostile Closed Environment" [exposure,pos="-
0.413,-0.218"] 
"Individual Factors" [pos="-0.149,-0.382"] 
"Individual Readiness" [pos="0.228,-0.282"] 
"Isolation and Confinement" [exposure,pos="-
0.420,-0.317"] 
"Long Term Health Outcomes" 
[outcome,pos="0.417,0.105"] 
"Loss of Crew Life" [outcome,pos="0.416,-0.043"] 
"Loss of Mission Objectives" 
[outcome,pos="0.392,-0.446"] 
"Loss of Mission" [outcome,pos="0.457,-0.471"] 
"Mechanical Obstruction" [pos="-0.231,-0.285"] 
"Medical Illness" [pos="0.229,-0.166"] 
"Medical Prevention Capability" 
[pos="0.042,0.241"] 
"Medical Treatment Capability" 
[pos="0.144,0.333"] 
"Pharm (Risk)" [latent,pos="0.017,0.108"] 
"Post-Void Residual" [pos="-0.089,-0.290"] 
"Sensorimotor (Risk)" [latent,pos="-0.303,0.187"] 
"Task Performance" [outcome,pos="0.376,-
0.364"] 
"Urinary Muscle Changes" [pos="-0.279,-0.128"] 
"Urinary Retention" [pos="0.035,-0.288"] 
"Urine Flow" [pos="0.130,-0.288"] 
"Vehicle Design" [pos="-0.309,0.287"] 
"Void Trial" [pos="0.028,-0.168"] 
Anticholergics [pos="-0.233,0.085"] 
Catheterization [pos="0.135,-0.022"] 
Evacuation [outcome,pos="0.386,-0.235"] 
Inflammation [pos="-0.278,-0.419"] 
Radiation [exposure,pos="-0.419,-0.428"] 
Surveillance [pos="0.307,0.389"] 
Sympathomimetics [pos="-0.300,-0.005"] 
Tamsulosin [pos="-0.195,-0.019"] 

Ultrasound [pos="-0.096,0.189"] 
"Altered Gravity" -> "Urinary Muscle Changes" 
"Astronaut Selection" -> "Individual Factors" 
"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> 
"Medical Prevention Capability" 
"Crew Health and Performance System" -> 
"Medical Treatment Capability" 
"Crew Health and Performance System" -> 
Ultrasound 
"Detect Post-Void Residual" -> "Void Trial" 
"Detect Post-Void Residual" -> Catheterization 
"Distance from Earth" -> "Vehicle Design" 
"EVA (Risk)" -> Sympathomimetics 
"EVA (Risk)" -> Ultrasound 
"HSIA (Risk)" -> "Crew Health and Performance 
System" 
"HSIA (Risk)" -> "Vehicle Design" 
"Hostile Closed Environment" -> Inflammation 
"Individual Factors" -> "Mechanical Obstruction" 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> Inflammation 
"Long Term Health Outcomes" -> "Detect Long 
Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Mechanical Obstruction" -> "Post-Void Residual" 
"Medical Illness" -> "Individual Readiness" 
"Medical Illness" -> "Long Term Health Outcomes" 
"Medical Illness" -> "Loss of Crew Life" 
"Medical Illness" -> Evacuation 
"Medical Prevention Capability" -> Tamsulosin 
"Medical Treatment Capability" -> "Medical 
Illness" 
"Medical Treatment Capability" -> Catheterization 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> Anticholergics 
"Pharm (Risk)" -> Sympathomimetics 
"Post-Void Residual" -> "Detect Post-Void 
Residual" 
"Post-Void Residual" -> "Medical Illness" 
"Post-Void Residual" -> "Urinary Retention" 
"Sensorimotor (Risk)" -> Anticholergics 
"Sensorimotor (Risk)" -> Sympathomimetics 
"Sensorimotor (Risk)" -> Ultrasound 
"Task Performance" -> "Loss of Mission 
Objectives" 
"Urinary Muscle Changes" -> "Mechanical 
Obstruction" 
"Urinary Retention" -> "Medical Illness" 
"Urinary Retention" -> "Urine Flow" 
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"Urine Flow" -> "Medical Illness" 
"Vehicle Design" -> "Crew Health and 
Performance System" 
"Void Trial" -> "Urinary Retention" 
Anticholergics -> "Mechanical Obstruction" 
Catheterization -> "Medical Illness" 
Catheterization -> "Urine Flow" 
Inflammation -> "Mechanical Obstruction" 

Radiation -> Inflammation 
Surveillance -> "Detect Long Term Health 
Outcomes" 
Sympathomimetics -> "Urinary Muscle Changes" 
Tamsulosin -> "Urinary Muscle Changes" 
Ultrasound -> "Detect Post-Void Residual" 
} 
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VTE Concern  
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dag { 
bb="-0.5,-0.5,0.5,0.5" 
"Altered Gravity" [exposure,pos="-0.452,-0.461"] 
"Astronaut Selection" [pos="-0.432,-0.378"] 
"Atmospheric Conditions" [pos="-0.416,-0.074"] 
"Blood Stagnation" [pos="0.061,-0.448"] 
"Blood Viscosity" [pos="-0.134,-0.151"] 
"CO2 (Risk)" [latent,pos="-0.301,-0.033"] 
"Crew Capability" [pos="0.219,-0.284"] 
"Crew Health and Performance System" [pos="-0.148,0.408"] 
"Detect Long Term Health Outcomes" [pos="0.396,0.225"] 
"Detect Thrombosis" [pos="0.158,0.088"] 
"Distance from Earth" [exposure,pos="-0.437,0.407"] 
"Endocrine Factors" [pos="-0.023,0.211"] 
"Endothelial Damage" [pos="-0.016,-0.232"] 
"Fluid Shifts" [pos="-0.314,-0.457"] 
"Food and Nutrition (Risk)" [latent,pos="-0.145,0.156"] 
"Hematologic Index Alterations" [pos="-0.203,-0.285"] 
"Hostile Closed Environment" [exposure,pos="-0.419,-0.285"] 
"Hypoxia (Risk)" [latent,pos="-0.300,-0.161"] 
"Individual Factors" [pos="-0.315,-0.344"] 
"Individual Readiness" [pos="0.207,-0.191"] 
"Isolation and Confinement" [exposure,pos="-0.421,0.263"] 
"Long Term Health Outcomes" [outcome,pos="0.413,0.086"] 
"Loss of Crew Life" [outcome,pos="0.448,-0.035"] 
"Loss of Mission Objectives" [outcome,pos="0.340,-0.444"] 
"Loss of Mission" [outcome,pos="0.443,-0.470"] 
"Medical (Risk)" [latent,pos="0.208,-0.038"] 
"Medical Monitoring Capability" [pos="0.104,0.284"] 
"Medical Prevention Capability" [pos="0.067,0.410"] 
"Medical Treatment Capability" [pos="0.281,0.282"] 
"Oral Contraceptives" [pos="-0.047,0.320"] 
"Oxidative Stress" [pos="-0.346,0.056"] 
"Pharm (Risk)" [latent,pos="0.246,0.412"] 
"Task Performance" [outcome,pos="0.256,-0.369"] 
"Vascular Structure/Function" [pos="-0.131,-0.453"] 
"Vehicle Design" [pos="-0.323,0.405"] 
"Venous Thrombosis" [pos="0.066,-0.038"] 
Anticoagulants [pos="0.280,0.111"] 
Coagulability [pos="-0.047,0.065"] 
Evacuation [outcome,pos="0.334,-0.216"] 
Inflammation [pos="-0.223,0.087"] 
Radiation [exposure,pos="-0.451,0.053"] 
Stress [pos="-0.333,0.199"] 
Surveillance [pos="0.408,0.396"] 
Ultrasound [pos="0.146,0.190"] 
"Altered Gravity" -> "Fluid Shifts" 
"Astronaut Selection" -> "Individual Factors" 
"Atmospheric Conditions" -> "CO2 (Risk)" 
"Atmospheric Conditions" -> "Hypoxia (Risk)" 
"Blood Stagnation" -> "Venous Thrombosis" 
"Blood Viscosity" -> "Blood Stagnation" 
"Blood Viscosity" -> Coagulability 
"CO2 (Risk)" -> Inflammation 
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"Crew Capability" -> "Task Performance" 
"Crew Health and Performance System" -> "Medical Monitoring Capability" 
"Crew Health and Performance System" -> "Medical Prevention Capability" 
"Crew Health and Performance System" -> "Medical Treatment Capability" 
"Detect Thrombosis" -> Anticoagulants 
"Distance from Earth" -> "Vehicle Design" 
"Endocrine Factors" -> Coagulability 
"Endothelial Damage" -> "Venous Thrombosis" 
"Fluid Shifts" -> "Hematologic Index Alterations" 
"Fluid Shifts" -> "Vascular Structure/Function" 
"Food and Nutrition (Risk)" -> Coagulability 
"Hematologic Index Alterations" -> "Blood Viscosity" 
"Hostile Closed Environment" -> "Atmospheric Conditions" 
"Hypoxia (Risk)" -> "Hematologic Index Alterations" 
"Hypoxia (Risk)" -> Coagulability 
"Hypoxia (Risk)" -> Inflammation 
"Individual Factors" -> "Endocrine Factors" 
"Individual Factors" -> "Vascular Structure/Function" 
"Individual Factors" -> Coagulability 
"Individual Readiness" -> "Crew Capability" 
"Isolation and Confinement" -> Stress 
"Long Term Health Outcomes" -> "Detect Long Term Health Outcomes" 
"Loss of Mission Objectives" -> "Loss of Mission" 
"Medical (Risk)" -> "Individual Readiness" 
"Medical (Risk)" -> "Long Term Health Outcomes" 
"Medical (Risk)" -> "Loss of Crew Life" 
"Medical (Risk)" -> Evacuation 
"Medical Monitoring Capability" -> Ultrasound 
"Medical Prevention Capability" -> "Oral Contraceptives" 
"Medical Prevention Capability" -> "Venous Thrombosis" 
"Medical Treatment Capability" -> Anticoagulants 
"Oral Contraceptives" -> "Endocrine Factors" 
"Oxidative Stress" -> Inflammation 
"Pharm (Risk)" -> "Medical Prevention Capability" 
"Pharm (Risk)" -> "Medical Treatment Capability" 
"Task Performance" -> "Loss of Mission Objectives" 
"Vascular Structure/Function" -> "Blood Stagnation" 
"Vascular Structure/Function" -> "Endothelial Damage" 
"Vehicle Design" -> "Atmospheric Conditions" 
"Vehicle Design" -> "Crew Health and Performance System" 
"Venous Thrombosis" -> "Detect Thrombosis" 
"Venous Thrombosis" -> "Medical (Risk)" 
Anticoagulants -> "Medical (Risk)" 
Coagulability -> "Venous Thrombosis" 
Evacuation -> "Loss of Crew Life" 
Evacuation -> "Loss of Mission Objectives" 
Inflammation -> "Endothelial Damage" 
Inflammation -> "Vascular Structure/Function" 
Radiation -> "Oxidative Stress" 
Stress -> Inflammation 
Surveillance -> "Detect Long Term Health Outcomes" 
Ultrasound -> "Detect Thrombosis" 
} 
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